
IBM System Storage  N series

Single Mailbox  Recovery 5.0 

Administrator’s  Guide  

GC26-7885-02 

(NA 215-03766_A0)  

���



Copyright  and  trademark  information  

This section includes copyright and trademark information, and important notices. 

Copyright information 

Copyright ©1994 - 2008 Network Appliance, Inc. All rights reserved. Printed in the 

U.S.A. 

Portions copyright © 2006, 2008 IBM Corporation. All rights reserved. 

US Government Users Restricted Rights - Use, duplication or disclosure restricted 

by GSA ADP Schedule Contract with IBM Corp. 

No part of this file covered by copyright may be reproduced in any form or by any 

means—graphic, electronic, or mechanical, including photocopying, recording, 

taping, or storage in an electronic retrieval system—without prior written 

permission of the copyright owner. 

Software derived from copyrighted material of NetApp, Inc. is subject to the 

following license and disclaimer: 

THIS SOFTWARE IS PROVIDED BY NETAPP “AS IS” AND WITHOUT ANY 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 

PARTICULAR PURPOSE, WHICH ARE HEREBY DISCLAIMED. IN NO EVENT 

SHALL NETAPP BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 

CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 

STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 

ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Portions of this product are Copyright © 2005-2006 Kroll Ontrack Inc. All rights 

reserved. 

Single Mailbox Recovery is a software application that has been developed, 

copyrighted, and licensed by Kroll Ontrack, Inc. Use of the software is governed 

by the terms and conditions of the end user license agreement contained within 

the software. 

This manual should not be construed as any representation or warranty with 

respect to the software named herein. Occasionally, changes or variations exist in 

the software that are not reflected in the manual. Generally, if such changes or 

variations are  known to exist and affect the product significantly, a release note or 

Read Me file will accompany the User Guide, or will be available on the Kroll 

Ontrack Web site. In that event, please read the release note or Read Me file before 

using the product. 

No part of this publication may be reproduced, transmitted, transcribed, stored in 

a retrieval system, or translated into a language or computer language, in any form 

 

© Copyright  IBM Corp.  2006, 2008  ii



by any means, electronic, mechanical, optical, chemical, manual or otherwise, 

without the express written consent of Kroll Ontrack Inc. 

NetApp reserves the right to change any products described herein at any time, 

and without notice. NetApp assumes no responsibility or liability arising from the 

use of products described herein, except as expressly agreed to in writing by 

NetApp. The use or purchase of this product does not convey a license under any 

patent rights, trademark rights, or any other intellectual property rights of NetApp. 

The product described in this manual may be protected by one or more U.S. 

patents, foreign patents, or pending applications. 

RESTRICTED RIGHTS LEGEND: Use, duplication, or disclosure by the 

government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the 

Rights in Technical Data and Computer Software clause at DFARS 252.277-7103 

(October 1988) and FAR 52-227-19 (June 1987). 

Trademark information 

The following terms are trademarks of International Business Machines 

Corporation in the United States, other countries, or both: IBM, the IBM logo, AIX, 

System Storage. 

Apple is a registered trademark and QuickTime is a trademark of Apple, Inc. in 

the U.S.A. and/or other countries. Microsoft is a registered trademark and 

Windows Media is a trademark of Microsoft Corporation in the U.S.A. and/or 

other countries. RealAudio, RealNetworks, RealPlayer, RealSystem, RealText, and 

RealVideo are  registered trademarks and RealMedia, RealProxy, and SureStream 

are trademarks of RealNetworks, Inc. in the U.S.A. and/or other countries. 

NetApp, the Network Appliance logo, the bolt design, NetApp—the Network 

Appliance Company, Cryptainer, Cryptoshred, DataFabric, DataFort, Data ONTAP, 

Decru, FAServer, FilerView,  FlexClone, FlexVol, Manage ONTAP, MultiStore, 

NearStore, NetCache, NOW NetApp on the Web,  SANscreen, SecureShare, 

SnapDrive, SnapLock, SnapManager, SnapMirror, SnapMover, SnapRestore, 

SnapValidator, SnapVault, Spinnaker Networks, SpinCluster, SpinFS, SpinHA, 

SpinMove, SpinServer, StoreVault,  SyncMirror, Topio,  VFM, and WAFL  are 

registered trademarks of NetApp, Inc. in the U.S.A. and/or other countries. gFiler, 

Network Appliance, SnapCopy, Snapshot, and The evolution of storage are 

trademarks of NetApp, Inc. in the U.S.A. and/or other countries and registered 

trademarks in some other countries. The NetApp arch logo; the StoreVault  logo; 

ApplianceWatch; BareMetal; Camera-to-Viewer; ComplianceClock; 

ComplianceJournal; ContentDirector; ContentFabric; EdgeFiler; FlexShare; FPolicy; 

Go Further, Faster; HyperSAN; InfoFabric; Lifetime Key Management, LockVault; 

NOW; ONTAPI; OpenKey, RAID-DP; ReplicatorX; RoboCache; RoboFiler; 

SecureAdmin; Serving Data by Design; SharedStorage; Simplicore; Simulate 

ONTAP; Smart SAN; SnapCache; SnapDirector; SnapFilter; SnapMigrator; 

SnapSuite; SohoFiler; SpinMirror; SpinRestore; SpinShot; SpinStor; vFiler; VFM 

Virtual File Manager; VPolicy; and Web Filer are trademarks of NetApp, Inc. in the 

U.S.A. and other countries. NetApp Availability Assurance and NetApp ProTech  

Expert are  service marks of NetApp, Inc. in the U.S.A. 

All other brands or products are trademarks or registered trademarks of their 

respective holders and should be treated as such. 

Network Appliance is a licensee of the CompactFlash and CF Logo trademarks. 

 

iii IBM System Storage  N series: Single  Mailbox  Recovery 5.0 Administrator’s Guide



Network Appliance NetCache is certified RealSystem compatible. 

Notice to Users 

Single Mailbox Recovery is a software application that has been developed, 

copyrighted, and licensed by Kroll Ontrack Inc. Use of the software is governed by 

the terms and conditions of the end user license agreement contained within the 

software. 

This manual should not be construed as any representation or warranty with 

respect to the software named herein. Occasionally, changes or variations exist in 

the software that are not reflected in the manual. 

Generally, if such changes or variations are known to exist and affect the product 

significantly, a release note or Read Me file will accompany the User Guide, or will 

be available on the NetApp web site. In that event, please read the release notes or 

Read Me file before using the product. 

 

Copyright  and trademark information iv

Supported features IBM® System StorageTM N series products are driven by NetApp® Data 
ONTAP software. Some features described in the product software 
documentation are neither offered nor supported by IBM. Please contact your 
local IBM representative or reseller for further details. Information about 
supported features can also be found at the following Web site:

www.ibm.com/storage/support/nas/

A listing of currently available N series products and features can be found at the 
following Web site:

www.ibm.com/storage/nas/

Using the 
documentation

Information about the N series hardware products is available in printed 
documents and a documentation CD that comes with your system. The same 
documentation is available as PDF files on the IBM NAS support Web site: 

www.ibm.com/storage/support/nas/



Notices  

This information was developed for products and services offered  in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe on any IBM intellectual property right 

may be used instead. However, it is the user’s responsibility to evaluate and verify 

the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you 

any license to these patents. You can send license inquiries, in writing to:

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, N.Y.  10504-1785 

U.S.A. 

For additional information, visit the web at: 

http://www.ibm.com/ibm/licensing/contact/ 

The following paragraph does not apply to the United Kingdom or any other 

country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 

FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply 

to you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements 

and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice. 

Any references in this information to non-IBM web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those web 

sites. The materials at those web sites are not part of the materials for this IBM 

product and use of those web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it 

believes appropriate without incurring any obligation to you. 

Any performance data contained herein was determined in a controlled 

environment. Therefore, the results obtained in other operating environments may 

vary significantly. Some measurements may have been made on development-level 

 

© Copyright  IBM Corp.  2006, 2008   v



systems and there is no guarantee that these measurements will be the same on 

generally available systems. Furthermore, some measurement may have been 

estimated through extrapolation. Actual results may vary.  Users of this document 

should verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of 

those products, their published announcements or other publicly available sources. 

IBM has not tested those products and cannot confirm the accuracy of 

performance, compatibility or any other claims related to non-IBM products. 

Questions on the capabilities of non-IBM products should be addressed to the 
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INTRODUCTION

INTRODUCTION

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

Welcome to NetApp® Single Mailbox Recovery 5.0, the mailbox recovery software that saves 
time, money, and resources when recovering Microsoft Exchange data.

Single Mailbox Recovery works with your existing Microsoft® Exchange server backup 
architecture and procedures, and allows you to recover individual mailboxes, folders, messages, 
attachments, and even calendar, notes, and tasks directly to your production Exchange server or any 
PST file. This eliminates time-consuming and expensive single mailbox (brick-level) backups. This 
powerful software also lets you search and create a copy of all archived email that matches a given 
keyword or criteria.

Because Single Mailbox Recovery can work in conjunction with your existing NetApp® 
SnapManager® for Microsoft® Exchange environment, you can continue to use SnapManager 
to perform full, online backups of Exchange databases using NetApp Snapshot™ technology. This 
technology enables you to retain many Exchange backups on a NetApp storage system with 
minimal storage requirements for each incremental backup. Later, whenever you need to restore 
previously deleted, individual Exchange mail items, use Single Mailbox Recovery to rapidly locate 
and then restore the items—at any level of granularity—directly to an existing mailbox on your 
production Exchange server or to a new or existing offline Outlook PST file. 

• To restore mail items from an Exchange database (EDB) file in a SnapManager backup 
set snapshot, connect to the LUN in the snapshot on the NetApp storage system and then 
use Single Mailbox Recovery to restore the mail items directly from the SnapManager-
created snapshot.

• To restore mail items from an EDB file in a tape or disk backup created using an 
Exchange-aware backup application, first use the appropriate application-specific Single 
Mailbox Recovery ExtractWizard agent to read the Exchange server backup directly from 
the backup media and restore the Exchange database to any alternate location where you 
can perform Single Mailbox Recovery processes. You can then use Single Mailbox 
Recovery to restore the mail items from the database. The use of an Single Mailbox 
Recovery ExtractWizard agent also enables you to use Single Mailbox Recovery to restore 
Exchange mail items from an archived copy of a SnapManager-based full backup set 
created by a supported, Exchange-aware backup application run in copy mode. 

• To restore mail items from an Outlook PST file located on any alternate location where you 
can perform Single Mailbox Recovery processes, use the Single Mailbox Recovery PST 
agent.

Single Mailbox Recovery locates and restores Exchange mail items without the assistance of the 
Exchange server, thereby eliminating the need for a recovery server. In contrast, most backup 
programs let you restore Exchange data only to the same or duplicate server from which it was 
backed up. 

This user guide provides step-by-step instructions for completing specific tasks on the Windows 
platform. See the table of contents or the Index to locate the pages on which particular topics are 
discussed.
1



I N T R O D U C T I O N
Five Major Reasons for Using Single Mailbox RecoveryINTRODUCTION
Use Adobe Acrobat to open the PDF version of this user guide. After you open the PDF file, click 
the Hand tool to view the Table of Contents hyperlinks in layout view. Then click a hyperlink to 
jump to a specific topic in the manual.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Five Major Reasons for Using Single Mailbox Recovery

There are five primary ways you can benefit from using Single Mailbox Recovery:

Minimize the time to restore an individual mailbox. Single Mailbox Recovery can slash restore 
time, making it possible to restore mail items from a previous full backup directly into your 
production Exchange Server, or directly into a new or existing PST file. This eliminates the need 
for a recovery server and the extra steps required to separately import mail back into Exchange or 
Outlook.

Eliminate backups of an individual mailbox. Single Mailbox Recovery eliminates the need to 
back up individual mailboxes because they can be restored directly from an EDB file.

Minimize the time to locate all email matching specific criteria. Single Mailbox Recovery 
includes an Advanced Find feature that can search across all mailboxes in an archive EDB file, 
rather than searching one mailbox at a time or bringing an old backup back online for analysis. And 
you can search by a variety of criteria, including keywords, subject, date and specific users.

Minimize storage space and the cost required to store and archive your backups. Because you 
don’t need to back up mailboxes individually doing a brick-level backup, you eliminate the backup 
space, cost, and time associated with performing brick-level backups.

Minimize the time to back up all mailboxes. Single Mailbox Recovery eliminates the need to 
back up mailboxes individually. Normally, companies do a full Exchange backup, and then run a 
second process to back up “Very Important Mailboxes” (VIMs) individually as well. Single 
Mailbox Recovery eliminates this second process.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Single Mailbox Recovery 5.0 Enhancements

Single Mailbox Recovery 5.0 contains all the features and benefits of Single Mailbox Recovery 4.2 
plus these exciting new and improved features: 

• Live Microsoft Exchange Server as a Target: You can open live Exchange Servers as a 
Target within Single Mailbox Recovery. 

• Searching Microsoft Exchange Server Target: You can search a Exchange Server Target 
and perform actions on the search results. 

• Mailbox Creation Wizard: You can create mailboxes on a Target Exchange Server 
manually or as part of copy and paste process. This gives you the ability to create a new 
mailbox-enabled user, or to create a new mailbox for an existing user. 

• Search Results Report: You can save a text-based report of the search results without 
having to copy or export any of the actual search results. The search results report includes 
search criteria, date/time the search was started, and a report of messages that matched the 
criteria.
2
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. .I N T R O D U C T I O N
Single Mailbox Recovery Editions
• Export to PST: The Export to PST feature provides you a method for selecting a single 
mailbox from an off-line EDB or an entire off-line EDB and exporting to PST files—one 
for each mailbox.

• Journaling Support: Single Mailbox Recovery has added the capability to search multiple 
levels of embedded messages. 

• Exchange Server 2007 support in Single Mailbox Recovery ExtractWizard: Single 
Mailbox Recovery ExtractWizard functionality has been expanded to support current 
product releases of Agent-supported backup software products offered by Single Mailbox 
Recovery ExtractWizard Agents. Also, Single Mailbox Recovery ExtractWizard 
functionality has been expanded to support current product releases of Agent-supported 
backup software products offering Exchange Server 2007 support. 

• Exchange Server 2007 Service Pack 1 (SP1) Support: Single Mailbox Recovery can 
perform both Source and Target functions and Single Mailbox Recovery ExtractWizard 
(SP1 supported limited to VERITAS NetBackup Bkf files) operations on Microsoft 
Exchange Server 2007 SP1 EDB data stores and Server systems.

• Operation in Virtualized Environments: Single Mailbox Recovery is supported to run in 
virtualized environments using VMware Server v1.0x, VMware Workstation for Windows 
v6.0x, Microsoft Virtual Server 2005 R2, and Microsoft Virtual PC 2007.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Single Mailbox Recovery Editions

Single Mailbox Recovery 5.0 is available as a fully-licensed edition or as a trial edition. The trial 
edition supports all the features of the fully-licensed edition, but it is enabled for a maximum of 30 
days before it expires. 

To determine whether an installed copy of Single Mailbox Recovery 5.0 is a trial edition or a fully-
licensed edition, select Help > About in the Single Mailbox Recovery main window.

Note:  To upgrade from a trial edition to fully-licensed edition, you must uninstall the trial edition 
and install the fully-licensed version. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Single Mailbox Recovery Agents

Single Mailbox Recovery is distributed with the following agents:

• PST Source Agent
• Advanced Searching Agent
• Single Mailbox Recovery ExtractWizard Agents
• How Single Mailbox Recovery ExtractWizard Can Be Used with SnapManager
3
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Single Mailbox Recovery AgentsINTRODUCTION
PST Source Agent 

By default, Single Mailbox Recovery enables you to open an EDB file as the source of the 
Exchange mail items to be restored to your production Exchange server or to a new or existing PST 
file. If you enable the optional PST source agent (priced separately), you can also open a PST file 
as the source of the Exchange mail items.

Advanced Searching Agent 

By default, Single Mailbox Recovery enables you to search attachment text for user-defined 
keywords or phrases. If you enable the optional advanced searching agent (priced separately), you 
can also search any combination of attachment text, message subject, message body, and 
attachment file name(s). 

Single Mailbox Recovery ExtractWizard Agents 

Typically, Single Mailbox Recovery is used to restore individual mail items from Exchange 
database files that you backed up to a NetApp storage system using SnapManager for Microsoft 
Exchange. However, for integration with your legacy tape backup environment, Single Mailbox 
Recovery also enables you to restore mail items from Exchange Information Store data that you 
backed up to disks or tapes using an Exchange-aware, tape-based backup application other 
than SnapManager. Application-specific Single Mailbox Recovery ExtractWizard agents enable 
you to read Exchange Information Store data from the media and copy the data to any location 
where you can perform Single Mailbox Recovery processes. NetApp provides Single Mailbox 
Recovery ExtractWizard agents for the most widely-used disk and tape backup software, as 
summarized in the following table. 

Single Mailbox 
Recovery 

ExtractWizard 
Agent

Versions 
Supported Disk Backup Tape Backup

Agents enabled by default

Microsoft® NT 
Backup

All Versions .BKF Files Microsoft Tape Format 
(MTF)

Symantec Backup 
Exec™

8.x, 9.x, 10.1, and 
11.d

.BKF Files Microsoft Tape Format 
(MTF)

Optional agents (priced separately)

EMC® NetWorker® 6.x and 7.x through 
7.43

.0 Files NetWorker Tape 
Format

CA ARCserve® 
Backup

9.x, 11.52, and 11.5 
SP32,5

.CTF (ARCserve) 
Files

ARCserve Tape Format

VERITAS 
NetBackup™

4.5, 5.x, 6.0, and 
6.51

_C1_F (NetBackup) 
Files

VERITAS NetBackup 
Tape Format
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1) For NetBackup 6.x backups created using Bare Metal Restore or Off-Host Backup, NetApp 
recommends the Advanced Method for extraction.

2) For CA ARCserve 11.5 multiplexed backup tapes, NetApp recommends the Advanced Method 
for extraction.

3) For EMC NetWorker 7.2, 7.3, and 7.4 backups created using Advanced File Backups, NetApp 
recommends the Advanced Method for extraction.

4) For IBM Tivoli Storage Manager 5.3 and 5.4 backups created using Export mini format, NetApp 
recommends the Advanced Method for extraction.

5) For CA ARCserve 11.5 SP3 backups of Microsoft Exchange Server 2007 created using 
Advanced Mode, NetApp recommends the Direct method for extraction.

How Single Mailbox Recovery ExtractWizard Can Be Used with SnapManager 

Even if you are using SnapManager for Exchange as your primary Exchange backup application, 
Single Mailbox Recovery ExtractWizard is useful in the following situations:

• To enable recovery of mailbox items from a legacy backup. If you have Exchange 
Information Store data stored in legacy backups created using a supported backup 
application, you can use the associated Single Mailbox Recovery ExtractWizard agent to 
restore the Exchange data to any location where you can perform Single Mailbox Recovery 
processes.

• To enable recovery of mailbox items from a SnapManager archive. If you used an 
Exchange aware backup application to archive a SnapManager for Exchange full backup 
set in read only mode, use the associated Single Mailbox Recovery ExtractWizard agent to 
restore the Exchange Information Store data from the archive to any location where you can 
perform Single Mailbox Recovery processes. 

After the Exchange data has been restored, you can use Single Mailbox Recovery to restore 
individual mailbox items to your production Exchange server or to a PST file. 

IBM® Tivoli® 
Storage Manager

5.1, 5.2, 5.34, and 
5.44

.BFS and .OST Files Tivoli Tape Format

Hewlett-Packard 
OpenView® Storage 
Data Protector

4.2 and 5.x User-Defined File 
Extension

Hewlett-Packard 
OpenView Storage 
Data Protector Tape 
Format

CommVault® Galaxy 
™ Backup & 
Recovery

5.0 and 5.9 BackupPath CommVault Galaxy 
Tape Format

UltraBac 7.1 and 8.0 Magnetic Library UltraBac Software 
Tape Format

Single Mailbox 
Recovery 

ExtractWizard 
Agent

Versions 
Supported Disk Backup Tape Backup
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
About This Guide 

This guide shows you how to install Single Mailbox Recovery, how to use its commands and 
design features, and how to get help. It provides step-by-step instructions for completing specific 
tasks on the Windows platform. 

Menu Commands and Shortcuts 

This manual uses the following conventions for documenting menu commands and shortcuts: 

Shortcut Menu

You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to display a shortcut menu. The contents of the shortcut menu depend on 
whether you right-click in the Source or Target pane. This manual seeks to teach you how to use 
commands on the menu bar and toolbar, and doesn’t always specify when you can use the shortcut 
menu. Once you become familiar with Single Mailbox Recovery, the commands available to you 
on the shortcut menu should become apparent. 

Notes and Tips1 

Notes (including cautions, important notes, tips, and warnings, as well as general notes) call the 
reader's attention to information of special importance or information that can't otherwise be 
suitably presented in the main text. 

Note:  A note indicates neutral or positive information that emphasizes or supplements important 
points of the main text. A note supplies information that may apply only in special cases—for 
example, memory limitations, equipment configurations, or details that apply to specific versions of 
a program. 

Tip:  A tip helps users apply the techniques and procedures described in the text to their specific 
needs. A tip suggests alternative methods that may not be obvious and helps users understand the 
benefits and capabilities of the product. A tip is not essential to the basic understanding of the text.

Example Describes

On the File menu, point to Target PST, 
and then click Create New.

Choosing the Create New command on the 
Target PST submenu on the File menu.

On the Edit menu, click Paste Special. Choosing the Paste Special command on the 
Edit menu.

Press Ctrl+S (Open Source EDB) Holding down the Ctrl key and the S key at 
the same time and then releasing them.

Right-click Clicking the right mouse button.

1. The information in this section is taken from the Microsoft Manual of Style for Technical 
Publications, 3rd Edition. Redmond, WA: Microsoft Press, 2002.
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Other Documents
Important:  An important note provides information essential to the completion of a task. Users 
can disregard information in a note and still complete a task, but they should not disregard an 
important note. 

Caution:  A caution advises users that failure to take or avoid a specified action could result in loss 
of data. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Other Documents 

In addition to this guide, you should be familiar with the following guides and have them at hand, 
available for reference during installation and administration. 

Note:  All of the NetApp documents can be found on the NetApp on the Web (NOW) site at 
http://now.netapp.com/NOW/knowledge/docs. 

Reference Documents 

You should have the following documents readily available for reference. 

For the Most Current Information 

The following documents contain the most current information about NetApp products. 

For detailed information about... Read

Connecting NetApp LUNs SnapDrive Installation and Administration 
Guide for the version of SnapDrive that you 
are using

Configuring a Windows server Microsoft Windows documentation

Configuring Microsoft Outlook Microsoft Outlook documentation

Configuring Microsoft Exchange Microsoft Exchange documentation

Installing or upgrading SnapDrive™ 
software

SnapDrive Installation and Administration 
Guide for the version of SnapDrive that you 
are using

For detailed information about... Read

Compatible versions of SnapDrive and 
Data ONTAP™ software

SnapDrive/ONTAP Compatibility Matrix

SnapDrive system requirements: * 
Operating system * Hardware platform * 
Network

SnapDrive NOW Description page for the 
version of SnapDrive that you are using
7
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Getting HelpINTRODUCTION
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Getting Help 

NetApp provides you with the following ways to get help with Single Mailbox Recovery: “Online 
Help” on page 8 and “Technical Support” on page 8.

Online Help 

Online help includes all of the information in the administrator’s guide and more, and it lets you 
quickly access this information by using one of three tabs. The Contents tab offers a hierarchical 
view of the contents of the administrator’s guide. The Search tab offers a full-text search of the 
administrator’s guide. The Index tab offers a keyword-based way to get to specific topics. 

To start online Help

Do one of the following:

• Click the Help menu and then click Contents.
• Click  on the toolbar.
• Press the F1 key.

To identify a tool or control

• Position the pointer over a tool or control, and then pause. A tool tip shows the name of the 
item.

Technical Support 

If you have questions or problems not answered in the administrator’s guide or the online help, call 
NetApp Global Services at 1-888-4NETAPP. When reporting an issue, please include any 
information that might help us diagnose the problem. The following details are often the most 
helpful: 

• The version of Single Mailbox Recovery you are using (on the Help menu, click About).
• The version of Data ONTAP you are using.
• The version of SnapDrive you are using.
• The versions of Windows and Outlook that you are running.
• The version of Exchange that contained the source EDB file. 
• The circumstances and sequence of steps that led to the problem. 
• The text of the error messages (if any appeared), and the contents of the Details dialog box. 
• A list of other Windows programs that you were running when the error occurred.

Single Mailbox Recovery installation 
requirements

Single Mailbox Recovery 5.0 NOW 
Description page

For detailed information about... Read
8
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Installing or Upgrading Single Mailbox Recovery 

To install or upgrade to Single Mailbox Recovery 5.0, step through each of the following tasks: 

• Task I: Prepare Your Installation Environment 
• Task II: Install or Upgrade Single Mailbox Recovery 
• Task III: Enable Any Optional Agents 

Task I: Prepare Your Installation Environment 

Single Mailbox Recovery runs on the Windows server on which Microsoft Outlook is running, and 
it uses native Microsoft Messaging Application Program Interface (MAPI) protocol to 
communicate with the Microsoft Exchange Server that is running on a separate machine. The 
following illustration shows an example of a Single Mailbox Recovery environment in which you 
can restore mail items from an Exchange database (EDB) file in a SnapManager backup set 
snapshot. 

Figure 1-1. Example of a typical Single Mailbox Recovery environment

Before you install or upgrade to Single Mailbox Recovery 5.0, you must prepare your installation 
environment by verifying system requirements on both of the Microsoft Windows servers and 
configure Microsoft Outlook so that MAPI is installed on the Single Mailbox Recovery server. 

VERIFY SYSTEM REQUIREMENTS FOR YOUR SINGLE MAILBOX RECOVERY SERVER

This section covers System Requirements for Single Mailbox Recovery 5.0 and the minimum 
software requirements for Mailbox Creation Wizard.
9
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Single Mailbox Recovery 5.0

The machine on which you will run Single Mailbox Recovery must meet the following 
requirements:

• Intel Pentium class processor
• 1024 GB RAM
• 200 MB of free hard disk space for the installation of Single Mailbox Recovery.

Note:  More disk space will be needed for processing log files when opening an EDB file.

• Monitor with 800 x 600 or higher screen resolution
• One of the following operating systems:

• Windows 2000 Server
• Windows 2003 Server
• Windows Server 2008 Standard
• Windows Server 2008 Data Center
• Windows Server 2008 Enterprise
• Windows Vista Business
• Windows Vista Ultimate (32-bit and 64-bit versions)
• Windows Vista Enterprise

Note:  Single Mailbox Recovery in Vista can only be run by users with administrative 
privileges and in administrative mode.

Note:  The HASP HL override key functionality does not work on Windows Vista systems 
when using a remote desktop connection to the computer.

• The following virtual environments are supported:
• VMWare Server 1.0x 
• VMWare Workstation for Windows v6.0x
• Microsoft Virtual Server 2005 R2
• Microsoft Virtual PC 2007

Note:  Virtual operation of tape devices may have restrictions imposed by virtual operating 
systems.

Note:  HASP key operation is validated in environments that support USB attached devices 
and support the NetApp distributed HASP drivers only.

Note:  If SnapDrive will be used to connect and disconnect LUNs on the Single Mailbox 
Recovery server, then the operating system requirements must match the system 
requirements specified in the SnapDrive Installation and Administration Guide for the 
version of SnapDrive that you are using.

• Microsoft Outlook 2000 or later. Machine must have Outlook 2000 or greater installed and 
Outlook must have been run at least once to configure Outlook’s settings. Additionally, 
10



. .
 . 

. .I N T R O D U C T I O N
Installing or Upgrading Single Mailbox Recovery
those versions of Outlook that make a distinction between “Internet Email” and “Corporate 
Email” need to be configured for the latter.

• For Exchange Server 5.5: Microsoft Outlook 2000 or Outlook 2003 is required.

Note:  Microsoft Outlook 2007 cannot connect to an Exchange Server 5.5. However, 
Microsoft Outlook 2007 can be used with Single Mailbox Recovery to access an .edb file 
originating from an Exchange 5.5 environment.

• For Exchange Server 2000 and Exchange Server 2003: Microsoft Outlook 2000 or 
later is required.

• For Exchange Server 2007: Microsoft Outlook 2003 or Outlook 2007 is required. 

Note:  The Operating Systems listed above and Microsoft Outlook are required to have the latest 
service packs installed.

• Microsoft .NET 2.0 framework
• For connecting and disconnecting LUNs:

• Optional but recommended. SnapDrive

Note:  The SnapDrive version must be compatible with the version of Data ONTAP that is 
running on your NetApp storage system.

• FCP or iSCSI connectivity to the NetApp storage system

Note:  Single Mailbox Recovery is not designed to run from an Exchange server. Also, Outlook 
cannot be installed on an Exchange server.

• One or more NetApp storage systems must exist in the same network environment as the 
machine on which you run Single Mailbox Recovery.

• USB port (for Single Mailbox Recovery product licenses requiring HASP key dongle to run 
application)

Note:  Single Mailbox Recovery 5.0 supports Microsoft Exchange 5.5, Exchange Server 2000, 
Exchange Server 2003, Exchange Server 2007, or Exchange Server 2007 with SP1 installed. Single 
Mailbox Recovery 5.0 may run on Exchange Server 2007 or Exchange Server 2007 with SP1 
installed. If running Single Mailbox Recovery with Exchange Server 2007 or 2007 with SP1, 
Outlook 2003 or Outlook 2007 must be installed and configured.

Single Mailbox Recovery is designed to run from a Microsoft Windows workstation and uses native 
Microsoft Messaging APIs (MAPI) to communicate to the Exchange Server, ensuring reliable and 
consistent operation of your server. For MAPI to initialize properly, Microsoft Outlook must be 
installed and configured on the workstation to connect to an Exchange Server. When connecting to 
an Exchange Server 2007 or 2007 with SP1, Microsoft Outlook 2003 or Outlook 2007 must be 
installed and configured.

While Single Mailbox Recovery is designed to run from a Microsoft Windows workstation, 
Exchange Server 2007 installation configuration is supported. If running Single Mailbox Recovery 
on Exchange Server 2007, Microsoft Outlook 2003 or Outlook 2007 must be installed and 
configured on the Exchange Server. Single Mailbox Recovery does not support other Exchange 
Server installation configurations.
11
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Mailbox Creation Wizard

To use Mailbox Creation Wizard on your computer, you need these minimum software 
requirements.

The Exchange Management Tools can be installed on Windows XP Professional, Windows 2000 
Professional, Windows 2000 Server; Windows 2000 SP3, or Windows Server 2003. To see 
additional supported operating system  and prerequisite requirements, please refer to the Exchange 
Management Tools documentation for your specific version. 

*The Exchange 2000 Management Tools can only be used on Exchange Server 2000 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server, 
Windows 2000 SP3, or Windows Server 2003.

**The Exchange 2003 Management Tools can be used on Exchange 2000 or 2003 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server SP3, or 
Windows Server 2003.

***The Exchange 2007 Management Tools can only be used on Exchange Server 2007 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server SP3, or 
Windows Server 2003.

CONFIGURE MAPI FUNCTIONALITY ON YOUR SINGLE MAILBOX RECOVERY SERVER

Single Mailbox Recovery requires MAPI to communicate with the Exchange server. Perform the 
following steps prior to installing the Single Mailbox Recovery software. These steps ensure that a 
MAPI client (Outlook) is installed on the Single Mailbox Recovery server and establishes the 
MAPI connection between the Single Mailbox Recovery server and the MAPI application 
(Exchange).

1. Make sure that Microsoft Outlook is installed and has been run once.
2. Set up an email account on a Microsoft Exchange Server.
3. For those versions of Microsoft Outlook that distinguish between “Internet Email” and 

“Corporate Email,” use “Corporate Email” when configuring Microsoft Outlook.
4. Run Microsoft Outlook again, and connect to the Exchange Server.

Exchange Server Software Required Prerequisites

Exchange 2000 Exchange 2000 
Management Tools* 

Windows 2000 Administrative Tools

Exchange 2003 Exchange 2003 
Management Tools** 

Internet Information Server (IIS) 

Windows Server 2003 SP1 Administrative 
Tools Pack

Exchange 2007 Exchange 2007 
Management Tools*** 
(64-bit: CD; 32-bit: 
download)

IIS

.NET Framework 2.0

MMC 3.0

PowerShell 1.0
12
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Task II: Install or Upgrade Single Mailbox Recovery 

Note:  If you are upgrading from a trial version of Single Mailbox Recovery, first uninstall the trial 
version and then install the fully enabled release of Single Mailbox Recovery. Both Installing Single 
Mailbox Recovery and Uninstalling Single Mailbox Recovery are described in the paragraphs that 
follow.

INSTALLING SINGLE MAILBOX RECOVERY 
Follow these steps to install Single Mailbox Recovery: 

1. Turn off any disk utility or antivirus program running in the background. 
2. Insert the Single Mailbox Recovery CD-ROM into your CD-ROM drive. 
3. The installation program will automatically start. If it does not, click Run on the Start 

menu, and type D:\autorun.exe or D:\bin\setup.exe, where D is the drive letter of your 
CD-ROM drive. Click OK. 

4. Follow the on-screen instructions. 

UPDATING SINGLE MAILBOX RECOVERY 
NetApp periodically improves Single Mailbox Recovery—adding features, making changes based 
on customer requests, and fixing problems. When an update becomes available, follow these steps 
to download and install the update from the NetApp on the Web (NOW) web site: 

1. Using your web browser, navigate to http:\\now.netapp.com and select Software 
Downloads. 

2. When the Download Software page appears, locate the listing for Single Mailbox Recovery, 
select the Microsoft Exchange platform and click Go. 

3. On the Single Mailbox Recovery page, locate the listing for the latest version and click 
View and Download. 

4. Read the Single Mailbox Recovery Description page and click Continue. 
5. Read the License page and click Accept. 
6. Read and follow the instructions on the Single Mailbox Recovery Download page. 

UNINSTALLING SINGLE MAILBOX RECOVERY 
You can uninstall Single Mailbox Recovery by running the uninstall program.

1. Click the Start button and then click Control Panel. (In Windows 2000 and earlier, you will 
point to Settings before you click Control Panel.) 

2. In Control Panel, click the Add or Remove Programs icon. 
3. Click Single Mailbox Recovery, and then click Change/Remove. 
4. Click Yes when the confirmation dialog box appears. 
5. Follow the on-screen instructions. 
13
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Task III: Enable Any Optional Agents 

Single Mailbox Recovery includes all of the agents described in “Single Mailbox Recovery 
Agents” on page 3. The Single Mailbox Recovery ExtractWizard agent for Microsoft NT Backup 
and the Single Mailbox Recovery ExtractWizard agent for Symantec Backup Exec™ are enabled 
by default at no extra cost. All other agents are disabled by default. The following paragraphs 
describe the license.ini file and how to enable optional Single Mailbox Recovery ExtractWizard 
agents.

See also:

• About the license file
• Viewing and enabling agents

ABOUT THE LICENSE FILE 
Single Mailbox Recovery requires a license file. The license file is a NetApp-supplied, read only 
text file that specifies license settings. Before Single Mailbox Recovery enables itself, it checks the 
license file for the following: 

• Software version. The license file must be valid for Single Mailbox Recovery 5.0. You 
cannot use a Single Mailbox Recovery 4.2 license file with Single Mailbox Recovery 5.0. 

• Licensed agents. Only the agents specified in the license file will be enabled. 

VIEWING AND ENABLING AGENTS 

To view the currently enabled agents 

• On the Help menu, click About and then click License Info. 

To enable an agent

1. Contact a sales representative and specify which agent you wish to purchase. A license file 
containing the newly enabled agent will be sent to you. 

2. Replace the existing .ini file with the new .ini file. The default location for this file is in the 
Single Mailbox Recovery directory. 

Tip:  To view or change the location of the license file, see “Setting Preferences” on 
page 154. In the Single Mailbox Recovery Preferences dialog box, click the Options tab and 
read the instructions for the “License file name” preference. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Keyboard Shortcuts

Menu Bar Keyboard Shortcut

File Menu

Open Source Ctrl+S
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Keyboard Shortcuts
Open Target PST Ctrl+T

Open Target Exchange Server Ctrl+E

Close Store Ctrl+L

User Data Wizard Ctrl+W

Exit Alt+F4

Edit Menu

Copy Selection to Clipboard Ctrl+C

Paste Copied Item(s) Ctrl+V

Paste Special Ctrl+Y

Delete DEL

Rename Ctrl+R

New Folder Ctrl+N

New Mailbox Ctrl+M

Move To Folder (Microsoft Exchange 
Server as a Target - Find window)

Ctrl+Shift+V

Cut (Microsoft Exchange Server as a 
Target - Find window)

Ctrl+X

View Menu

Refresh Screen F5

Tools Menu

Integrity Check Ctrl+I

Export Ctrl+P

Create Reports Ctrl+O

Find F3

Online Help

View Help F1

Menu Bar Keyboard Shortcut
15



I N T R O D U C T I O N
Keyboard ShortcutsINTRODUCTION
16



CHAPTER 1

USING THE SINGLE MAILBOX RECOVERY 

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
EXTRACTWIZARD CHAPTER 1 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

If you have not yet extracted backed-up Exchange Information Store data, try using Single Mailbox 
Recovery ExtractWizard. The Single Mailbox Recovery ExtractWizard extracts both private and 
public Exchange Information Store data from tape and disk backups to any alternate location (e.g., 
machine, volume, folder), thereby eliminating the need for a recovery server. In contrast, most 
backup programs let you restore Exchange data only to the same or duplicate server from which it 
was backed up. 

The Direct Method of extracting backed-up Exchange data reads the tape or disk file directly 
without needing the original backup software installed. This method is useful if the original backup 
software is unavailable and you know the tapes on which the Exchange Information Store backups 
reside. For more information, see “Method of Extraction” on page 19.
The Advanced Method uses your existing backup software to extract an Exchange database from a 
backup server or tape library, across the network, to the computer running Single Mailbox 
Recovery ExtractWizard. The Advanced Method takes full advantage of your backup software’s 
knowledge of individual set locations and robotic library support. This is the fastest method to 
extract an Exchange Information Store from the most recent backups managed by your backup 
server.

For information about the Advanced Method of extracting backed-up Exchange data, see “Using 
the Single Mailbox Recovery ExtractWizard Advanced Method” on page 35.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Prerequisites

• Single Mailbox Recovery ExtractWizard requires that the tape drive be configured and 
active in the Device Manager.

• Single Mailbox Recovery ExtractWizard works best with Windows drivers supplied 
directly from the manufacturer of the tape drive hardware.

• If Single Mailbox Recovery ExtractWizard is installed on your backup server, make sure the 
services for the backup software are disabled.
17
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Single Mailbox Recovery ExtractWizardCHAPTER 1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Single Mailbox Recovery ExtractWizard

The Single Mailbox Recovery ExtractWizard steps you through the extracting process of both 
private and public Exchange Information Store data from tape and disk backups to any alternate 
location.

Welcome Page

1. Click Start, and then point to Programs. Point to NetApp, point to Single Mailbox 
Recovery, and then click Single Mailbox Recovery ExtractWizard. The first page 
describes the wizard. 

Figure 1-1. Single Mailbox Recovery ExtractWizard Welcome Page

Single Mailbox Recovery ExtractWizard: Pointing to a NetApp Device 

In order for Single Mailbox Recovery ExtractWizard to operate, one or more NetApp storage 
systems must be present on the same network as the one on which Single Mailbox Recovery 
ExtractWizard is installed. 

The first time you start Single Mailbox Recovery ExtractWizard, complete the following steps to 
point Single Mailbox Recovery ExtractWizard to the presence of a NetApp storage system that is 
running in the same network environment. 

1. When the Single Mailbox Recovery ExtractWizard Welcome page appears, click About 
and then click License Info to display the License Information page. 

2. Locate the Storage appliance name or IP address field. Type or browse and select the 
name or address of any NetApp storage system on the network and press the Enter key.
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Note:  The name or IP address of any NetApp storage system in the environment will 
suffice, whether or not you intend to carry out Single Mailbox Recovery ExtractWizard 
operations on it. 

3. After you press the Enter key, click the Close button (Be sure to press the Enter key first) 
to close the License information box. 

4. Click OK to close the About box and redisplay the Single Mailbox Recovery ExtractWizard 
Welcome page.

5. Click Next. 

Note:  After you have specified the name or IP address of a NetApp storage system in the 
environment once, you do not need to enter it again, as long as the specified storage system 
exists in this network environment. 

Method of Extraction

The second page of the Single Mailbox Recovery ExtractWizard offers two methods of extracting 
backed-up Exchange data: “Direct Method” on page 19 and “Advanced Method” on page 20.

Figure 1-2. Selecting IBM Tivoli Storage Manager in the Method of Extraction Advanced Method

DIRECT METHOD 
The Direct Method reads the tape or disk file directly without needing the original backup software 
installed. This method is useful if the original backup software is unavailable and you know the 
tapes on which the Exchange Information Store backups reside. 

The Direct Method has the following requirements:
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• The tape drive must be directly attached to the computer and configured and active in the 
Windows Device Manager.

• The latest Windows drivers supplied directly from the manufacturer of the tape drive 
hardware should be installed for best results.

• Both online and offline Exchange backups are supported.
• As Single Mailbox Recovery ExtractWizard reads tapes one at a time, you must manually 

insert and eject each tape when prompted.
• Ι f Single Mailbox Recovery ExtractWizard is installed on your backup server, make sure 

the services for the backup software are disabled. 

ADVANCED METHOD

The Single Mailbox Recovery ExtractWizard Advanced Method uses your existing backup 
software to extract an Exchange database from a backup server or tape library, across the network, 
to the computer running Single Mailbox Recovery ExtractWizard. The Advanced Method takes full 
advantage of your backup software’s knowledge of individual set locations and robotic library 
support. This is the fastest method to extract an Exchange Information Store from the most recent 
backups managed by your backup server.

Once configured for the Advanced Method, Single Mailbox Recovery ExtractWizard seamlessly 
integrates with your backup software and fully supports your existing catalogs, backups, and tape 
library. No other changes to your existing backup architecture or settings are required.

The Advanced Method offers two choices: the API method of extraction and the Exchange 
Emulation method of extraction. They share the following requirements:

• Only online Exchange backups are supported. This includes full, copy, incremental, and 
differential backups.

• The backup client software must be installed on the computer running Single Mailbox 
Recovery ExtractWizard.

Note:  The Exchange Emulation method has additional requirements. For information on using the 
Advanced Method of extracting backed-up Exchange data, see “Using the Single Mailbox 
Recovery ExtractWizard Advanced Method” on page 35.
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Exchange Information Store Extraction Source

On the next page of the Single Mailbox Recovery ExtractWizard, select the Exchange Information 
Store extraction Source.

Figure 1-3. Exchange Information Store Extraction Source

Do one of the following:

• Select Extract from Disk. Then type the extraction Source file path, use the history drop-
down menu, or browse to it. Click Next.

• Select Extract from Tape. Then insert a backup tape in your tape device and, if desired, 
select the Enable Prescan option for more accurate time estimates. Click Next. 

• If the Single Mailbox Recovery ExtractWizard cannot locate a tape in the selected device, it 
will prompt you to insert the tape. If you have more than one tape device connected to your 
system, another screen will appear. Select the device containing the tape.

• Select Use Catalog File. Then browse to a previously created catalog file, or use the history 
drop-down menu. Look for the .ewc extension on the file. Click Next. 

Important:  In order to select this option, you must have previously created one or more 
Single Mailbox Recovery ExtractWizard catalog files. For information on creating an 
Single Mailbox Recovery ExtractWizard catalog file, see “Step 3: Saving a Catalog File” 
on page 31. 
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Catalog Performance Options

The Catalog Performance Options page of the Single Mailbox Recovery ExtractWizard offers 
five options for cataloging Exchange backup data sets. All five of the options will automatically 
skip over known backup types that do not contain Exchange Information Store files. These types 
include registry backups, SQL backups, UNIX backups, image backups, NetWare backups, and 
Macintosh backups. 

Figure 1-4. Catalog Performance Options

To choose a catalog performance option

1. Select one of the following options. 
• Catalog Online Exchange backup datasets only: This option will catalog only 

known online Exchange backup datasets. It will skip all other types of backups. If the 
backup type is unknown, it will be skipped.

• Catalog Online and Offline Exchange backup datasets: This option will catalog 
known online and offline Exchange backup datasets. If an unknown backup type is 
encountered, Single Mailbox Recovery Extract Wizard will catalog it just in case it is a 
new backup identifier for Exchange backups. This option is slower because it will 
catalog more types of backups. 

• Catalog SSID for EMC NetWorker only: Enter a specific Save Set ID (SSID) or a 
list of SSIDs, separated by commas, in the box. This option is available only if the 
EMC NetWorker agent is installed and you selected a tape source. Single Mailbox 
Recovery ExtractWizard will catalog only the SSIDs listed. When Single Mailbox 
Recovery ExtractWizard detects the end of the SSIDs in the list, it will stop 
immediately and rewind the tape. 

This option greatly increases the catalog speed for EMC NetWorker users who want to 
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start on a tape in the middle of a span set. If you select a specific SSID search on a non-
EMC NetWorker tape, it will behave identically to the second option (Catalog Online 
and Offline Exchange backup datasets).

• Catalog specific object ID for IBM Tivoli only: Enter a specific object ID or a list of 
object IDs, separated by commas, in the box. This option is available only if the IBM 
Tivoli agent is installed. Single Mailbox Recovery ExtractWizard will catalog only the 
object IDs listed. When Single Mailbox Recovery ExtractWizard detects the end of the 
object IDs in the list, it will immediately stop processing. 

This option greatly increases the catalog speed for Tivoli users who know the Object ID 
of the backup they wish to extract. If you select a specific Object ID search on a non-
Tivoli tape, it will behave identically to the second option (Catalog Online and Offline 
Exchange backup datasets).

• Catalog specific job ID for CommVault Galaxy only: Enter a specific job ID or a list 
of job IDs, separated by commas, in the box. This option is available only if the 
CommVault Galaxy agent is installed. Single Mailbox Recovery ExtractWizard will 
catalog only the sessions associated with the Job IDs entered, both online and offline 
sessions. Single Mailbox Recovery ExtractWizard will be unable to know when all data 
associated with the Job ID has been processed; therefore, Single Mailbox Recovery 
ExtractWizard will be unable to stop cataloging early and will still need to process the 
entire tape. Using this option will still greatly increase the speed of the catalog, because 
all other sessions can be quickly skipped over. 

This option greatly increases the catalog speed for CommVault Galaxy users who know 
the job IDs of the backup they want to extract. This option also applies to CommVault 
backup-to-disk files. If you select a specific job ID search on a non-CommVault Galaxy 
tape, it will behave identically to the second option (Catalog Online and Offline 
Exchange backup datasets).

Note:  All five options skip known non-Exchange backups (such as registry, SQL, Unix, 
Mac, and Netware).

2. Click Next.
23



U S I N G  T H E  S I N G L E  M A I L B O X  R E C O V E R Y  E X T R A C T W I Z A R D
Single Mailbox Recovery ExtractWizardCHAPTER 1
Catalog Progress

The Catalog Progress page of the Single Mailbox Recovery ExtractWizard displays the 
progression of the cataloging process and the time remaining until completion. The Single Mailbox 
Recovery ExtractWizard catalogs the disk or tape and locates the Information Store data. 
Cataloging a disk backup is much faster than cataloging a full tape. During cataloging, the Single 
Mailbox Recovery ExtractWizard can be in one of four states: initializing, reading (processing one 
block at a time), scanning (seeking ahead multiple blocks), and rewinding. 

In addition, CommVault Galaxy Backup & Recovery displays a pre-cataloging stage (i.e., reading 
session information from the backup) after the initializing stage.

Do one of the following: 
• Click Cancel if you want to stop the catalog process. If you click Cancel, the Single 

Mailbox Recovery ExtractWizard catalog will display all files that it found to that point.
• When the catalog is completed, click Next to proceed to the next page of the Single 

Mailbox Recovery ExtractWizard.

Figure 1-5. Catalog Progress
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Exchange Information Store Selection

On the Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard, you can select both the private and public Exchange Information Store files that you 
want to extract from an Exchange backup. This page of the wizard requires you to perform four 
steps:

“Step 1: Viewing an Exchange Backup” 

“Step 2: Extracting an Online or Offline Backup” 
“Step 3: Saving a Catalog File” 

“Step 4: Completing the Exchange Information Store Selection” 

STEP 1: VIEWING AN EXCHANGE BACKUP 
1. On the left side of the window, click the plus sign (+) next to a backup set to view its 

volumes. 
2. Select a volume (select its name, not its check box) to display the Exchange Information 

Store files on the right side of the window. 

In the illustration below, the Microsoft NT Backup contains four backup sets and five 
volumes. Each backup set lists the session day and time (e.g., 8/29/2003 12:34 AM). Each 
volume lists the machine name and volume name (e.g., EXCH\Second Storage Group).

Figure 1-6. Viewing a full online disk backup (Microsoft NT Backup)

STEP 2: EXTRACTING AN ONLINE OR OFFLINE BACKUP

After viewing the Exchange backup sets and information store files, you can select the files you 
want to extract. When viewing and selecting files, keep in mind the following points:

• Microsoft NT Backup, Symantec Backup Exec, VERITAS NetBackup, and IBM Tivoli 
Storage Manager can contain multiple backup sets for both disk and tape backups.
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• CA ARCserve Backup and EMC NetWorker can contain only one backup set for disk, but 
multiple backup sets for tape.

To extract a full online (normal) backup

• On the Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard, select the .edb, .stm, and .log files, as well as .pat files, if they exist. 

Example 1: Extracting a Full Online Disk Backup (Microsoft NT Backup)
A Microsoft NT Backup to disk can contain multiple backup sets and volumes. Each 
backup set lists the session day and time (e.g., 8/29/2003 12:34 AM). Each volume lists the 
machine name and volume name (e.g., EXCH\Second Storage Group). 

Figure 1-7. Extracting a full online disk backup (Microsoft NT Backup)

• Example 2: Extracting a Full Online Disk Backup (CA ARCserve Backup)
A CA ARCserve backup to disk can contain only one backup set and volume. The backup 
set lists the session day and time (e.g., 8/29/2003 10:32 AM). Each volume lists the machine 
name and volume name (e.g., Exch\First Storage Group).
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Figure 1-8. Extracting a full online disk backup (CA ARCserve Backup)

• Example 3: Extracting a Full Online Tape Backup (EMC NetWorker)
An EMC NetWorker backup to tape can contain multiple backup sets and volumes. This 
example only displays one online backup set. The backup set lists the SSID (e.g., 
4247758661). The volume lists the machine name and volume name.

Figure 1-9. Extracting a full online tape backup (EMC NetWorker)

• Example 4: Extracting a Full Online Tape Backup (VERITAS NetBackup)
A VERITAS NetBackup to tape can contain multiple backup sets and volumes. This 
example only displays one online backup set. Each backup set lists the session day and time 
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(e.g., 11/17/2005 3:42 PM). Each volume lists the machine name. Online backups also 
include the volume name (e.g., pc\First Storage Group).

Figure 1-10. Extracting a full online tape backup (VERITAS NetBackup)

To extract the last full online and every incremental backup

• On the Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard, select all of the files (e.g., .edb, .log, .stm, .pat) from the last full online 
(normal) backup, plus the .log files from every incremental backup.

Figure 1-11. Extracting the full online plus every incremental backup to disk (Microsoft NT 
Backup)
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To extract the last full online and last differential backup 

• On the Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard, select all of the files (e.g., .edb, .log, .stm, .pat) from the last full online 
(normal) backup, plus the .log files from the last differential backup.

Figure 1-12. Extracting the last normal plus the last differential backup to disk (Microsoft 
NT Backup)

To extract an online copy backup (plus every incremental or last differential) 

Use the same procedure for extracting a copy backup as you do for extracting a full online backup. 
A copy backup also works the same as a full online backup when extracting a copy backup plus 
every incremental or last differential backup. For more information see the following topics:

• To “extract a full online (normal) backup” on page 26
• To “extract the last full online and every incremental backup” on page 28
• To “extract the last full online and last differential backup” on page 29

Note:  The only difference between a full online backup and a copy backup is the following: For a 
full online backup, the .log files are truncated. For a copy backup, the .log files are not truncated.

About Extracting a Full Offline Backup

The Single Mailbox Recovery ExtractWizard works the same for an offline backup as it does for an 
online backup. There are four differences between an offline backup and an online backup: 

1. For an offline backup, you need to extract the .edb and .stm files. To ensure that all email 
data is recovered, you should also include all .log files, as well as .pat and .chk files if they 
exist. Single Mailbox Recovery performs its own verification process and will include the 
.log, .pat, and .chk files to determine if it needs them to recover the data.

2. An offline backup can contain a .chk file.
3. The name of the volume for an offline backup displays the drive letter.
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4. The volume for an offline backup extracts the full path for the Information Store files.

To extract a full offline backup

• On the Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard, select the .edb and .stm files. To ensure that all email data is recovered, you 
should also select .log files, as well as .pat and .chk files if they exist.

Figure 1-13. Extracting a full offline disk backup (Microsoft NT Backup)

About Extracting a Backup from Exchange Server 5.5 vs. Exchange Server 2000/2003/2007 

Extracting data from Exchange Server 5.5 works the same way as extracting data from Exchange 
Server 2000/2003/2007. However, when you are selecting files to extract on the Exchange 
Information Store File Selection page of the Single Mailbox Recovery ExtractWizard, you will 
notice two differences: 

• Exchange Server 5.5 through Exchange Server 2000 (SP1) contain .pat (patch) files in their 
information stores, whereas Exchange Server 2000 (SP2) and later do not contain .pat files 
in their information stores. 
In Exchange Server 5.5 through Exchange Server 2000 (SP1), the .pat files are used to 
record information on page splits. In Exchange Server 2000 (SP2) and later, the 
functionality provided by .pat files is incorporated into Exchange log files.

• Exchange Server 2000/2003 information stores contain .stm files in addition to the .edb 
files. Exchange Server 5.5 and Exchange Server 2007 (SP1) do not contain .stm files.
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Using the “Show Duplicates” Option for CommVault Galaxy Backup & Recovery

Single Mailbox Recovery ExtractWizard has a “Show Duplicates” check box for CommVault 
users. Duplicates can occur when CommVault Backup fails and restarts. You can select this check 
box, and if duplicates exist, they will appear on the right side of the Single Mailbox Recovery 
ExtractWizard window. If Single Mailbox Recovery ExtractWizard or Single Mailbox Recovery 
encounters a problem with a file, you can then attempt to extract its duplicate. This feature saves 
time by allowing you to extract only that file (i.e., its duplicate) which encountered the problem, 
instead of performing a full extraction of all of the files in the session. 

To use the “Show Duplicates” Option for CommVault Galaxy Backup & Recovery

1. Select the Show Duplicates check box. If duplicates exist, they will appear on the right side 
of the Single Mailbox Recovery ExtractWizard window. 

2. Select the duplicate(s) of the file(s) that encountered problems in Single Mailbox Recovery  
ExtractWizard or Single Mailbox Recovery, and click Next.

3. Complete the remaining steps of the Single Mailbox Recovery ExtractWizard.

STEP 3: SAVING A CATALOG FILE

The catalog file saves all the information that Single Mailbox Recovery ExtractWizard needs to 
extract from a backup disk or tape. Saving a catalog file means that the next time you extract from 
that tape or backup disk, you can skip the catalog process. 

To save a Catalog File

1. On the Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard, select the files you want to extract, and then select the Save Single Mailbox 
Recovery ExtractWizard Catalog File check box.

2. Browse to the desired location, type a file name, and click Save. Note that the catalog file is 
not saved until you click Next.

Figure 1-14. Saving a Catalog File
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STEP 4: COMPLETING THE EXCHANGE INFORMATION STORE SELECTION

On the Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard, make sure you have selected the Information Store files that you want to extract, 
and saved the Single Mailbox Recovery ExtractWizard catalog file, if desired. Then click Next to 
proceed to the last page of the wizard. 

Exchange Information Store Destination Folder

Use the Exchange Information Store Destination Folder page of the wizard to specify a location for 
the extracted data.

1. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, type the path where you want Single Mailbox Recovery 
ExtractWizard to extract the data, use the history drop-down menu, or browse to the desired 
location and type the file name. (The Browse window lets you create a new folder on the 
Target volume, unless you are running Windows NT 4). 

2. Click Next. The Single Mailbox Recovery ExtractWizard verifies that you have enough 
disk space as well as access rights to create files and directories.

Figure 1-15. Exchange Information Store Destination Folder
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Exchange Information Store Copy Progress

The Exchange Information Store Copy Progress page of the Single Mailbox Recovery 
ExtractWizard shows the progress of the Single Mailbox Recovery ExtractWizard extracting the 
Exchange Information Store data to the destination folder. This process may take some time. 

The top bar indicates the progress for the file that is currently being extracted. The bottom bar 
indicates the progress for all of the files. For EMC NetWorker and NetBackup tapes, the top bar 
may switch back and forth between files if they are interleaved. 

During file extraction, Single Mailbox Recovery ExtractWizard can be in one of four states: 
initializing, reading (processing one block at a time), scanning (seeking ahead multiple blocks), and 
rewinding.

Figure 1-16. Exchange Information Store Copy Progress

Note:  You can click Cancel to stop the process. The file currently being extracted will be deleted, 
but you can access any files that have completed extraction.
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Completing the Wizard

The last page of the Single Mailbox Recovery ExtractWizard displays all of the files that were 
successfully extracted. If you are satisfied with the results, click Finish.

Figure 1-17. Single Mailbox Recovery ExtractWizard complete

If you extracted multiple data sets, see “Organizing the Extracted Files for Single Mailbox 
Recovery” on page 34.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Organizing the Extracted Files for Single Mailbox Recovery 

Before using the extracted files to restore Exchange mail items, you will need to organize the 
extracted files for Single Mailbox Recovery if the backup was created using one of the following 
backup methods: 

• Online incremental backup 
• Online differential backup 
• Offline backup 

For detailed information, see “Organizing Files Extracted from Other Backup Applications” on 
page 286.
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Overview

The Single Mailbox Recovery ExtractWizard Advanced Method uses your existing backup 
software to extract an Exchange database from a backup server or tape library, across the network, 
to the computer running Single Mailbox Recovery ExtractWizard. The Advanced Method takes full 
advantage of your backup software’s knowledge of individual set locations and robotic library 
support. This is the fastest method to extract an Exchange Information Store from the most recent 
backups managed by your backup server.

Once configured for the Advanced Method, Single Mailbox Recovery ExtractWizard seamlessly 
integrates with your backup software and fully supports your existing catalogs, backups, and tape 
library. No other changes to your existing backup architecture or settings are required.

Note:  For information on using the Direct Method of extracting backed-up Exchange data, see 
“Using the Single Mailbox Recovery ExtractWizard” on page 17.

Single Mailbox Recovery ExtractWizard Advanced Method: Two Modes of Operation

The Single Mailbox Recovery ExtractWizard Advanced Method offers you two choices:

• API Method: With this method, Single Mailbox Recovery ExtractWizard communicates 
directly with the backup software server through methods provided by the client side .dll 
files. For more information, see “Using the API Method” on page 37. The API method is 
used for these types of backup software: 

• IBM Tivoli Storage Manager — see “Using the API Method for IBM Tivoli Storage 
Manager” on page 37

• EMC NetWorker — see “Using the API Method for EMC NetWorker” on page 43
• Exchange Emulation: With this method, Single Mailbox Recovery ExtractWizard appears 

as an Exchange Server to the backup software. You run the backup software and extract the 
Exchange data to the computer running Single Mailbox Recovery ExtractWizard. For more 
information, see “Using the Exchange Emulation Method” on page 50. The Exchange 
Emulation method is used for these types of backup software: 
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• Microsoft NT Backup — see “Exchange Emulation for Microsoft NT Backup” on 
page 52

• HP OpenView Storage Data Protector — see “Exchange Emulation for HP OpenView 
Storage Data Protector” on page 65

• Symantec Backup Exec — see “Exchange Emulation for Symantec Backup Exec 8.6 
and 9.1/10.1/11d” on page 75

• VERITAS NetBackup — see “Exchange Emulation for Veritas NetBackup” on 
page 108

• CA ARCserve Backup— see “Exchange Emulation for CA ARCserve Backup” on 
page 97

• CommVault Galaxy Backup & Recovery — see “Exchange Emulation for CommVault 
Galaxy Backup & Recovery” on page 118

Requirements for Using the Single Mailbox Recovery ExtractWizard Advanced Method 

The API and Exchange Emulation advanced methods share three main requirements:

• Only online Exchange backups are supported. This includes full, copy, incremental, and 
differential backups.

• The backup client software must be installed on the computer running Single Mailbox 
Recovery ExtractWizard.

• One or more NetApp storage systems must exist in the same network environment.

Note:  The Exchange Emulation method has additional requirements. For more information, see 
“Requirements for Using the Exchange Emulation Method” on page 51.
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Using the API Method

The API method of extracting backed-up Exchange data allows Single Mailbox Recovery 
ExtractWizard to communicate directly to the backup software server. Single Mailbox Recovery 
ExtractWizard queries the backup server for online Exchange backups using the backup software’s 
API (Application Program Interface). You then select which backups you want extracted and 
Single Mailbox Recovery ExtractWizard will extract the databases to the desired location on disk. 

Using the API Method for IBM Tivoli Storage Manager

1. Install the IBM Tivoli client software on the computer that will be running Single Mailbox 
Recovery ExtractWizard.

2. Start Single Mailbox Recovery ExtractWizard. Click Start, and then point to Programs. 
Point to NetApp, point to Single Mailbox Recovery, and then click Single Mailbox 
RecoveryExtractWizard. The first page describes the wizard. 

Figure 2-1. Single Mailbox Recovery ExtractWizard Welcome Page

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. Click Next.
The Method of Extraction page of the Single Mailbox Recovery ExtractWizard offers two 
methods of extracting backed-up Exchange data. For more information on these two 
methods, see “Method of Extraction” on page 19.
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Figure 2-2. Method of Extraction

4. Select the Advanced Method option.
5. Select IBM Tivoli Storage Manager from the drop-down menu.
6. Click Next. The Connection Parameters page of the Single Mailbox Recovery 

ExtractWizard lets you specify the backup server and client computer names. 

Figure 2-3. Connection parameters for NT Backup

7. Specify the connection parameters:
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• For Backup Server, enter the name of the computer on which the backup server 
software is installed.

• For Client Node, enter the IBM Tivoli client node that backed up the Exchange 
Information Store.

• For Password, enter the client password.
• For Protocol, select one of the following options:

==>TCP/IP Port: Refer to your IBM Tivoli Storage Manager user guide or help for 
instructions.

==>Named Pipe: Refer to your IBM Tivoli Storage Manager user guide or help for 
instructions.

• For Only catalog Exchange databases that were backed up in this time period, 
select the desired time period.

Note:  The Catalog Progress page of the Single Mailbox Recovery ExtractWizard shows the 
catalog progress. The Single Mailbox Recovery ExtractWizard queries the Tivoli backup 
server database for Information Store backups. 

Figure 2-4. Initializing the Catalog Process

8. Do one of the following: 
• Click Cancel if you want to stop the catalog process. If you click Cancel, the Single 

Mailbox Recovery ExtractWizard catalog will display all files that it found to that 
point.

• When the catalog is completed, click Next to proceed to the next page of the Single 
Mailbox Recovery ExtractWizard.
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The Exchange Information Store File Selection page of the Single Mailbox Recovery 
ExtractWizard lets you select both the private and public Exchange Information Store files 
that you want to extract from an Exchange backup. 
In the following example, IBM Tivoli Storage Manager can contains multiple backup sets 
and volumes. Each backup set lists the session day and time (e.g., Feb 08 14:01:29 2005). 
Each volume lists the computer name and volume name. The objects belonging to the 
volume appear on the right side of the window. One object contains the log files, and the 
other object contains the .edb and .stm files.

Note:  An asterisk (*) next to a backup indicates that it is an incremental or differential 
backup.

Figure 2-5. Extracting a full online disk backup (IBM Tivoli Storage Manager)

9. On the left side of the window, click the plus sign (+) next to a backup set to view its 
volumes. 

10. Select a volume (select its name, not its check box) to display the Exchange Information 
Store objects on the right side of the window. 

11. Select the check boxes next to the objects containing the .log, .edb, and .stm files, as well as 
.pat files, if they exist. 

12. Click Next. The Exchange Information Store Destination Folder page of the Single 
Mailbox Recovery ExtractWizard lets you select a folder for the extracted files. 
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Figure 2-6. Exchange Information Store Destination Folder

13. Under Destination Folder, specify a location for the extracted files. 
14. Click Next. Before proceeding to extract the Exchange Information Store data to the 

destination folder, Single Mailbox Recovery ExtractWizard performs two verification steps. 
• First verification: The Single Mailbox Recovery ExtractWizard checks for the 

following conditions: 
• You have specified the name or address of a NetApp storage system that 

exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.  
41



U S I N G  T H E  S I N G L E  M A I L B O X  R E C O V E R Y  E X T R A C T W I Z A R D  A D V A N C E D  M E T H O D
Using the API MethodCHAPTER 2
Figure 2-7. Enter Storage Appliance Name dialog box

15. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

16. Click OK to proceed to the next verification. 
17. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

18. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. This process may take some time. 

Figure 2-8. Exchange Information Store Copy Progress

19. (Optional) Click Cancel only if you want to stop the process. The file currently being 
extracted will be deleted, but you can access any files that have completed extraction. 

The last page of the Single Mailbox Recovery ExtractWizard displays all of the files that 
were successfully extracted. 
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Figure 2-9. The Finished window for Single Mailbox Recovery ExtractWizard

20. If you are satisfied with the results, click Finish.
21. If you extracted multiple data sets, see “Organizing the Extracted Files for Single Mailbox 

Recovery” on page 138.

Using the API Method for EMC NetWorker

Before you use the API Method for EMC NetWorker, you must do the following:

• For EMC NetWorker 7.3 and older: Make sure your current login has remote access to 
the client to which you are restoring. To gain remote access, perform these steps: 1) Run 
NetWorker Administrator. 2) Select Manage Clients. 3) Right-click the Exchange client 
you wish to restore the database from and click Edit. 4) In the Remote tab, enter your full 
user name in the Remote Access box. Example: postmaster@netapp.com.

• For EMC NetWorker 7.4: Make sure your current login has remote access to the client to 
which you are restoring. To gain remote access, perform these steps: 1) Run NetWorker 
Administrator. 2) Select Manage Clients. 3) Right-click the Exchange client you wish to 
restore the database from and click Edit. 4) In the client Properties, click the Globals (1 of 
2) tab. Add the machine name that will be running Single Mailbox Recovery ExtractWizard 
in the Aliases field for the client.

• Make sure your login has EMC NetWorker administrative rights to get correct sizes for 
Exchange files. If you do not have these rights, you can still run Single Mailbox Recovery 
ExtractWizard, but you will not get accurate extraction progress. 

To use the API Method for EMC NetWorker

1. Install the EMC NetWorker client software on the computer that will be running Single 
Mailbox Recovery ExtractWizard.
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2. Start Single Mailbox Recovery ExtractWizard. Click Start, and then point to Programs. 
Point to NetApp , point to Single Mailbox Recovery, and then click Single Mailbox 
Recovery ExtractWizard. The first page describes the wizard. 

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

Figure 2-10. Single Mailbox Recovery ExtractWizard Welcome Page

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location.

The license file controls which Single Mailbox Recovery ExtractWizard agents are active. 
For more information, see “Single Mailbox Recovery Agents” on page 3 and “About the 
license file” on page 14.
The Method of Extraction page of the Single Mailbox Recovery ExtractWizard offers two 
methods of extracting backed-up Exchange data. For more information on these two 
methods, see “Method of Extraction” on page 19.
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Figure 2-11. Selecting EMC NetWorker in the Method of Extraction Advanced Method

4. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 
Advanced Method and EMC NetWorker.

5. Click Next. The Connection Parameters page of the Single Mailbox Recovery 
ExtractWizard lets you specify the backup server and client computer names.

Figure 2-12. Connection parameters for EMC NetWorker
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6. Specify the connection parameters:
• For Backup Server, enter the name of the computer on which the backup server 

software is installed.
• For Client, enter the EMC NetWorker client that backed up the Exchange Information 

Store.
• For Only catalog Exchange databases that were backed up in this time period, 

select the desired time period.

Note:  The Catalog Progress page of the Single Mailbox Recovery ExtractWizard shows the 
catalog progress. The Single Mailbox Recovery ExtractWizard queries the EMC NetWorker 
backup server database for Information Store backups.

Figure 2-13. Initializing the Catalog Progress

7. Do one of the following: 
• Click Cancel if you want to stop the catalog process. If you click Cancel, the Single 

Mailbox Recovery ExtractWizard catalog will display all files that it found to that 
point.

• When the catalog is completed, click Next to proceed to the next page of the Single 
Mailbox Recovery ExtractWizard.

Note:  The Exchange Information Store File Selection page of the Single Mailbox 
Recovery ExtractWizard lets you select both the private and public Exchange Information 
Store files that you want to extract from an Exchange backup. 

• In the following example, EMC NetWorker can contains multiple backup sets and 
volumes. Each backup set lists the session day and time (e.g., Wed Jan 26 14:36:58 
2005). Each volume lists the computer name and volume name.

Note:  An asterisk (*) next to a backup indicates that it is an incremental or differential 
backup.
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Figure 2-14. Extracting a full online disk backup (EMC NetWorker) 

8. On the left side of the window, click the plus sign (+) next to a backup set to view its 
volumes. 

9. Select a volume (select its name, not its check box) to display the Exchange Information 
Store objects on the right side of the window. 

10. Select the check boxes next to the .log, .edb, and .stm files, as well as .pat files, if they exist. 
11. Click Next. The Exchange Information Store Destination Folder page of the Single 

Mailbox Recovery ExtractWizard lets you select a folder for the extracted files. 
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Figure 2-15. Exchange Information Store Destination Folder

12. Under Destination Folder, specify a location for the extracted files.
13. Click Next. Before proceeding to extract the Exchange Information Store data to the 

destination folder, Single Mailbox Recovery performs two verification steps.
• First verification: The Single Mailbox Recovery ExtractWizard checks for the 

following conditions: 
• You have specified the name or address of a NetApp storage system that 

exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.  
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Figure 2-16. Enter Storage Appliance Name dialog box

14. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

15. Click OK to proceed to the next verification. 
16. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

17. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. This process may take some time. 

Figure 2-17. Exchange Information Store Copy Progress

18. (Optional) Click Cancel only if you want to stop the process. The file currently being 
extracted will be deleted, but you can access any files that have completed extraction. The 
last page of the Single Mailbox Recovery ExtractWizard displays all of the files that were 
successfully extracted. 
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Figure 2-18. Finished window for Single Mailbox Recovery ExtractWizard

19. If you are satisfied with the results, click Finish.
20. If you extracted multiple data sets, see “Organizing the Extracted Files for Single Mailbox 

Recovery” on page 34.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Using the Exchange Emulation Method

The Exchange Emulation method of extracting backed-up Exchange data allows you to run your 
backup software and restore to the computer running Single Mailbox Recovery ExtractWizard, 
which acts as the alternate Exchange Server. Single Mailbox Recovery ExtractWizard responds to 
the backup software by using the same interfaces that Exchange uses. 

Two Basic Steps for Using the Exchange Emulation Method 

1. Start Single Mailbox Recovery ExtractWizard on the computer where the Exchange 
Information Store files will be restored. Then configure it for the Advanced Method of 
Exchange Emulation.

2. Start your backup restore software on the computer you normally run it on, and then 
perform a redirected online restore to an alternate Exchange Server. The computer running 
Single Mailbox Recovery ExtractWizard acts as the alternate Exchange Server.
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Figure 2-19. The Single Mailbox Recovery ExtractWizard Exchange Emulation Method

Terms

• Restore Target Computer is the computer running Single Mailbox Recovery 
ExtractWizard, where the Exchange Information Store files will be restored.

• Backup Restore Software is the backup software used to initiate the restore. It may be on 
the same computer running Single Mailbox Recovery ExtractWizard. 

Note:  For Veritas NetBackup, you must run your backup restore software on the computer running 
Single Mailbox Recovery ExtractWizard.

Requirements for Using the Exchange Emulation Method 

The Advanced Method for Exchange Emulation has five requirements:

• Only online Exchange backups are supported. This includes full, copy, incremental, and 
differential backups.

• The backup client software must be installed on the computer running Single Mailbox 
Recovery ExtractWizard.

• Single Mailbox Recovery ExtractWizard cannot be run on an Exchange Server.
• Backup restore .dll files must be in the system path on the computer running Single Mailbox 

Recovery ExtractWizard. For Exchange Server 2000/2003/2007, esebcli2.dll is required as 
well as a registry key pointing to it. For Exchange Server 5.5, edbbcli.dll is required. For 
more information, see the instructions for each type of backup software discussed in this 
section.

• You must have the rights to create and start services on the computer running Single 
Mailbox Recovery ExtractWizard. 
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Exchange Emulation for Microsoft NT Backup

In order to run Microsoft NT Backup on the computer running Exchange Emulation, NT Backup 
must be set up to do online Exchange backups. If it is not, follow the instructions in this Microsoft 
Knowledge Base article:

• XADM: How to Use Microsoft NT Backup from a Non-Exchange 2000 Computer 
http://support.microsoft.com/?kbid=275876

For information on related topics, refer to these Microsoft Knowledge Base articles:

• XADM: Troubleshooting a Remote Online Backup of Exchange 2000 
http://support.microsoft.com/?kbid=275676

• XADM: Files Needed to Perform Exchange NT Backup on Workstation 
http://support.microsoft.com/?kbid=181445

Exchange Emulation for NT Backup: Exchange Server 2000/2003/2007 on Windows 
2000/XP/2003 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, do one of 
the following: 

• Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory.

• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\system32 or windows\system32.

Figure 2-20. Example of Setting the Registry Key

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and NT Backup. 
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Figure 2-21. Selecting NT Backup in the Method of Extraction Advanced Method

6. Click Next. The Connection Parameters page of the Single Mailbox Recovery 
ExtractWizard appears.

Figure 2-22. Selecting the Connection Parameters, NT Backup

7. Select the Exchange Server 2000, 2003, or 2007 option.
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8. In the Storage Groups box, enter the name of the storage group you will be extracting. The 
storage group name is case sensitive and must match exactly the name that appears in the 
Exchange System Manager. You can enter multiple storage groups, separated by semicolons 
(;). 

9. Click Next. 
10. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it). 

Figure 2-23. Exchange Information Store Destination Folder

11. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
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drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.

Figure 2-24. Enter Storage Appliance Name dialog box

12. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

13. Click OK to proceed to the next verification. 
14. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

15. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.
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Figure 2-25. The Exchange Emulation information window

Tip:  You can copy the “Restore to” and “Log file path” information on this page and paste 
it into NT Backup when prompted later in this section.

16. Start NT Backup (Backup Utility in Windows XP and 2003) on the computer you normally 
run your restores on. This can be the same computer as the one running Single Mailbox 
Recovery ExtractWizard.

17. Do one of the following:
• If NT Backup is on a different computer than Single Mailbox Recovery ExtractWizard, 

proceed to step 12.
• If NT Backup is on the same computer as Single Mailbox Recovery ExtractWizard, 

skip steps 12-15 and proceed to step 16.
18. In NT Backup, click the Backup tab. 
19. On the Tools menu, click Remote Store.
20. In the Remote Store window, enter the name of the Restore Target Computer (i.e., the 

computer running Single Mailbox Recovery ExtractWizard). The name must be in all 
capital letters. See previous step 9 to verify that you are using the “Restore to” value from 
the Exchange Emulation page of the Single Mailbox Recovery ExtractWizard. Click OK.

21. If you receive an error stating that the Microsoft Exchange Server does not appear in the 
Backup tree (i.e., it does not appear in the left pane in the Backup tab), this means that NT 
Backup is not able to verify the Single Mailbox Recovery ExtractWizard emulation. 
Therefore, you must follow the steps outlined in this article from the Microsoft Knowledge 
Base: “XADM: Troubleshooting a Remote Online Backup of Exchange 2000”: 
http://support.microsoft.com/?kbid=275676 

When NT Backup has finished verifying the computer, the Restore Target computer appears 
under the Microsoft Exchange Server node.
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22. In NT Backup, click the Restore tab (the Restore and Manage Media tab in Windows 
2003).

23. In the tree view, select your Exchange backup from the list of media.
24. Click Start Restore. The Restoring Database Store window appears.
25. In the Restore To box, enter the name of the Restore Target Computer (i.e., the computer 

running Single Mailbox Recovery ExtractWizard). The name must be in all capital letters. 
See previous step 9 to verify that you are using the “Restore to” value from the Exchange 
Emulation page of the Single Mailbox Recovery ExtractWizard. 

26. In the Temporary location for log and patch files box, enter the log file path. See previous 
step 9 to verify that you are using the “Log file path” value from the Exchange Emulation 
page of the Single Mailbox Recovery ExtractWizard.

27. Do not select either of the check boxes at the bottom of the Restoring Database Restore 
window.

28. Click OK. NT Backup will start to restore Exchange files to the Single Mailbox Recovery 
ExtractWizard. The Restore Progress window appears.

29. When NT Backup has finished, click Close and close NT Backup.
30. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for NT Backup: Exchange Server 5.5 on Windows 2000/XP/2003 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, make sure 
edbbcli.dll is in the system path. The easiest way to ensure this is to copy edbbcli.dll to 
winnt\system32 or windows\system32. The edbbcli.dll file can be found on the Exchange 
Server in the Exchange Server\bin directory.

2. Start Single Mailbox Recovery ExtractWizard. 

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then License Info. 
Under License File Name, specify a new location. The license file controls which Single 
Mailbox Recovery ExtractWizard agents are active. For more information, see “Single 
Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and NT Backup. Then click Next.
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Figure 2-26. Selecting NT Backup in the Method of Extraction Advanced Method

6. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 
select the Exchange Server 5.5 option and click Next. 

Figure 2-27. Selecting Exchange Server 5.5 as the Connection Parameters, NT Backup
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7. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive and of the form x:\Path where x is a valid drive letter that has an administrative 
share associated with it such as x$, and Path is the complete path to a folder (if a folder 
doesn’t exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-28. Exchange Information Store Destination Folder

8. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-29. Enter Storage Appliance Name dialog box

9. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

10. Click OK to proceed to the next verification. 
11. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

12. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-30. The Exchange Emulation information window
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Tip:  You can copy the “Restore to” information on this page and paste it into NT Backup 
when prompted later in this section.

13. Start NT Backup (Backup Utility in Windows XP and 2003) on the computer you normally 
run your restores on. This can be the same computer as the one running Single Mailbox 
Recovery ExtractWizard.

14. In NT Backup, click the Restore tab (the Restore and Manage Media tab in Windows 
2003). 

15. In the tree view, select your Exchange backup from the list of media. NT Backup allows you 
to restore only one Exchange Information Store at a time.

Note:  You cannot restore the Directory.

16. Click Start Restore. The Restoring Microsoft Exchange window appears.
17. Select the Erase all existing data check box.
18. In the Restore To box, enter the name of the Restore Target Computer (i.e., the computer 

running Single Mailbox Recovery ExtractWizard). The name must be in all capital letters. 
See previous step 7 to verify that you are using the “Restore to” value from the Exchange 
Emulation page of the Single Mailbox Recovery ExtractWizard.

19. Click OK. NT Backup will start to restore Exchange files to the Single Mailbox Recovery 
ExtractWizard.

20. When NT Backup has finished, click Close and close NT Backup.
21. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for NT Backup: Exchange Server 5.5 on Windows NT 4 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, make sure 
edbbcli.dll is in the system path. The easiest way to ensure this is to copy edbbcli.dll to 
winnt\system32 or windows\system32. The edbbcli.dll file can be found on the Exchange 
Server in the Exchange Server\bin directory.

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and NT Backup.
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Figure 2-31. Selecting NT Backup in the Method of Extraction Advanced Method

6. Click Next.
7. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5 option and click Next. 

Figure 2-32. Selecting Exchange Server 5.5 Connection Parameters
62



. .
 . 

. .U S I N G  T H E  S I N G L E  M A I L B O X  R E C O V E R Y  E X T R A C T WI Z A R D  A D V A N C E D  M E T H O D
Using the Exchange Emulation Method
8. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive and of the form x:\Path where x is a valid drive letter that has an administrative 
share associated with it such as x$, and Path is the complete path to a folder (if a folder 
doesn’t exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-33. Exchange Information Store Destination Folder

9. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-34. Enter Storage Appliance Name dialog box

10. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

11. Click OK to proceed to the next verification. 
12. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

13. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-35. The Exchange Emulation information window

Tip:  You can copy the “Restore to” information on this page and paste it into NT Backup 
when prompted later in this section.
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14. Start Microsoft NT Backup on the computer you normally run your restores on. This can be 
the same computer as the one running Single Mailbox Recovery ExtractWizard.

15. In the Tapes window, select the Exchange backup you want to restore. NT Backup allows 
you to restore only one Exchange Information Store at a time.

Note:  You cannot restore the Directory.

16. Click Restore. The Restoring Microsoft Exchange window appears.
17. In the Destination Server box, enter the name of the Restore Target Computer (i.e., the 

computer running Single Mailbox Recovery ExtractWizard). The name must be in all 
capital letters. See previous step 7 to verify that you are using the “Restore to” value from 
the Exchange Emulation page of the Single Mailbox Recovery ExtractWizard.

18. Select the Erase all existing data check box.
19. Click OK. NT Backup will start to restore Exchange files to the Single Mailbox Recovery 

ExtractWizard.
20. When NT Backup has finished, click Close and close NT Backup.
21. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for HP OpenView Storage Data Protector

Exchange Emulation for HP OpenView Storage Data Protector and Exchange Server 
2000/2003 

1. Install HP client software on the computer that will be running Single Mailbox Recovery 
ExtractWizard. When choosing components for this client, make sure to include the MS 
Exchange 2000 Integration component.

Note:  If the computer running Single Mailbox Recovery ExtractWizard already has the HP 
client software installed, make sure the MS Exchange 2000 Integration component has been 
included in the installation.
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Figure 2-36. Properties Window for HP OpenView Storage Data Protector

2. On the computer that will be running Single Mailbox Recovery ExtractWizard, do one of 
the following: 

• Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory.

• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\system32 or windows\system32.

Figure 2-37. Example of Setting the Registry Key

3. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 4.

4. Click Next. 
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5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 
Advanced Method and HP OpenView Storage Data Protector.

Figure 2-38. Selecting HP OpenView Storage Data Protector in the Method of Extraction 
Advanced Method

6. Click Next.
7. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 2000 or 2003 option.

Figure 2-39. Selecting Exchange Server 2000 or 2003 Connection Parameters
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8. Click Next.
9. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-40. Exchange Information Store Destination Folder

10. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.
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If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.

Figure 2-41. Enter Storage Appliance Name dialog box

11. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

12. Click OK to proceed to the next verification. 
13. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

14. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.
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Figure 2-42. The Exchange Emulation information window

Tip:  You can refer to the “Restore to” and “Log file path” information on this page when 
verifying it in HP OpenView Storage Data Protector later in this section.

15. Start HP OpenView Storage Data Protector on the computer you normally run your restores 
on. This can be the same computer as the one running Single Mailbox Recovery 
ExtractWizard.

16. Select Restore from the drop-down list at the top left of the window. 
17. In the left pane, expand the MS Exchange 2000 Server tree node and select the appropriate 

Exchange Server.
18. In the right pane, click the Source tab and then select the Exchange backup you want to 

restore.
19. In the right pane, click the Options tab.
20. Select the Restore to another client check box. 
21. Select the name of the Restore Target Computer from the drop-down menu. See previous 

step 8 to verify that you are using the “Restore to” value from the Exchange Emulation page 
of the Single Mailbox Recovery ExtractWizard.

22. In the Directory for temporary log files box, enter the log file path. See previous step 8 to 
verify that you are using the “Log file path” value from the Exchange Emulation page of the 
Single Mailbox Recovery ExtractWizard.

23. Do not select the Last resort set (start recovery) check box.

Note:  If this check box is selected, HP OpenView Storage Data Protector will display a 
message stating the restore failed. Click OK. The files will still be extracted and usable.

24. Click the Devices tab, and verify your devices are properly configured. 
25. Click the Media tab, and verify the required media is available.
26. Click Restore. The Start Restore Session window appears.
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27. Do one of the following:
• Click Next to specify options on Report level and Network load, and then click Finish.
• Click Finish.

28. When HP OpenView Storage Data Protector says it has finished, close the program.
29. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for HP OpenView Storage Data Protector and Exchange Server 5.5 

1. Install HP client software on the computer that will be running Single Mailbox Recovery 
ExtractWizard. When choosing components for this client, make sure to include the MS 
Exchange 5.x Integration component. 

Note:  If the computer running Single Mailbox Recovery ExtractWizard already has the HP 
client software installed, make sure the MS Exchange 5.x Integration component has been 
included in the installation.

2. On the computer running Single Mailbox Recovery ExtractWizard, make sure edbbcli.dll is 
in the system path. The easiest way to ensure this is to copy edbbcli.dll to winnt\system32 
or windows\system32. The edbbcli.dll file can be found on the Exchange Server in the 
Exchange Server\bin directory.

3. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 4.

4. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

5. Click Next. 
6. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and HP OpenView Storage Data Protector.
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Figure 2-43. Selecting HP OpenView Storage Data Protector in the Method of Extraction 
Advanced Method

7. Click Next.
8. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5 option.

Figure 2-44. Selecting Exchange Server 5.5 Connection Parameters

9. Click Next.
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10. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive and of the form x:\Path where x is a valid drive letter that has an administrative 
share associated with it such as x$, and Path is the complete path to a folder (if a folder 
doesn’t exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-45. Exchange Information Store Destination Folder

11. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-46. Enter Storage Appliance Name dialog box

12. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

13. Click OK to proceed to the next verification. 
14. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

15. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-47. The Exchange Emulation information window
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Tip:  You can refer to the “Restore to” information on this page when verifying it in HP 
OpenView Storage Data Protector later in this section.

16. Start HP OpenView Storage Data Protector on the computer you normally run your restores 
on. This can be the same computer as the one running Single Mailbox Recovery 
ExtractWizard.

17. Select Restore from the drop-down list at the top left of the window. 
18. In the left pane, expand the MS Exchange 5.x Server folder and select the appropriate 

Exchange Server.
19. In the right pane, select the Exchange backup you would like to restore. 

Note:  You cannot restore the DS object.

20. In the right pane, click the Options tab.
21. Select the Restore to another client check box. 
22. Select the name of the Restore Target Computer from the drop-down menu. See previous 

step 8 to verify that you are using the “Restore to” value from the Exchange Emulation page 
of the Single Mailbox Recovery ExtractWizard.

23. Do not select either the Stop services before restore check box or the Start services after 
restore check box. 

Note:  If these check boxes are selected, HP OpenView Storage Data Protector will display 
a message stating the restore failed. Click OK. The files will still be extracted and usable.

24. Under Restore actions, select the action you want to perform: 
• Restore both databases
• Restore private database only
• Restore public database only

25. Click the Devices tab, and verify your devices are properly configured. 
26. Click the Media tab, and verify the required media is available.
27. Click Restore. The Start Restore Session window appears.
28. Do one of the following:

• Click Next to specify options on Report level and Network load, and then click Finish.
• Click Finish.

29. When HP OpenView Storage Data Protector says it has finished, close the program.
30. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for Symantec Backup Exec 8.6 and 9.1/10.1/11d

Exchange Emulation for Symantec Backup Exec 9.1/10.1 and Exchange Server 2000/2003 

1. Install “Backup Exec Remote Agent for Windows Servers” client software on the computer 
that will be running Single Mailbox Recovery ExtractWizard. 

2. On the computer that will be running Single Mailbox Recovery ExtractWizard, do one of 
the following: 

• Install the Exchange System Management Tools.
• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\systems32 or windows\system32.
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Figure 2-48. Example of Setting the Registry Key

3. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 4.

4. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

5. Click Next. 
6. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and Symantec Backup Exec. 
7. Click Next. The Connection Parameters page of the Single Mailbox Recovery 

ExtractWizard appears.

Figure 2-49. Selecting Exchange Server 2000 or 2003 Connection Parameters
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8. Select the Exchange Server 2000 or 2003 option.
9. In the Storage Groups box, enter the name of the storage group you will be extracting. The 

storage group name is case sensitive and must match exactly the name that appears in the 
Exchange System Manager. You can enter multiple storage groups, separated by semicolons 
(;). 

10. Click Next. 
11. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-50. Exchange Information Store Destination Folder

12. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of aa NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.
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• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.

Figure 2-51. Enter Storage Appliance Name dialog box

13. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

14. Click OK to proceed to the next verification. 
15. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

16. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.
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Figure 2-52. The Exchange Emulation information window

Tip:  You can refer to the “Restore to” information on this page when verifying it in 
Symantec Backup Exec later in this section.

17. Start Symantec Backup Exec 9.1/10.1 on the computer you normally run your restores on. 
This can be the same computer as the one running Single Mailbox Recovery ExtractWizard. 

18. Click Restore. The Restore Job Properties window appears. 
19. In the Properties pane, select Selections under the Source heading.
20. In the All Resources tree, select the Exchange backup you want to restore.
21. In the Properties pane, select Exchange Redirection under the Destination heading.
22. Select the Redirect Exchange sets check box.
23. In the Restore to server box, enter the name of the Restore Target Computer (i.e., the 

computer running Single Mailbox Recovery ExtractWizard). See previous step 9 to verify 
that you are using the “Restore to” value from the Exchange Emulation page of the Single 
Mailbox Recovery ExtractWizard.

24. In the Server logon account, change the logon account if necessary. The account you select 
must have backup operator rights to the Restore Target Computer.

25. In the Properties pane, select Exchange under the Settings heading.
26. In the Exchange 2000 and Exchange 2003 area, deselect the No Loss Restore check box.

Important:  If the No Loss Restore check box is selected, the restore will fail.

27. In the Temporary location for log and path files box, enter the log file path. See previous 
step 9 to verify that you are using the “Log file path” value from the Exchange Emulation 
page of the Single Mailbox Recovery ExtractWizard.

28. Deselect the Commit after restore completes check box. 
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Caution:  Make sure to deselect the Commit after restore completes check box. If this check 
box remains selected, Backup Exec will automatically delete the restored files after 
completing the restore.

29. Click Run Now. Backup Exec displays a warning about restoring a server with different 
Site and Organization names. You can safely click Yes. Single Mailbox Recovery 
ExtractWizard and Single Mailbox Recoverydo not depend on the Site and Organization 
names. Backup Exec will start to restore Exchange files to the Single Mailbox Recovery 
ExtractWizard.

30. When Backup Exec has finished, click OK and close Backup Exec.
31. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for Symantec Backup Exec 11d and Exchange Server 2000/2003/2007 

1. Install “Backup Exec Remote Agent for Windows Servers” client software on the computer 
that will be running Single Mailbox Recovery ExtractWizard. 

2. On the computer that will be running Single Mailbox Recovery ExtractWizard, do one of 
the following: 

• Install the Exchange System Management Tools.
• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\systems32 or windows\system32.

Figure 2-53. Example of Setting the Registry Key

3. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 4.

4. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

5. Click Next. 
6. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and Symantec Backup Exec. 
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7. Click Next. The Connection Parameters page of the Single Mailbox Recovery 
ExtractWizard appears.

Figure 2-54. Selecting Exchange Server 2000, 2003, or 2007 Connection Parameters

8. Select the Exchange Server 2000, 2003, or 2007 option.
9. In the Storage Groups box, enter the name of the storage group you will be extracting. The 

storage group name is case sensitive and must match exactly the name that appears in the 
Exchange System Manager. You can enter multiple storage groups, separated by semicolons 
(;). 

10. Click Next. 
11. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).
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Figure 2-55. Exchange Information Store Destination Folder

12. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-56. Enter Storage Appliance Name dialog box

13. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

14. Click OK to proceed to the next verification. 
15. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

16. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-57. The Exchange Emulation information window
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Tip:  You can refer to the “Restore to” information on this page when verifying it in 
Symantec Backup Exec later in this section.

17. Start Symantec Backup Exec 11d on the computer you normally run your restores on. This 
can be the same computer as the one running Single Mailbox Recovery ExtractWizard. 

18. Click Restore. The Restore Job Properties window appears. 
19. In the Properties pane, select Selections under the Source heading.
20. In the All Resources tree, select the Exchange backup you want to restore.
21. In the Properties pane, select Microsoft Exchange Redirection under the Destination 

heading.
22. Select the Redirect Exchange sets check box.
23. In the Restore to server box, enter the name of the Restore Target Computer (i.e., the 

computer running Single Mailbox Recovery ExtractWizard). See previous step 9 to verify 
that you are using the “Restore to” value from the Exchange Emulation page of the Single 
Mailbox Recovery ExtractWizard.

24. In the Server logon account, change the logon account if necessary. The account you select 
must have backup operator rights to the Restore Target Computer.

25. If using Volume Shadow Copy Services (VSS), select the Redirect using Volume Shadow 
Copy Service (VSS) snapshot provider check box.

26. Select the Redirect to drive and path (Exchange 2003 and 2007) option.
27. In the Restore to drive, select the computer name of the one running Single Mailbox 

Recovery ExtractWizard. 
28. In Restore to path, enter the path to that same computer. This should match the Single 

Mailbox Recovery ExtractWizard destination path.
29. In the Properties pane, select Microsoft Exchange under the Settings heading.
30. In the Exchange 2000 and later area, select the Purge existing data and restore only the 

databases and transaction logs from the backup sets option.
31. In the Exchange Server for temporary storage of log and patch files box, enter the log 

file path. 
32. Deselect the Commit after restore completes and Mount database after restore check 

boxes. 

Caution:  Make sure to deselect the Commit after restore completes check box. If this check 
box remains selected, Backup Exec will automatically delete the restored files after 
completing the restore.

33. Click Run Now. Backup Exec displays a warning about restoring a server with different 
Site and Organization names. You can safely click Yes. Single Mailbox Recovery 
ExtractWizard and Single Mailbox Recovery do not depend on the Site and Organization 
names. Backup Exec will start to restore Exchange files to the Single Mailbox Recovery 
ExtractWizard.

34. When Backup Exec has finished, click OK and close Backup Exec.
35. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.
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Exchange Emulation for Symantec Backup Exec 9.1/10.1 and Exchange Server 5.5 

1. Install “Backup Exec Remote Agent for Windows Servers” client software on the computer 
that will be running Single Mailbox Recovery ExtractWizard. 

2. On the computer running Single Mailbox Recovery ExtractWizard, make sure edbbcli.dll is 
in the system path. The easiest way to ensure this is to copy edbbcli.dll to winnt\system32 
or windows\system32. The edbbcli.dll file can be found on the Exchange Server in the 
Exchange Server\bin directory.

3. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 4.

4. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

5. Click Next. 
6. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and Symantec Backup Exec. Then click Next.
7. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5 option.

Figure 2-58. Selecting Exchange Server 5.5 Connection Parameters

8. Click Next.
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9. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-59. Exchange Information Store Destination Folder

10. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-60. Enter Storage Appliance Name dialog box

11. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

12. Click OK to proceed to the next verification. 
13. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

14. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-61. The Exchange Emulation information window

Tip:  You can copy the “Restore to” information on this page and paste it into Backup Exec 
when prompted later in this section.
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15. Start Symantec Backup Exec on the computer you normally run your restores on. This can 
be the same computer as the one running Single Mailbox Recovery ExtractWizard.

16. Click Restore at the top left of the Backup Exec window. The Restore Job Properties 
window appears. 

17. In the Properties pane, select Selections under the Source heading.
18. In the All Resources tree, select the Exchange backup you want to restore. 

Note:  You cannot restore the Microsoft Exchange Directory.

19. In the Properties pane, select Exchange Redirection under the Destination heading.
20. Select the Redirect Exchange sets check box.
21. In the Restore to server box, enter the name of the Restore Target Computer (i.e., the 

computer running Single Mailbox Recovery ExtractWizard). See previous step 8 to verify 
that you are using the “Restore to” value from the Exchange Emulation page of the Single 
Mailbox Recovery ExtractWizard. 

22. In the Server logon account, change the logon account if necessary. The account you select 
must have backup operator rights to the Restore Target Computer.

23. In the Properties pane, select Exchange under the Settings heading.
24. In the Exchange v5.5 area, deselect the No Loss Restore check box.

Important:  If the No Loss Restore check box is selected, the restore will fail.

25. Select one or both of the following check boxes: Select the Restore public folder if you 
would like to restore the pub.edb. Select the Restore private mailboxes if you would like 
to restore the priv.edb. 

26. Click Run Now. Backup Exec will display a warning about restoring a server with different 
Site and Organization names. You can safely click Yes. Single Mailbox Recovery 
ExtractWizard and Single Mailbox Recovery do not depend on the Site and Organization 
names. Backup Exec will start to restore Exchange files to the Single Mailbox Recovery 
ExtractWizard.

27. When Backup Exec has finished, click OK and close Backup Exec.
28. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for Symantec Backup Exec 8.6 and Exchange Server 2000/2003 

1. Install “Backup Exec Remote Agent for Windows Servers” client software on the computer 
that will be running Single Mailbox Recovery ExtractWizard.

2. On the computer that will be running Single Mailbox Recovery ExtractWizard, do one of 
the following: 

• Install the Exchange System Management Tools.
• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\system32 or windows\system32.
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Figure 2-62. Example of Setting the Registry Key

3. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 4.

4. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

5. Click Next. 
6. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and Symantec Backup Exec. 
7. Click Next. The Connection Parameters page of the Single Mailbox Recovery 

ExtractWizard appears.
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Figure 2-63. Selecting Exchange Server 2000 or 2003 Connection Parameters

8. Select the Exchange Server 2000 or 2003 option.
9. In the Storage Groups box, enter the name of the storage group you will be extracting, 

exactly as it appears in the Exchange System Manager. Backup Exec will check this name, 
which is case sensitive, and it must match exactly. You can enter multiple storage groups, 
separated by semicolons (;). 

10. Click Next. 
11. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).
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Figure 2-64. Exchange Information Store Destination Folder

12. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-65. Enter Storage Appliance Name dialog box

13. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

14. Click OK to proceed to the next verification. 
15. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

16. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-66. The Exchange Emulation information window
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Tip:  You can copy the “Restore to” and “Log file path” information on this page and paste 
it into Backup Exec when prompted later in this section.

17. Start Symantec Backup Exec on the computer you normally run your restores on. This can 
be the same computer as the one running Single Mailbox Recovery ExtractWizard.

18. On the toolbar at the top of the Backup Exec window, click Restore. The Restore Job 
Properties window appears.

19. In the Restore Job Properties window, click the Selections tab. 
20. In the All Volumes tree, select the Exchange backup you want to restore.
21. Click the Redirection tab.
22. Select the Redirect Exchange sets check box.
23. In the Restore to server box, enter the name of the Restore Target Computer. See previous 

step 9 to verify that you are using the “Restore to” value from the Exchange Emulation page 
of the Single Mailbox Recovery ExtractWizard.

24. Select the Exchange tab.
25. In the Exchange 2000 area, deselect the No Loss Restore check box.

Important:  If the No Loss Restore check box is selected, the restore will fail.

26. In the Temporary location for log and path files box, enter the log file path. See previous 
step 9 to verify that you are using the “Log file path” value from the Exchange Emulation 
page of the Single Mailbox Recovery ExtractWizard.

27. Deselect the Commit after restore completes check box. 

Caution:  Make sure to deselect the Commit after restore completes check box. If this check 
box remains selected, Backup Exec will automatically delete the restored files after 
completing the restore.

28. Click Run Now. Backup Exec will display a warning about restoring a server with different 
Site and Organization names. You can safely click Yes. Single Mailbox Recovery 
ExtractWizard and Single Mailbox Recovery do not depend on the Site and Organization 
names. Backup Exec will start to restore Exchange files to the Single Mailbox Recovery 
ExtractWizard.

29. When Backup Exec has finished, click OK and close Backup Exec.
30. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for Symantec Backup Exec 8.6 and Exchange Server 5.5 

1. Install “Backup Exec Remote Agent for Windows Servers” client software on the computer 
that will be running Single Mailbox Recovery ExtractWizard. 

2. On the computer running Single Mailbox Recovery ExtractWizard, make sure edbbcli.dll is 
in the system path. The easiest way to ensure this is to copy to winnt\system32 or 
windows\system32. The edbbcli.dll file can be found on the Exchange Server in the 
Exchange Server\bin directory.

3. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is known as the Restore Target Computer.
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Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 4.

4. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

5. Click Next. 
6. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and Symantec Backup Exec. Then click Next.
7. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5 option.

Figure 2-67. Selecting Exchange Server 5.5 Connection Parameters

8. Click Next.
9. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).
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Figure 2-68. Exchange Information Store Destination Folder

10. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-69. Enter Storage Appliance Name dialog box

11. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

12. Click OK to proceed to the next verification. 
13. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

14. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-70. The Exchange Emulation information window

Tip:  You can copy the “Restore to” information on this page and paste it into Backup Exec 
when prompted later in this section.
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15. Start Symantec Backup Exec on the computer you normally run your restores on. This can 
be the same computer as the one running Single Mailbox Recovery ExtractWizard.

16. Click Restore at the top left of the Backup Exec window. The Restore Job Properties 
window appears.

17. In the Restore Job Properties window, click the Selections tab. 
18. In the All Volumes tree, select the Exchange backup you want to restore.

Note:  You cannot restore the Microsoft Exchange Directory.

19. Click the Redirection tab.
20. Select the Redirect Exchange sets check box.
21. In the Restore to server box, enter the name of the Restore Target Computer. See previous 

step 8 to verify that you are using the “Restore to” value from the Exchange Emulation page 
of the Single Mailbox Recovery ExtractWizard.

22. Select the Exchange tab.
23. In the Exchange v5.5 area, deselect the No Loss Restore check box.

Important:  If the No Loss Restore check box is selected, the restore will fail.

24. Select one or both of the following check boxes: Select the Restore public folder if you 
would like to restore the pub.edb. Select the Restore private mailboxes if you would like 
to restore the priv.edb. 

25. Click Run Now. Backup Exec will display a warning about restoring a server with different 
Site and Organization names. You can safely click Yes. Single Mailbox Recovery 
ExtractWizard and Single Mailbox Recovery do not depend on the Site and Organization 
names. Backup Exec will start to restore Exchange files to the Single Mailbox Recovery 
ExtractWizard.

26. When Backup Exec has finished, click OK and close Backup Exec.
27. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for CA ARCserve Backup

Exchange Emulation for CA ARCserve Backup and Exchange Server 2000/2003 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, do one of 
the following: 

• Install the Exchange System Management Tools.
• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\system32 or windows\system32.
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Figure 2-71. Example of Setting the Registry Key

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and CA ARCserve Backup. 

Figure 2-72. Selecting CA ARCserve Backup in the Method of Extraction Advanced Method
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6. Click Next. The Connection Parameters page of the Single Mailbox Recovery 
ExtractWizard appears.

Figure 2-73. Selecting Exchange Server 2000 or 2003 Connection Parameters

7. Select the Exchange Server 2000 or 2003 option.
8. In the Storage Groups box, enter the name of the storage group you will be extracting. The 

storage group name is case sensitive and must match exactly as it appears in the Exchange 
System Manager. You can enter multiple storage groups, separated by semicolons (;). 

9. Click Next. 
10. If Single Mailbox Recovery ExtractWizard displays a warning about the CA ARCserve 

Exchange client not being properly configured for emulating Exchange Server 2000/2003, 
click OK to continue. You can configure the CA ARCserve Exchange client when you get 
to step 12 later in this section.

11. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).
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Figure 2-74. Exchange Information Store Destination Folder

12. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.  
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Figure 2-75. Enter Storage Appliance Name dialog box

13. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

14. Click OK to proceed to the next verification.
15. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

16. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder.
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-76. The Exchange Emulation information window

Tip:  You can copy the “Restore to” and “Log file path” information on this page and paste 
it into CA ARCserve Backup when prompted later in this section.
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17. Make sure “CA ARCserve Backup Client Agent for Windows” software and “Backup 
Agent for Microsoft Exchange” software are installed on the computer running Single 
Mailbox Recovery ExtractWizard. 

18. If you have already installed the Backup Agent for Exchange Server 5.5 and you wish to 
emulate Exchange Server 2000/2003, you must do one of the following:

• Option 1: Reinstall the Backup Agent for Microsoft Exchange with Single Mailbox 
Recovery ExtractWizard, running the correct emulation type.

• Option 2: Manually edit the registry setting for the CA ARCserve Exchange client. 
Make sure the following key exists: 
HKEY_LOCAL_MACHINE\SOFTWARE\ComputerAssociates\BrightStor 
ARCserve Backup\DSAgent\CurrentVersion\agent\dbaexch. 

In this key, make sure the REG_DWORD value “isExch2000” exists with a value of 
“1”.

19. Start CA ARCserve Backup on the computer you normally run your restores on. This can be 
the same computer as the one running Single Mailbox Recovery ExtractWizard. The CA 
ARCserve Backup window appears.

20. On the Quick Start menu, click Restore. A Server tree appears in the Source tab.
21. In the Source tab, select the Exchange backup you want to restore.
22. Right-click the storage group you want to restore and click Backup Agent Option. The 

Backup Agent Restore Options window appears.
23. In the Temporary location for log and path files box, enter the log file path. See previous 

step 10 to verify that you are using the “Log file path” value from the Exchange Emulation 
page of the Single Mailbox Recovery ExtractWizard.

24. Click OK to close the Backup Agent Restore Options window.
25. Click the Destination Tab.
26. Deselect the Restore files to their original location check box.

Important:  For the following two steps, use the Network tree. Do not use the Windows 
NT/2000/XP/2003 Systems tree.

27. In the Network tree, expand the Microsoft Windows Network node, and locate the 
Restore Target Computer. If the Restore Target Computer does not appear, do one or both of 
the following:

• If the domain or workgroup that the Restore Target Computer belongs to does not 
appear in the Microsoft Windows Network node, right-click the Microsoft Windows 
Network node and click Add Machine/Object. In the Add Object window, enter the 
domain or workgroup and click Add.

• If the Restore Target Computer does not appear in the domain or workgroup it belongs 
to, right-click the domain or workgroup node, and click Add Machine/Object. In the 
Add Object window, enter the name of the Restore Target Computer and click Add. 
See previous step 10 to verify that you are using the “Restore to” value from the 
Exchange Emulation page of the Single Mailbox Recovery ExtractWizard.

28. Expand the Restore Target Computer node and select the Microsoft Information Store 
node. 
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Note:  If the Microsoft Information Store node does not appear under the Restore Target 
Computer, select the Restore Target Computer node so that its name appears in the Address 
box above the Destination tree. Then append \dbaexchis to the Restore Target Computer 
name. This signals CA ARCserve Backup you are restoring an Information Store. 

29. On the toolbar, click Start. 
30. If the Remote Agent Security is not properly configured, the Security window appears. 

Make sure your Server logon account (User Name and Password) is correct. The account 
you use must have backup operator rights to the Restore Target Computer. 

31. Click OK. The Session User Name and Password window appears.
32. Verify the session information is correct.
33. Click OK. The Submit Job window appears.
34. In the Description box, enter a description if desired, and click OK. CA ARCserve Backup 

will start to restore Exchange files to the Single Mailbox Recovery ExtractWizard.
35. When CA ARCserve Backup has finished, click OK and close CA ARCserve Backup.
36. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for CA ARCserve Backup and Exchange Server 5.5 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, make sure 
edbbcli.dll is in the system path. The easiest way to ensure this is to copy edbbcli.dll to 
winnt\system32 or windows\system32. The edbbcli.dll file can be found on the Exchange 
Server in the Exchange Server\bin directory.

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and CA ARCserve Backup.
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Figure 2-77. Selecting CA ARCserve Backup in the Method of Extraction Advanced Method

6. Click Next.
7. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5 option.

Figure 2-78. Selecting Exchange Server 5.5 Connection Parameters
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8. In the Site and Org boxes, enter the Site and Org for the Exchange Information Store files 
you are preparing to restore. The Site and Org names are case sensitive and must match 
exactly as they appear in the Exchange System Manager. 

9. Click Next. 
10. If Single Mailbox Recovery ExtractWizard displays a warning about the CA ARCserve 

Backup Exchange client not being properly configured for emulating Exchange 5.5, click 
OK to continue. You can configure the CA ARCserve Backup Exchange client when you 
get to step 12 later in this section.

11. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, specify a location for the extracted files. This location must be of 
the form x:\Path where x is a valid drive letter that has an administrative share associated 
with it such as x$, and Path is the complete path to a folder (if a folder doesn’t exist, Single 
Mailbox Recovery ExtractWizard will create it).

Figure 2-79. Exchange Information Store Destination Folder

12. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.
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• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.  

Figure 2-80. Enter Storage Appliance Name dialog box

13. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

14. Click OK to proceed to the next verification. 
15. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

16. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.
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Figure 2-81. The Exchange Emulation information window

Tip:  You can copy the “Restore to” and “Log file path” information on this page and paste 
it into CA ARCserve Backup when prompted later in this section.

17. Make sure “CA ARCserve Backup Client Agent for Windows” software and “Backup 
Agent for Microsoft Exchange” software are installed on the computer running Single 
Mailbox Recovery ExtractWizard. 

18. If you have already installed the Backup Agent for Exchange Server 2000/2003 and you 
wish to emulate Exchange Server 5.5, you must do one of the following:

• Option 1: Reinstall the Backup Agent for Microsoft Exchange with Single Mailbox 
Recovery ExtractWizard, running the correct emulation type.

• Option 2: Manually edit the registry setting for the CA ARCserve Backup Exchange 
client. Make sure the following key exists: 
HKEY_LOCAL_MACHINE\SOFTWARE\ComputerAssociates\BrightStor 
ARCserve Backup\DSAgent\CurrentVersion\agent\dbaexch. 

In this key, make sure the REG_DWORD value “isExch2000” does not exist.

Important Note: If REG_DWORD value “isExch2000” exists, delete it.
19. Start CA ARCserve Backup on the computer you normally run your restores on. This can be 

the same computer as the one running Single Mailbox Recovery ExtractWizard. The CA 
ARCserve Backup window appears.

20. On the Quick Start menu, click Restore. A Server tree appears in the Source tab.
21. Select the Exchange backup you want to restore.

Note:  You cannot restore the Directory.

22. Click the Destination tab.
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23. Deselect the Restore files to their original location check box.

Important:  For the following two steps, use the Network tree. Do not use the Windows 
NT/2000/XP/2003 Systems tree.

24. In the Network tree, expand the Microsoft Windows Network node, and locate the 
Restore Target Computer. If the Restore Target Computer does not appear, do one or both of 
the following:

• If the domain or workgroup that the Restore Target Computer belongs to does not 
appear in the Microsoft Windows Network node, right-click the Microsoft Windows 
Network node and click Add Machine/Object. In the Add Object window, enter the 
domain or workgroup and click Add.

• If the Restore Target Computer does not appear in the domain or workgroup it belongs 
to, right-click the domain or workgroup node, and click Add Machine/Object. In the 
Add Object window, enter the name of the Restore Target Computer and click Add. 
See previous step 10 to verify that you are using the “Restore to” value from the 
Exchange Emulation page of the Single Mailbox Recovery ExtractWizard.

25. Expand the Restore Target Computer node and select the Microsoft Exchange Server 
node. 

Note:  If the Microsoft Exchange Server node does not appear under the Restore Target 
Computer, select the Restore Target Computer node so that its name appears in the Address 
box above the Destination tree. Then append \dbaexch to the Restore Target Computer 
name. This signals CA ARCserve Backup you are restoring an Information Store. 

26. On the toolbar, click Start.
27. If the Remote Agent Security is not properly configured, the Security window appears. 

Make sure your Server logon account (User Name and Password) is correct. The account 
you use must have backup operator rights to the Restore Target Computer. 

28. Click OK. The Session User Name and Password window appears.
29. Verify the session information is correct.
30. Click OK. The Submit Job window appears.
31. In the Description box, enter a description if desired, and click OK. CA ARCserve Backup 

starts to restore Exchange files to the Single Mailbox Recovery ExtractWizard.
32. When CA ARCserve Backup has finished, click OK and close CA ARCserve Backup.
33. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for Veritas NetBackup

Exchange Emulation for Veritas NetBackup 4.5-5.1 and Exchange Server 2000/2003 

Note:  For NetBackup 4.5, you must install the NetBackup client and the Exchange agent on the 
computer running Single Mailbox Recovery ExtractWizard.

1. Install NetBackup client software for Windows on the computer that will be running Single 
Mailbox Recovery ExtractWizard.

2. Allow the computer running Single Mailbox Recovery ExtractWizard to restore backups 
created by the Exchange Server client. Follow the instructions for allowing redirected 
restores in the NetBackup Administrators Guide.
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3. On the computer that will be running Single Mailbox Recovery ExtractWizard, do one of 
the following: 

• Install the Exchange System Management Tools.
• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\system32 or windows\system32.

Figure 2-82. Example of Setting the Registry Key

4. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 5.

5. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

6. Click Next. 
7. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and Veritas NetBackup.
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Figure 2-83. Selecting Veritas NetBackup in the Method of Extraction Advanced Method

8. Click Next. The Connection Parameters page of the Single Mailbox Recovery 
ExtractWizard appears.

Figure 2-84. Selecting Exchange Server 2000 or 2003 Connection Parameters

9. Select the Exchange Server 2000 or 2003 option.
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10. In the Storage Groups box, enter the name of the storage group you will be extracting. The 
storage group name is case sensitive and must match exactly the name that appears in the 
Exchange System Manager. You can enter multiple storage groups, separated by semicolons 
(;). 

11. Click Next. 
12. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-85. Exchange Information Store Destination Folder

13. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
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drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.

Figure 2-86. Enter Storage Appliance Name dialog box

14. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

15. Click OK to proceed to the next verification. 
16. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

17. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.
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Figure 2-87. The Exchange Emulation information window

Tip:  You can copy the “Log file path” information on this page and paste it into NetBackup 
when prompted later in this section.

18. Start the NetBackup client on the computer running Single Mailbox Recovery 
ExtractWizard.

19. On the File menu, click Specify NetBackup Machines and Policy Type. (For NetBackup 
4.5, click Specify NetBackup Machines.)

Figure 2-88. Specify the client and policy type

20. In the Specify NetBackup Machines and Policy Type window, click the Client/Policy 
Type tab. 

21. Under Client List, select the Exchange client you wish to restore from and make it the 
current client. Click OK.
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22. On the toolbar, click Select for Restore, and then select the Exchange backup you wish to 
restore. 

23. On the Actions menu, click Start Restore of Marked Files. 
24. In the Restore Marked Files window, deselect the Commit after restore completes check 

box.

Caution:  If the Commit after restore completes check box is selected, NetBackup will 
automatically delete the restored files after completing the restore.

25. In the Temporary location for log and patch files box, enter the log file path. See previous 
step 11 to verify that you are using the “Log file path” value from the Exchange Emulation 
page of the Single Mailbox Recovery ExtractWizard.

26. Click Start Restore.
27. When NetBackup has finished, click OK and close NetBackup.
28. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for Veritas NetBackup 4.5-5.1 and Exchange Server 5.5 

Note:  For NetBackup 4.5, you must install the NetBackup client and the Exchange agent on the 
computer running Single Mailbox Recovery ExtractWizard.

1. Install NetBackup client software for Windows on the computer that will be running Single 
Mailbox Recovery ExtractWizard.

2. Allow the computer running Single Mailbox Recovery ExtractWizard to restore backups 
created by the Exchange Server client. Follow the instructions for allowing redirected 
restores in the NetBackup Administrators Guide.

3. On the computer running Single Mailbox Recovery ExtractWizard, make sure edbbcli.dll is 
in the system path. The easiest way is to copy edbbcli.dll to winnt\system32 or 
windows\system32. The edbbcli.dll file can be found on the Exchange Server in the 
Exchange Server\bin directory.

4. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 5.

5. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

6. Click Next. 
7. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and Veritas NetBackup.
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Figure 2-89. Selecting Veritas NetBackup in the Method of Extraction Advanced Method

8. Click Next.
9. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5 option and click Next. 
10. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).
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Figure 2-90. Exchange Information Store Destination Folder

11. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-91. Enter Storage Appliance Name dialog box

12. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

13. Click OK to proceed to the next verification. 
14. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

15. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-92. The Exchange Emulation information window

Tip:  You can copy the “Log file path” information on this page and paste it into NetBackup 
when prompted later in this section.
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16. Start the NetBackup client on the computer running Single Mailbox Recovery 
ExtractWizard.

17. On the File menu, click Specify NetBackup Machines and Policy Type. (For NetBackup 
4.5, click Specify NetBackup Machines.)

Figure 2-93. Specify client and policy type

18. In the Specify NetBackup Machines and Policy Type window, click the Client/Policy 
Type tab. 

19. Under Client List, select the Exchange client you wish to restore from and make it the 
current client. Click OK.

20. On the toolbar, click Select for Restore, and then select the Exchange backup you wish to 
restore. 

21. On the Actions menu, click Start Restore of Marked Files.
22. In the Restore Marked Files window, click Start Restore.
23. When NetBackup has finished, click OK and close NetBackup.
24. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for CommVault Galaxy Backup & Recovery

Exchange Emulation for CommVault Galaxy Backup & Recovery 5.0 and 5.9 and Exchange 
Server 2000/2003

Important:  CommVault Galaxy will not install the Exchange agent onto a non-server OS. The 
Exchange agent is required for Single Mailbox Recovery ExtractWizard to work. 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, do the 
following:

• Install the Exchange System Management Tools.
• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\system32 or windows\system32.
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Figure 2-94. Example of Setting the Registry Key

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and CommVault Galaxy Backup & Recovery.

Figure 2-95. Selecting CommVault Galaxy Backup & Recovery in the Method of Extraction 
Advanced Method
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6. Click Next. The Connection Parameters page of the Single Mailbox Recovery 
ExtractWizard appears.

Figure 2-96. Selecting Exchange Server 2000 or 2003 Connection Parameters

7. Select the Exchange Server 2000 or 2003 option.
8. Click Next. 
9. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).
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Figure 2-97. Exchange Information Store Destination Folder

10. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-98. Enter Storage Appliance Name dialog box

11. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

12. Click OK to proceed to the next verification. 
13. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

14. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-99. The Exchange Emulation information window

Tip:  You can copy the “Log file path” information on this page and paste it into 
CommVault when prompted later in this section.
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15. Do one of the following:
• For CommVault Galaxy 5.9: Make sure “iDA for Windows File Systems” software 

and “iDA for Exchange Database” software are installed on the computer running 
Single Mailbox Recovery ExtractWizard. 

• For CommVault Galaxy 5.0: Make sure “CommVault Systems File System 
iDataAgent” software and “CommVault Systems Exchange Database iDataAgent” 
software are installed on the computer running Single Mailbox Recovery 
ExtractWizard.

Note:  

• You must run Single Mailbox Recovery ExtractWizard in Advanced mode while running 
the CommVault installer.

• CommVault Galaxy will not install the Exchange agent onto a non-server OS. The 
Exchange agent is required for Single Mailbox Recovery ExtractWizard to work. 

16. If you have already installed the Exchange Database iDataAgent for Exchange Server 5.5 
and you wish to emulate Exchange Server 2000/2003, you must reinstall the Exchange 
Database iDataAgent with Single Mailbox Recovery ExtractWizard running the correct 
emulation type. That is, the Exchange Server 2000 or Exchange Server 2003 option must 
be selected on the Connection Parameters page).

17. Start CommCell Console on the computer you normally run your restores on. This can be 
the same computer as the one running Single Mailbox Recovery ExtractWizard. The 
CommCell Console window appears.

18. In the CommCell Browser, right-click the Exchange Server you want to restore and click 
Browse & Recover. The Browse Options window appears.

19. Specify the appropriate browse time for your recovery:
• Browse the Latest Data
• Specify Browse Time

20. In the Browse Options window, select your Exchange Server from the Client Computer 
drop-down menu. 

21. Click OK to show the browse data for your Exchange Server.
22. Select the storage groups to restore. 

Note:  You can only restore data from under the Exchange Database tree node.

23. Click Recover All Selected.
24. The Restore Options for All Selected Items window appears. 
25. Select the Restore to a Different Client option.
26. Select the Restore Target Computer from the Select a Client drop-down menu. See 

previous step 8 to verify that you are using the “Restore to” value from the Exchange 
Emulation page of the Single Mailbox Recovery ExtractWizard.

27. Click OK to close the Restore Options for All Selected Items window.
28. When CommVault has finished the restore, you can close CommCell Console.
29. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.
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Exchange Emulation for CommVault Galaxy Backup & Recovery and Exchange Server 5.5 

Important:  CommVault Galaxy will not install the Exchange agent onto a non-server OS. The 
Exchange agent is required for Single Mailbox Recovery ExtractWizard to work.

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, make sure 
edbbcli.dll is in the system path. The easiest way to ensure this is to copy edbbcli.dll to 
winnt\system32 or windows\system32. The edbbcli.dll file can be found on the Exchange 
Server in the Exchange Server\bin directory.

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and CommVault Galaxy Backup & Recovery.

Figure 2-100. Selecting CommVault Galaxy Backup & Recovery in the Method of 
Extraction Advanced Method

6. Click Next.
7. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5 option.
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Figure 2-101. Selecting Exchange Server 5.5 Connection Parameters

8. Click Next. 
9. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be of 
the form x:\Path where x is a valid drive letter that has an administrative share associated 
with it such as x$, and Path is the complete path to a folder (if a folder doesn’t exist, Single 
Mailbox Recovery ExtractWizard will create it).
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Figure 2-102. Exchange Information Store Destination Folder

10. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.  
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Figure 2-103. Enter Storage Appliance Name dialog box

11. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

12. Click OK to proceed to the next verification. 
13. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

14. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-104. The Exchange Emulation information window

Tip:  You can refer to the “Restore to” information on this page when verifying it in 
CommVault Galaxy Backup & Restore later in this section.
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15. Do one of the following:
• For CommVault Galaxy 5.9: Make sure “iDA for Windows File Systems” software 

and “iDA for Exchange Database” software are installed on the computer running 
Single Mailbox Recovery ExtractWizard. 

• For CommVault Galaxy 5.0: Make sure “CommVault Systems File System 
iDataAgent” software and “CommVault Systems Exchange Database iDataAgent” 
software are installed on the computer running Single Mailbox Recovery 
ExtractWizard.

Note:  

• You must run Single Mailbox Recovery ExtractWizard in Advanced mode while running 
the CommVault installer.

• CommVault Galaxy will not install the Exchange agent onto a non-server OS. The 
Exchange agent is required for Single Mailbox Recovery ExtractWizard to work. 

16. If you have already installed the Exchange Database iDataAgent for Exchange Server 
2000/2003 and you wish to emulate Exchange Server 5.5, you must reinstall the Exchange 
Database iDataAgent with Single Mailbox Recovery ExtractWizard running the correct 
emulation type. That is, the Exchange Server 5.5 option must be selected on the 
Connection Parameters page.

17. Start CommCell Console on the computer you normally run your restores on. This can be 
the same computer as the one running Single Mailbox Recovery ExtractWizard. The 
CommCell Console window appears.

18. In the CommCell Browser, right-click the Exchange Server you want to restore and click 
Browse & Recover. The Browse Options window appears.

19. Specify the appropriate browse time for your recovery:
• Browse the Latest Data
• Specify Browse Time

20. In the Browse Options window, select your Exchange Server from the Client Computer 
drop-down menu. 

21. Click OK to show the browse data for your Exchange Server.
22. Select the Exchange backup you want to restore.

Note:  You can only restore data from under the Exchange Database tree node. You cannot 
restore the Directory (DSA item).

23. Click Recover All Selected. The Restore Options for All Selected Items window appears. 
24. Select the Restore to a Different Client option.
25. Select the Restore Target Computer from the Select a Client drop-down menu. See 

previous step 8 to verify that you are using the “Restore to” value from the Exchange 
Emulation page of the Single Mailbox Recovery ExtractWizard.

26. Click OK.
27. When CommVault has finished the restore, you can close CommCell Console.
28. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.
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Exchange Emulation for UltraBac

Exchange Emulation for UltraBac and Exchange Server 2000/2003 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, do the 
following:

• Install the Exchange System Management Tools.
• Add the path C:\Program Files\Exchsrvr\bin\ to the system path: 
winnt\system32 or windows\system32.

Figure 2-105. Example of Setting the Registry Key

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 

Advanced Method and UltraBac.
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Figure 2-106. Selecting UltraBac in the Method of Extraction Advanced Method

6. Click Next. The Connection Parameters page of the Single Mailbox Recovery 
ExtractWizard appears.

Figure 2-107. Selecting Exchange Server 2000 or 2003 Connection Parameters

7. Select the Exchange Server 2000 or 2003 option and click Next. 
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8. On the Exchange Information Store Destination Folder page of the Single Mailbox 
Recovery ExtractWizard, specify a location for the extracted files. This location must be a 
local drive of the form x:\Path where x is a valid drive letter that has an administrative share 
associated with it such as x$, and Path is the complete path to a folder (if a folder doesn’t 
exist, Single Mailbox Recovery ExtractWizard will create it).

Figure 2-108. Exchange Information Store Destination Folder

9. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder.

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.

If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.
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Figure 2-109. Enter Storage Appliance Name dialog box

10. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

11. Click OK to proceed to the next verification. 
12. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

13. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.

Figure 2-110. The Exchange Emulation information window

Tip:  You can copy the “Restore to” and “Log file path” information on this page and paste 
it into UltraBac when prompted later in this section.
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14. Start UltraBac Management Console on the computer you normally run your restores on. 
This can be the same computer as the one running Single Mailbox Recovery ExtractWizard. 
The UltraBac window appears.

15. In UltraBac, click Restore Wizard on the toolbar. The Select Index Source window 
appears.

16. Select the appropriate source for your backup index, and click Next. The Select Online 
Index window appears.

17. Select the correct online index to load for your backup. Click Next to return to the UltraBac 
window.

18. In UltraBac, select the appropriate backup item to restore from the tree and list views. You 
can only restore one storage group at a time.

Note:  You can only restore data from under the Exchange Agent tree node.

19. Click Restore. The General Restore Options window appears.
20. Click Exchange 2000, 2003 Options. The Exchange 2000, 2003-Specific Options 

window appears.
21. Select the Restore to Alternate Server option. In its Restore to box, enter the name of the 

Restore Target Computer (i.e., the computer running Single Mailbox Recovery 
ExtractWizard). See previous step 7 to verify you are using the “Restore to” value from the 
Exchange Emulation page of the Single Mailbox Recovery ExtractWizard.

22. Select the Alternate Temporary Log File Directory option. In its Restore to box, enter 
the log file path. See previous step 7 to verify you are using the “Log file path” value from 
the Exchange Server Emulation page of the Single Mailbox Recovery ExtractWizard.

23. Click OK.
24. In the General Restore Options window, click Next. The Restore Options window 

appears.
25. Click Restore.
26. When UltraBac has finished the restore, click Exit to close UltraBac.
27. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

Exchange Emulation for UltraBac and Exchange Server 5.5 

1. On the computer that will be running Single Mailbox Recovery ExtractWizard, make sure 
edbbcli.dll is in the system path. The easiest way to ensure this is to copy edbbcli.dll to 
winnt\system32 or windows\system32. The edbbcli.dll file can be found on the Exchange 
Server in the Exchange Server\bin directory.

2. Start Single Mailbox Recovery ExtractWizard. The computer running Single Mailbox 
Recovery ExtractWizard is the Restore Target Computer.

Note:  If you have not already done so, click About and License Info to specify the name or 
address of a NetApp storage device as described in “Single Mailbox Recovery 
ExtractWizard: Pointing to a NetApp Device” on page 18; otherwise, continue to Step 3.

3. (Optional) To change the location of the license file, click About and then click License 
Info. Under License File Name, specify a new location. The license file controls which 
Single Mailbox Recovery ExtractWizard agents are active. For more information, see 
“Single Mailbox Recovery Agents” on page 3.

4. Click Next. 
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5. On the Method of Extraction page of the Single Mailbox Recovery ExtractWizard, select 
Advanced Method and UltraBac.

Figure 2-111. Selecting UltraBac in the Method of Extraction Advanced Method

6. Click Next.
7. On the Connection Parameters page of the Single Mailbox Recovery ExtractWizard, 

select the Exchange Server 5.5.

Figure 2-112. Selecting Exchange Server 5.5 Connection Parameters
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8. Click Next.
9. On the Exchange Information Store Destination Folder page of the Single Mailbox 

Recovery ExtractWizard, specify a location for the extracted files. This location must be of 
the form x:\Path where x is a valid drive letter that has an administrative share associated 
with it such as x$, and Path is the complete path to a folder (if a folder doesn’t exist, Single 
Mailbox Recovery ExtractWizard will create it).

Figure 2-113. Exchange Information Store Destination Folder

10. Click Next. Before proceeding to extract the Exchange Information Store data to the 
destination folder, Single Mailbox Recovery performs two verification steps.

• First verification: The Single Mailbox Recovery ExtractWizard checks for the 
following conditions: 

• You have specified the name or address of a NetApp storage system that 
exists in your network environment in the License information box of the 
Single Mailbox Recovery ExtractWizard as described in “Single Mailbox 
Recovery ExtractWizard: Pointing to a NetApp Device” on page 18.

• A LUN on a NetApp storage system is connected to an available drive letter 
on the Single Mailbox Recovery server. You do not need to use this LUN as 
the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, 
and the CIFS share is either mapped to a drive letter on the Single Mailbox 
Recovery server or is accessed by a specified UNC path.

• The Destination Folder resides on a CIFS share on a Windows server that has 
a NetApp LUN connected to it, and the CIFS share is either mapped to a 
drive letter on the Single Mailbox Recovery server or is accessed by a 
specified UNC path.
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If Single Mailbox Recovery ExtractWizard does not find any of the above conditions, the 
Enter Storage Appliance Name dialog box appears and prompts you to enter the name of a 
NetApp storage system.

Figure 2-114. Enter Storage Appliance Name dialog box

11. If the Enter Storage Appliance Name dialog box appears, do one of the following: 
• Enter or browse to the host name of a NetApp storage system.
• Enter the IP address of a NetApp storage system.

12. Click OK to proceed to the next verification. 
13. Second verification: The Single Mailbox Recovery ExtractWizard verifies that you have 

enough disk space as well as access rights to create files and directories, and then begins to 
extract the Exchange Information Store files you have selected. 

14. After both checkpoints have been passed successfully, the Exchange Information Store 
Copy Progress page of the Single Mailbox Recovery ExtractWizard shows the progress of 
the Single Mailbox Recovery ExtractWizard extracting the Exchange Information Store 
data to the destination folder. 
When the Exchange Emulation page changes from “Initializing” to “Emulating Exchange 
Server,” you are ready to start NT Backup.

Note:  Do not click the Stop button until you reach the end of these instructions.
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Figure 2-115. The Exchange Emulation information window

Tip:  You can copy the “Restore to” information on this page and paste it into UltraBac 
when prompted later in this section.

15. Start UltraBac Management Console on the computer you normally run your restores on. 
This can be the same computer as the one running Single Mailbox Recovery ExtractWizard. 
The UltraBac window appears.

16. In UltraBac, click Restore Wizard on the toolbar. The Select Index Source window 
appears.

17. Select the appropriate source for your backup index. Click Next. The Select Online Index 
window appears.

18. Select the correct online index to load for your backup. Click Next to return to the UltraBac 
window.

19. Select the appropriate backup item to restore from the tree and list views. 

Note:  

• You can only restore data from under the Exchange Agent tree node.
• You cannot restore the Directory Store.

20. Click Restore. The General Restore Options window appears. 
21. Click Exchange 5.5 Options. The Exchange 5.5-Specific Options window appears.
22. Select the Restore to Alternate Server option. In its Restore to box, enter the name of the 

Restore Target Computer (i.e., the computer running Single Mailbox Recovery 
ExtractWizard). See previous step 7 to verify you are using the “Restore to” value from the 
Exchange Emulation page of the Single Mailbox Recovery ExtractWizard.

23. Under Databases to Restore, select the appropriate option: Public Store, Private Store, or 
Both.

24. Click OK.
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25. In the General Restore Options window, click Next. 
26. In the Restore Options window, click Restore.
27. When UltraBac has finished the restore, click Exit to close UltraBac.
28. In Single Mailbox Recovery ExtractWizard, click Stop and then click Finish.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Organizing the Extracted Files for Single Mailbox Recovery

Before using the extracted files to restore Exchange mail items, you will need to organize the 
extracted files for Single Mailbox Recovery if the backup was created using one of the following 
backup methods:

• Online incremental backup
• Online differential backup
• Offline backup

For detailed information, see “Organizing Files Extracted from Other Backup Applications” on 
page 286.
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. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
LOOKING AT THE INTERFACE CHAPTER 3 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

This chapter describes the parts of the main Single Mailbox Recovery window, and shows you how 
to preview messages, view details of an EDB, PST, or CAS file, and change the view.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Single Mailbox Recovery Main Window

The Single Mailbox Recovery main window is where you do most of your work. This window 
displays the Source EDB, PST, or CAS file(s) as well as the Target PST file(s), Exchange Server or 
CAS. The Target acts as a container for the restored files. The various work areas and controls are 
described in the following sections. 

Note:  In the illustration below, the Target pane displays a PST that acts as a container for restored 
files. Keep in mind that the Target pane could just as easily display an Exchange Server. 
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Figure 3-1. The Single Mailbox Recovery main window

Source Pane 

The Source pane displays the EDB file(s) that you extracted from a disk or tape backup. The 
Source pane can also display one or more PST files if you have purchased the “PST as Source File” 
agent. It also displays a content analysis store (CAS) as Source. If you have not yet extracted 
Exchange data from a backup tape or disk, see “Using the Single Mailbox Recovery 
ExtractWizard” on page 17 or “Using the Single Mailbox Recovery ExtractWizard Advanced 
Method” on page 35.
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Figure 3-2. Sample icons with descriptions below

Sources Root Node contains one or more Source data stores that are pre-pended 
with a “SourceX” where X is a number starting with 1 and is incremented for each 
additional Source opened. You can select the Sources root node as your search 
Source.

Source EDB File (e.g., ) contains the Exchange Information Store 
data that you extracted from a tape or disk backup. Click the plus sign (+) next to an 
EDB file to expand its contents.

Mailbox (e.g., ) contains the Outlook folders. Click the plus sign 
(+) next to a mailbox to expand its contents.

Outlook Folders (e.g.,  Inbox,  Contacts,  Tasks) contain Outlook 
message items. Select a folder to view its contents in the Source message list.

Source CAS File (e.g., ) contains the content analysis store data created 
to analyze content based on certain criteria.

CAS Profile Folder (e.g., ) which contains the results of a 
content analysis.

Inaccessible Mailbox which displays the inaccessible mailbox but the contents are 
not accessible based on administrator permission settings.

Status indicator which indicates that Single Mailbox Recovery is licensed for the 
Agent for Administrative Services and that it is connected to Single Mailbox 
Recovery Administrative Server. This icon is located in the Status Bar of the Single 
Mailbox Recovery main window.

Status indicator which indicates that Single Mailbox Recovery is either not licensed 
for the Agent for Administrative Services or it is licensed but not connected to the 
Single Mailbox Recovery Administrative Server. This icon is located in the Status 
Bar of the Single Mailbox Recovery main window.
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Note:  In the above illustration, the Source pane displays an EDB file, but it could just as easily 
display a PST file, CAS, or even multiple EDB and PST files.

Source Message List

The Source message list displays the message items in the Outlook folder that you selected in the 
Source pane. This folder is one of the Outlook folders (e.g., Inbox, Contacts, Tasks). In the 
illustration below, the Source message list displays the messages in an Inbox. 

Figure 3-3. The Source Message List

The Source message list displays metadata about the message items in six columns. The metadata 
includes file type; attachments, if any; message sender; subject; date; and status. The Sent Items 
folder also displays the “To” column. For more information on the message list, see “Sorting 
Messages in the Message Lists” on page 149.

The Source content analysis store message list includes file type; Database #, Database, and Path. 
The Source content analysis store profile folder message list includes file type; Attachment, if any; 
From; Subject; Create Date; Database #; Folder, and Status. For more information on content 
analysis stores, see “Content Analysis Store” on page 257.

Target Pane

The Target pane can display one or more Target PST files and/or one Target mailbox, public folders 
and mailboxes from an Exchange Server, and content analysis stores (CAS) with profile folders. 
The Target acts as a container for your restored files. If a Target is a newly created PST file, it 
defaults to 10 Outlook folders. If a Target is an existing PST file or Exchange Server, it shows 
whatever folders are in the Target. It is into these folders that you paste and restore your message 
items. For information on restoring message items, see “Restoring Exchange Data” on page 219.”
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Figure 3-4. Target panes with PST, CAS, and Exchange Server files

Target Message List (Restored Messages)

The Target message list displays the message items in the Outlook folder that you selected in the 
Target pane. If the Target is a newly created PST file or CAS, the Outlook folders and message list 
will be empty. If the Target is an existing PST file, CAS file, or Exchange Server, or if you have 
restored message items to a newly created PST file, you can select a folder in the Target pane to 
display messages in the Target message list. 

Figure 3-5. Target Message List Displaying Restored Messages

The Target message list displays metadata about the message items in five columns (instead of six 
columns in the Source message list). The metadata includes file type; attachments, if any; message 
sender; Subject; and Create Date. The Sent Items folder also displays the “To” column. For more 
information on the message list, see “Sorting Messages in the Message Lists” on page 149.

The Target content analysis store message list includes file type; Database #, Database, and Path. 
The Target content analysis store profile folder message list includes file type; attachment, if any; 
From; Subject; Create Date; Database #; Folder; and Status. For more information on content 
analysis stores, see “Content Analysis Store” on page 257.

Target pane with PST 
files

Target pane with CAS 
files Target pane with Exchange 

Server
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Menu Bar

Figure 3-6. The Menu Bar in the main window

The menu bar contains most of the Single Mailbox Recovery commands. The menu commands, 
submenu commands, and resulting windows are discussed fully in the chapters that focus on those 
specific commands. See the Index to quickly locate the pages on which a menu command is 
discussed.

HELP MENU - ADMINISTRATIVE SERVICES

The Administrative Services option is available in the Help menu when the Single Mailbox 
Recovery Agent for Administrative Services is active. It displays information regarding the Single 
Mailbox Recovery Administrative Server that Single Mailbox Recovery is connected to and the 
services that are being used.

Note:  During normal operation, the auditing service (if activated) does not alter the behavior of 
Single Mailbox Recovery.
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Figure 3-7. The Button Toolbar in the main window

The buttons on the toolbar perform the following functions:

Open Source displays the Open window, which lets you navigate to and select a 
Source Exchange Database (EDB), PST, or CAS file. The EDB, PST, or CAS file 
contains the message items you want to restore.

Open Target PST displays the Open window, which lets you navigate to and select a 
Target Personal Folders (PST) file. The Target PST file is a container for restored 
message items.

Open Target Exchange Server displays the Connect to Exchange Server window, 
which lets you connect to a Target Exchange Server. The Target Exchange Server is a 
container for restored message items.

Create/Open Content Analysis Store displays the Create Content Analysis File 
window which allows you to open an existing content analysis store or to create a 
new one in the Target pane.

Copy copies into the Clipboard the selected message(s) in the Source message list; 
or the selected folder, mailbox, or EDB file in the Source pane.

Paste inserts the items from the Clipboard into the selected folder in the Target pane. 
If you wish to retain the directory structure of the restored messages, you must use 
the Paste Special command instead of the Paste command or Paste button.

Export displays the Export window, which lets you export messages to a local or 
network drive destination. You can choose to save exported messages as plain text 
files (.txt) or as Microsoft Outlook files (.msg). You can also export EDBs to a PST.

Search displays the Find window, which lets you specify the desired search criteria 
for finding messages in the Source pane.

Preview Pane displays the Preview pane on the Single Mailbox Recovery main 
window so you can read a message without opening it.

View Help displays Single Mailbox Recovery Online Help, which includes all of the 
information in this user guide and more. Online Help lets you quickly access this 
information by using a Contents, Search, or Index tab.

Message Table View is only available when a message in the Source message list is 
highlighted. It opens a Message Table View of that message and any message related 
to it.
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Previewing and Opening Messages

In the Preview pane, you can read the contents of a message item and open attachments. You can 
preview a message located in either the Source message list or the Target message list. The 
information displayed in the Message Header is different for messages, calendars, contacts, tasks, 
and distribution lists.

To open the preview pane

Do one of the following:

• On the View menu, click Preview Pane.
• On the toolbar, click the Preview Pane icon  in the toolbar.

To hide the preview pane

• Repeat one of the previous steps.

Tip:  Hiding the Preview pane will allow you to scroll through messages faster.

To display a message in the preview pane

1. In the Source or Target message list, select a message.
2. Open the Preview pane by clicking on the Preview Pane icon  in the toolbar. 

Figure 3-8. Preview pane for a message

To open a message in its own window

• In the Source or Target message list, double-click a message.

Attachment Table View is only available when a message with an attachment in the 
Source message list is highlighted. It opens an Attachment Table View of that 
message and attachment and all related messages and attachments.

Conversation View is only available when a message in the Source message list is 
highlighted. It shows the thread of that message with indentions to indicate the 
responses to each e-mail.
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Opening Attachments 

If you have the appropriate program installed on your computer, Single Mailbox Recovery will 
load the application to view the selected attachment (e.g., to view an .xls file attachment, Single 
Mailbox Recovery will launch MS Excel). 

If no associated program is available for the attachment’s file type, Single Mailbox Recovery 
presents a message window saying the attachment cannot be viewed. 

Note:  Single Mailbox Recovery cannot view attached embedded graphics in HTML messages.

To open an attachment in an open message

1. In the message list, double-click a message that has the Attachment icon  next to its 
name.

2. Click the Attachment icon  on the right side of the message header. A pop-up window 
lists the attachments for the selected message.

3. Click the name of the attachment you want to view.

To open an attachment in the preview pane

1. In the message list, select a message that has the Attachment icon  next to its name.
2. Open the Preview pane. In the Single Mailbox Recovery main window, click the Preview 

Pane icon . In the Find window, select the Preview check box.
3. Click the Attachment icon  on the right side of the message header in the Preview 

pane. A pop-up window lists the attachments for the selected message.
4. Click the name of the attachment you want to view.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Saving Attachments

A “save attachments” option is available on the File menu and paperclip menu of an open message, 
as well as on the paperclip menu of the Preview pane. The Save Attachments window lists the 
attachments for the selected message and lets you select the attachments you want to save. 

To save attachments in an open message

1. In the Source or Target message list, double-click a message that has the Attachment icon 
 next to its name.

2. In the open message, do one of the following:
• On the File menu, click Save Attachments.
• Click the Attachment icon  on the right side of the message header, and then click 

Save Attachments. 
3. In the Save Attachments window, select one or more attachments, and click OK. 
4. In the Browse For Folder window, select a location for the attachment(s), and click OK.

To save attachments in the preview pane 

1. In the Source or Target message list, select a message that has the Attachment icon  
next to its name.
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2. In the Preview pane, click the Attachment icon  on the right side of the message 
header, and then click Save Attachments. 

3. In the Save Attachments window, select one or more attachments, and click OK. 
4. In the Browse For Folder window, select a location for the attachment(s), and click OK.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Changing the View

You can change the view in the Single Mailbox Recovery window by hiding the toolbar or status 
bar, by using split bars; by sorting message lists; and by refreshing the screen.

Viewing or Hiding the Toolbar and Status Bar

The toolbar and status bar appear by default in the main Single Mailbox Recovery window, but you 
can easily hide them.

To hide the toolbar or status bar

• On the View menu, click Toolbar or Status Bar. The check mark no longer appears next to 
the name of the toolbar or status bar.

To view the toolbar or status bar

• On the View menu, click Toolbar or Status Bar. The check mark appears next to the name 
of the toolbar or status bar.

Resizing Panes Separated by a Split Bar

You can use a split bar (the horizontal or vertical double line that separates two panes) to increase 
the area within one pane while simultaneously decreasing the area within the adjacent pane. The 
Source pane, Source message list, Target pane, Target message list, and Preview pane all border a 
split bar.

To resize panes separated by a split bar

1. Position the cursor over a split bar between two panes until a double arrow  appears. A 
vertical double arrow  appears if you position the cursor over a horizontal split bar.
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Figure 3-9. Before dragging the split bar between the Target message list and the Preview 
pane

2. Drag the split bar until the two panes are the desired size.

Sorting Messages in the Message Lists

You can sort messages in the Source and Target message lists based on attachments, message 
sender, subject, date, and status. In addition, the Source message list lets you sort messages based 
on status, and the Sent Items folder lets you sort items based on the “To” heading. Sorting messages 
on the From column, for example, can help to identify messages from a specific sender.

To sort a message list

1. Click a column heading to sort the messages based on that heading. For most headings, an 
arrow appears indicating the sort direction. An up arrow indicates that the messages appear 
in ascending (A-Z) order. A down arrow indicates that the messages appear in descending 
(Z-A) order.

2. To reverse the order of the messages based on that column heading, click the column 
heading again. Notice the arrow reverses directions.

An example of sorting messages

• If you click the attachment  column heading, messages are sorted in ascending order 
based on this heading, even though no arrow appears. This means that messages with 
attachments appear at the top of the message list, while messages with no attachments 
appear at the bottom of the document list. If you click the attachment  column heading 
again, the order is reversed.

Note:  The view settings (sort order and column width) for a folder or mailbox are saved until you 
close the data store.

Refreshing the Screen

You may wish to refresh the screen occasionally when you are connected to a Target Exchange 
Server. That is because the information on the server may change while you are connected.
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To refresh the screen

Do one of the following:

• On the View menu, click Refresh.
• Press the F5 key.

Viewing the Properties of an EDB File, PST File, CAS File, 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
CAS Profile Folder, Folder, or Mailbox

Single Mailbox Recovery makes it easy to view the properties of a Source PST file, EDB file, CAS 
file, CAS profile folder, mailbox, or folder.

Note:  Only accessible mailboxes can produce property reports. For CAS files, inaccessible 
mailboxes within that data store are not included in the totals.

To view the properties

1. In the Source pane, right-click an EDB file, PST file, CAS file, CAS profile folder, mailbox, 
or folder.

2. On the shortcut menu, click Properties. A Properties window appears.

Figure 3-10. Properties of an EDB File
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Figure 3-11. Properties of a PST File

Figure 3-12. Properties of a Mailbox

Figure 3-13. Properties of a Folder
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Figure 3-14. Properties of a content analysis store file

Figure 3-15. Properties of a content analysis store profile folder

An alternate way to view the properties of an EDB or PST file

Once you have viewed the properties of the Source EDB or PST file as described above, you can 
then display the properties in the Preview pane.

1. Open the Preview pane by clicking the Preview Pane icon  on the toolbar or by 
clicking the View menu and pointing to Preview Pane. 

2. Right-click on the Source EDB or PST file in the Source pane and click Properties.

Figure 3-16. Properties of an EDB File
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Performing an Integrity Check

You can perform an integrity check on messages, folders, mailboxes, PST files, CAS files, CAS 
profile folders, EDB files, and live Exchange Server Target search results. During the integrity 
check, Single Mailbox Recovery verifies that it can read all folder and message properties from the 
selected Source.

To perform an integrity check

1. In the Source pane, select an EDB file, PST file, CAS file, CAS profile folder, mailbox, 
folder, or message(s).

2. Do one of the following:
• On the Tools menu, click Integrity Check. The Integrity Check window appears. 
• Right-click the item and click Integrity Check in the shortcut menu.

3. Click Print to print a copy of the integrity check.
4. Click Save to save a copy of the integrity check to file.

Figure 3-17. An integrity check of an EDB file

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Viewing Deleted Messages

Single Mailbox Recovery can view and restore deleted messages that are held in the EDB file. 
These messages appear under the Status column in the Source message list. If deleted messages 
have been purged from the EDB file due to the deleted retention schedule, Single Mailbox 
Recovery cannot view or restore these messages. 

Content analysis store deleted messages in both the Source and Target panes also appear under the 
Status column in the message list.
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Setting Preferences

The Preferences window allows you to streamline Single Mailbox Recovery operations. Most of 
the preference settings in the three tabs are selected by default. There are two exceptions: the 
“Display new PST when PST limit is reached” setting in the Options tab, and the “Enable Tamper-
Proof Target” setting in the Security tab. If you change the settings, they are stored and reloaded on 
the next run of Single Mailbox Recovery. 

To change preference settings 

1. On the Edit menu, click Preferences.
2. Select or deselect the check boxes in the three tabs, as desired.

Options Tab

Figure 3-18. The Options Tab in Preferences

• Run Data Wizard on startup: The Data Wizard will launch every time you open Single 
Mailbox Recovery.

• Create new PST folders when PST message/folder limits are reached: Single Mailbox 
Recovery will automatically create new folders (e.g., Inbox) when the 16,383 
messages/folder limit is reached. After Single Mailbox Recovery creates a new folder, it 
continues to restore Exchange data where it left off. For more information, see “Limits for 
PST and Folder Targets” on page 220.

• Check for duplicate messages during copy: When restoring Exchange data, Single 
Mailbox Recovery does not copy duplicates of a message to the destination folder if a 
message already exists in the destination folder. Selecting this preference setting results in 
slower copy performance.
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• Check for duplicate messages during search: Single Mailbox Recovery will not return 
duplicates of a message during a search. For example, if the same message exists in two or 
more data stores, only the first message found is listed in the search results. Selecting this 
preference setting results in slower search performance.

• Display new PST when PST limit is reached: When the limit for a PST is reached in the 
Target pane, Single Mailbox Recovery automatically displays the overflow PST.

• Allow mailbox creation during copy: If this option is selected and a mailbox copy is 
initiated by you, mailboxes can be created during a mailbox copy. If it is deselected, 
mailbox creation cannot take place during copy. This setting has no effect on manual 
mailbox creation.

• Prompt whether to create mailboxes during copy: If this option is selected, you are 
prompted at the beginning of a copy and are asked if mailboxes should or should not be 
created. When it is deselected, mailbox creation occurs automatically. This setting is 
only in effect when Allow mailbox creation during copy is enabled. This setting has 
no effect on manual mailbox creation, or during a single mailbox copy.

• License file name: This box displays the current location of the license file. To put this file 
in a different location, click Browse and navigate to the desired location. There are two 
ways to manage the location of the license file:

• Multiple Copies of Single Mailbox Recovery: Put one license file in the Single 
Mailbox Recovery program directory of each Single Mailbox Recovery  installation.

• Single Copy of Single Mailbox Recovery: Put one license file in a single network 
folder to which all Single Mailbox Recovery installations make reference. 

Note:  For more information about the license file, see “About the license file” on page 14.
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Security Tab

The options in this tab are modifiable by default only by users that belong to the Administrator 
Group. The options are stored in the registry: 
HKEY_LOCAL_MACHINE\Software\NetApp\SMBR. 

The Single Mailbox Recovery Installation program sets this registry key to have read/write access 
to users in the Administrators group and read-only access by any user in the Users group. 

Figure 3-19. The Security Tab in Preferences

• Allow preview of messages: If this option is not selected, you will not have the ability to 
open or preview messages in the Source or Target.

• Enable Tamper-Proof Target: If this option is selected, Single Mailbox Recovery does not 
allow you to delete messages or folders in the Target or have the ability to rename folders in 
the Target. You only have the ability to add (copy) to the Target. 

• Allow Bcc field to be included when restoring or searching messages: If this option is 
selected, Single Mailbox Recovery includes Bcc information when restoring or searching 
messages. This means that a recipient is able to see Bcc recipients that he or she was not 
intended to see. It also means that searching with the “Sent to” option returns messages for 
Bcc recipients.

• Enable Message Views: If this option is selected, it makes the Message Views available. 
• List inaccessible mailboxes: If this option is selected, the inaccessible mailboxes listed in 

the directory are shown. They are for display only.
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Warnings Tab

Figure 3-20. The Warnings Tab in Preferences

• Show warning when logs specified but not found: Single Mailbox Recovery warns you 
when opening an EDB file if no .log files were found at the specified directory.

• Show warning when no log file path specified: Single Mailbox Recovery warns you when 
opening an EDB file if a .log file path has not been specified.

• Show warning when copying to Exchange Server root: Single Mailbox Recovery warns 
you when you are about to copy a large amount of data to the Exchange Server root.

• Show warning when opening an Exchange Server and an Exchange Server is already 
open: This warning appears when you attempt to connect to either a single mailbox or all 
mailboxes on an Exchange Server when a Target Exchange connection is already open in 
Single Mailbox Recovery.
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Overview

This chapter describes how to open a source EDB file or PST file and specify a target PST file or 
target Exchange server. The following topics are covered: 

Pointing Single Mailbox Recovery to a NetApp device. In order for Single Mailbox Recovery to 
operate, you must point it to a NetApp storage system that exists in the same network environment. 

Running the Data Wizard. The first time you start Single Mailbox Recovery, the Data Wizard 
starts. This section describes the Data Wizard, which guides you through the reading of EDB files 
or PST files into Single Mailbox Recovery and shows you how to specify the target PST file or 
Exchange server. 

Opening the source and target from the main window. Instead of using the Data Wizard to open 
the source databases and target mailboxes, you can use individual commands from the Single 
Mailbox Recovery main window.  

Opening multiple sources and targets. This section describes how you can display multiple 
sources in the Source pane Single Mailbox Recovery main window and how you can display 
multiple targets in the Target pane of the Single Mailbox Recovery main window. 

Closing sources and targets. This section describes how to close sources and targets from the 
Single Mailbox Recovery main window. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Pointing Single Mailbox Recovery to a NetApp Device

In order for Single Mailbox Recovery to operate, one or more NetApp storage systems must be 
present on the same network as the one on which Single Mailbox Recovery is installed. 

The first time you start Single Mailbox Recovery, NetApp recommends that you complete the 
following steps to point Single Mailbox Recovery to the presence of a NetApp storage system that 
is running in the same network environment. 

1. Click the Start button, and then point to Programs. Point to NetApp, point to Single 
Mailbox Recovery, and then click Single Mailbox Recovery. 

2. When the Data Wizard appears, click Close to close it. And display your blank Single 
Mailbox Recovery panes. 

3. Click Help and About and then click License Info to display the License Information page. 
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4. Locate the Storage appliance name or IP address field. Type or browse and select the 
name or IP address of any NetApp storage system on the network and press the Enter key. 

Note:  The name or IP address of any NetApp storage system in the environment will 
suffice, whether or not you intend to carry out Single Mailbox Recovery operations on it. 

5. After you press the Enter key, click the Close button (Be sure to press the Enter key first) 
to close the License information box. 

6. Click OK to close the About box.  
7. If you want to restart the Data Wizard, open the File menu and select Use Wizard. 

Note:  After you have specified the name or IP address of a NetApp storage system in the 
environment once, you do not need to enter it again, as long as the specified storage system exists 
in this network environment.   

Alternative Ways to Specify a NetApp Device 

In addition to your entering the name or IP Address of a NetApp storage system on the License 
Information page, the following alternative conditions also satisfy the requirement for the presence 
of a NetApp storage system: 

• A LUN on a NetApp storage system is connected to an available drive letter on the Single 
Mailbox Recovery server. You do not need to use this LUN as the Destination Folder. 

• The Destination Folder resides on CIFS share on a NetApp storage system, and the CIFS 
share is either mapped to a drive letter on the Single Mailbox Recovery server or is accessed 
by a specified UNC path.  

• The Destination Folder resides on a CIFS share on a Windows server that has a NetApp 
LUN connected to it, and the CIFS share is either mapped to a drive letter on the Single 
Mailbox Recovery server or is accessed by a specified UNC path. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Running the Data Wizard

The Data Wizard guides you through the loading of EDB or PST files into Single Mailbox 
Recovery, and shows you how to specify the target PST file or Exchange server. 

Configuring Single Mailbox Recovery

If Single Mailbox Recovery Administrative Server is connected and activated, you may have to 
manually locate a server if Single Mailbox Recovery cannot locate one automatically. By default, 
the automatic location is attempted. If it fails, the following message is displayed:
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Figure 4-1. Automatic Server Connection message

If you select “No,” Single Mailbox Recovery closes. If you select “Yes,” the following window is 
displayed:

Figure 4-2. Connection Point Manager

To add a server

1. Deselect Use Active Directory to locate server if it is selected.
2. Click Add. The Server Information window appears.
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Figure 4-3. Enter Server Information

3. Enter the Server address name or IP address and click OK.
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Before You Use the Data Wizard

The following information describes what you need to do in order to be able to select the source of 
the mail items you want to recover.

If the Source File is... Then do this:

An EDB file stored in a 
LUN on a NetApp 
storage system

NOTE: This includes 
SnapVault secondary 
storage system 
configurations.

1. Use the NetApp SnapDrive Connect Wizard to connect 
that LUN to an available drive letter on the Single Mailbox 
Recovery server. For details, see “Connecting Virtual Disks” 
in SnapDrive Installation and Administration Guide. When 
you select the source Exchange database, the mounted LUN 
will be your source drive. 

NOTE: Do not use the Data ONTAP LUN cloning feature to 
clone a virtual disk backed by a snapshot that is connected 
using SnapDrive. SnapDrive considers such a disk to be 
temporary, and it deletes the disk upon disconnect. 

2. Verify that there is sufficient hard drive space available to 
store temporary files that Single Mailbox Recovery creates. 
For details, see “Verifying Hard Drive Space for .idx and .dat 
Files” on page 287. 

CAUTION: Unmount this LUN as soon as your Single 
Mailbox Recovery restore operation is completed. Avoid 
maintaining a connection to a LUN in a snapshot during a 
period when the NetApp storage system volume containing 
that LUN is scheduled for update snapshots. While a LUN in 
a snapshot is mounted, if one or more snapshots are taken of 
the volume containing the LUN, a “busy snapshot” will 
result, and you will be unable to unmount or delete that LUN 
until all the more recent snapshots are deleted.

An EDB file in a backup 
created using a supported 
backup application other 
than SnapManager

1. Use Single Mailbox Recovery ExtractWizard to restore the 
files to a location accessible from the Single Mailbox 
Recovery server.  

2. If the backup is an offline backup or in an online 
incremental or differential backup, organize the files for 
use by Single Mailbox Recovery. For details, see 
“Organizing Files Extracted From Other Backup 
Applications” on page 286. 

3. Verify that there is sufficient hard drive space available to 
store temporary files that Single Mailbox Recovery creates. 
For details, see “Verifying Hard Drive Space for .idx and .dat 
Files” on page 287. 
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Data Wizard: Welcome Page

1. Click Start, and then point to Programs. Point to NetApp, point to Single Mailbox 
Recovery, and then click Single Mailbox Recovery. The Data Wizard appears. 

Note:  Because Single Mailbox Recovery requires a NetApp storage system in the same 
network environment in order to carry out its operations, NetApp recommends that the first 
time you start Single Mailbox Recovery that you click Cancel to close the Data Wizard. 
Then complete the steps described in “Pointing Single Mailbox Recovery to a NetApp 
Device” on page 159 to specify an instance of a NetApp device. After completing this task, 
you can then restart the Wizard by opening the File menu and selecting Use Wizard. 

2. If you do not want to run the Data Wizard every time you start Single Mailbox Recovery, 
deselect the Run On Startup check box. Click Next.

Figure 4-4. Opening page of the Data Wizard

A PST file Enable the PST source agent. For details, see “PST Source 
Agent” on page 4 and “Task III: Enable Any Optional 
Agents” on page 14.

NOTE: You cannot open the same PST file as both source and 
target. Also, due to the database nature of the PST file and 
MAPI subsystem, PSTs opened as source will be modified.

If the Source File is... Then do this:
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Data Wizard: Source Path Selection

On the Source Path Selection page of the Data Wizard, specify the Source EDB file path along with 
its log file path and temporary file path; or specify the Source PST file or CAS file path. If you do 
not want to open a Source EDB, PST, or CAS file at this time, click Skip.

Note:  Due to the database nature of the PST file and MAPI subsystem, PSTs opened as Source are 
modified.

To specify a source file

1. In the Source File box, click Browse to find the Source EDB file, Source PST file, or 
Source CAS file. 

2. If you specified a PST or CAS file path, proceed to step 5. PST files do not require log file 
or temporary file paths.

3. In the Log File Path box, click Browse to find the log files associated with the Source EDB 
file. 

Important:  After you select an EDB file, the Log File Path box defaults to the Source EDB 
file path, even if the log files are not in the same directory as the Source EDB file. Therefore, 
make sure you enter the correct log file path in the Log File Path box.

4. In the Temporary File Path box, accept the default location for .idx and .dat files, or 
specify a new location if they require more hard drive space. For more information, see 
“Verifying Hard Drive Space for .idx and .dat Files” on page 287.

Figure 4-5. Browse to the EDB or PST file to use as Source

5. Click Next.
Before you can open a source, Single Mailbox Recovery checks for the following 
conditions:
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• A LUN on a NetApp storage system is connected to an available drive letter on the 
Single Mailbox Recovery server. You do not need to use this LUN as the Destination 
Folder. 

• An EDB file exists on either a drive litter on the Single Mailbox Recovery server that is 
mapped to CIFS share on a NetApp storage system or on a direct UNC path to a CIFS 
share on a NetApp storage system. 

If Single Mailbox Recovery does not find any of the above conditions to be true, you cannot 
open a source file. 

Data Wizard: Target Type and Path Selection

On the Target Type and Path Selection page of the Data Wizard, specify the type and path of the 
Target file you are using as the container for your restored data. You have four choices: 1) specify a 
PST file as the Target for restored data; 2) specify an Exchange Server single mailbox connection 
as the Target for restored data; 3) specify an Exchange Server all mailboxes connection as the 
Target for restored data; or 4) specify a Content Analysis Store (CAS) file as the Target for creation 
or processing. An option to open Public Folders is available upon connection to an Exchange 
Server.

Note:  Click Skip if you do not want to select a Target file at this time.

To specify a PST File as the Target for restored data

1. Select the PST File option.

Figure 4-6. Select the PST File option in the Target Type & Path Selection window

2. Do one of the following:
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• If you know the Target PST file path, type it in the Target PST File path box.
• Click Browse to open the Create PST File window, and navigate to the desired 

location. Then create a new PST file by typing a name in the File name box, or select 
an existing PST file. Next, click Open. The path of the Target PST file appears in the 
Target PST File path box. 

3. Click Next.

To specify an Exchange Server as the Target for restored data for a Single Mailbox

1. Select the Connect to Exchange Server (Single Mailbox) option. 

Figure 4-7. Selecting Connect To Exchange Server (Single Mailbox) brings up the Target 
Exchange Server section.

2. For Mailbox and Server Name boxes, type the mailbox and server names. 

Tip:  If you do not know the full name of the mailbox, type the first letter of the mailbox in 
the Mailbox Name box, and click Next. In the Check Name window that appears, select the 
mailbox from the list, and click OK.

3. The Connect to Public Folders check box is selected by default. This feature allows you to 
open public folders as a Target for restoring public folders or messages. If you do not want 
to restore to public folders, deselect this check box. For more information, see “Restoring to 
Public Folders” on page 234.

4. If you are not connected to a domain, the Enter Password window appears. In this window, 
type a user name that has full rights to the mailbox, a password, and a domain name. Then 
click OK. This window may appear again, which will require you to reenter this 
information.
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5. Click Next.

To specify an Exchange Server as the Target for restored data for All Mailboxes

1. Select the Connect to Exchange Server (All Mailboxes) option. 

Figure 4-8. Selecting Connect To Exchange Server (All Mailboxes) brings up the Target 
Exchange Server section.

2. For Domain Controller and Server Name boxes, the domain controller and server names 
auto-populate. 

3. The Connect to Public Folders check box is selected by default. This feature allows you to 
open public folders as a Target for restoring public folders or messages. If you do not want 
to restore to public folders, deselect this check box. For more information, see “Restoring to 
Public Folders” on page 234.

4. If you are not connected to a domain, the Enter Password window appears. In this window, 
type a user name that has full rights to the mailbox, a password, and a domain name. Then 
click OK. This window may appear again, which will require you to reenter this 
information.

5. Click Next.

To specify a content analysis store

1. Select the Content Analysis Store option.
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Figure 4-9. Select Content Analysis Store in the Target Type & Path Selection

2. Do one of the following:
• If you know the Target CAS file path, enter it in the Content Analysis Store Path box.
• Click Browse to open the Create Content Analysis File window, and navigate to the 

desired location. Then create a new CAS file by typing a name in the File name box, or 
select an existing CAS file. Next, click Open. The path of the Target CAS file appears 
in the Content Analysis Store Path box. 

3. Click Next.

Data Wizard: Now Processing Data File

The Now Processing Data File page of the Data Wizard reports the processing of the EDB file in 
three stages: pre-scanning the log files (integrity check); scanning the log files (i.e., playing the log 
files); and hashing the EDB file (building a folder hierarchy). 

When the processing is complete, Single Mailbox Recovery automatically proceeds to the next 
page.

Note:  If Single Mailbox Recovery encounters bad or missing log files during log playing, you will 
be given the option to continue without playing the logs. If you choose to continue, Single Mailbox 
Recovery processes the EDB without logs. 
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Figure 4-10. If log files are missing, an error message will display

Data Wizard: Completing the Data Wizard

On the last page of the Data Wizard, click Finish. This page of the Data Wizard lists the Source file 
results and the Target file results.

Figure 4-11. Last page of Data Wizard
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Looking at the Main Window after Using the Data Wizard

In the Single Mailbox Recovery main window, the Source and Target panes now contain a Source 
EDB file, PST file, CAS, Target PST file, a Target Exchange Server, or Target CAS.

Figure 4-12. Source panes with PST, EDB, and CAS files

Figure 4-13. Target panes for PST files, Exchange Server, and CAS file

Returning to the Data Wizard

When working in the Single Mailbox Recovery main window, you can return to the Data Wizard at 
any time.

To open the Data Wizard from the main window

• On the File menu, click Use Wizard.

Source pane for an EDB fileSource pane for a PST file

Source pane for a CAS file

Target pane for an 
Exchange Server

Target pane for a PST file

Target pane for a CAS file
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Opening the Source Database and Target Mailboxes from the 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Main Window

Instead of using the Data Wizard to open the Source databases and Target mailboxes, you can open 
them from the Single Mailbox Recovery main window.

Before You Proceed

Before you proceed with opening Source databases and Target mailboxes, here is important 
information that will help enable smooth operation of Single Mailbox Recovery.

SINGLE MAILBOX RECOVERY EXTRACTWIZARD

Use the Single Mailbox Recovery ExtractWizard if you have not yet restored backed-up Exchange 
Information Store data. The Single Mailbox Recovery ExtractWizard reads previous Exchange 
Server backups and restores EDB files to any machine, volume, or folder. For more information, 
see “Using the Single Mailbox Recovery ExtractWizard” on page 17.

Note:  Due to the database nature of the PST file and MAPI subsystem, PSTs opened as Source are 
modified.

MAILBOX ACCESS

If your Administrator is running Single Mailbox Recovery Administrative Server  and has the 
Mailbox Permission plug-in activated, your access to mailboxes within a mailbox store (private 
EDB file) may be affected depending on the permission settings.

If permission to access a mailbox is denied, you are not able to access the contents of that specific 
mailbox. The inaccessible mailbox either in the Source or Target pane displays with an inaccessible 
icon , or is hidden depending on your Preference setting. See “Setting Preferences” on 
page 154 for more information.

Note:  Contact your Single Mailbox Recovery Administrative Server systems administrator if you 
need access to inaccessible mailboxes.

An EDB file that is denied access through the Single Mailbox Recovery Administrative Server 
Mailbox Permission setting affects:

• Find Window: An inaccessible mailbox’s contents cannot be processed during a search.
• Message Views: Any message items in an inaccessible mailbox are not displayed in an 

Conversation Table View or an Attachment Table View.
• CAS as a Target: Only accessible mailbox messages in the EDB Source are processed 

when populating a CAS profile.
• Exporting: Inaccessible mailboxes cannot be exported.
• Copying: Inaccessible mailboxes cannot be copied.
• Integrity Checking: Inaccessible mailboxes cannot have an Integrity Check performed on 

them. 
• Properties: An inaccessible mailbox’s properties cannot be viewed.
• Reports: Reports cannot be generated for inaccessible mailboxes.
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Connection Interruption

If errors are encountered that interrupt the communication between Single Mailbox Recovery and 
the Single Mailbox Recovery Administrative Server, an error is displayed. You can choose to retry 
the failed communication attempt. If the error is transient (e.g., a temporary network failure) and 
has been addressed, retrying allows Single Mailbox Recovery to continue. 

Figure 4-14. Server communication problem error message

If you click “No,” a further error is displayed and Single Mailbox Recovery closes when “OK” is 
clicked.

Figure 4-15. Message that Single Mailbox Recovery is not permitted to run.

Note:  If the error cannot be overcome, or more than 8 minutes has passed since the fault occurred, 
a successful retry is not possible. 
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Opening Source and Target Files

The File menu and toolbar can be used to open Source or Target files in addition to the Data 
Wizard.

Before You Open the Source Database from the Main Window

The following information describes what you need to do in order to be able to select the source of 
the mail items you want to recover.

If the Source File is... Then do this:

An EDB file stored in a 
LUN on a NetApp 
storage system

NOTE: This includes 
SnapVault secondary 
storage system 
configurations.

1. Use the NetApp SnapDrive Connect Wizard to connect 
that LUN to an available drive letter on the Single Mailbox 
Recovery server. For details, see “Connecting Virtual Disks” 
in SnapDrive Installation and Administration Guide. When 
you select the source Exchange database, the mounted LUN 
will be your source drive. 

NOTE: Do not use the Data ONTAP LUN cloning feature to 
clone a virtual disk backed by a snapshot that is connected 
using SnapDrive. SnapDrive considers such a disk to be 
temporary, and it deletes the disk upon disconnect. 

2. Verify that there is sufficient hard drive space available to 
store temporary files that Single Mailbox Recovery creates. 
For details, see “Verifying Hard Drive Space for .idx and .dat 
Files” on page 287. 

CAUTION: Unmount this LUN as soon as your Single 
Mailbox Recovery restore operation is completed. Avoid 
maintaining a connection to a LUN in a snapshot during a 
period when the NetApp storage system volume containing 
that LUN is scheduled for update snapshots. While a LUN in 
a snapshot is mounted, if one or more snapshots are taken of 
the volume containing the LUN, a “busy snapshot” will 
result, and you will be unable to unmount or delete that LUN 
until all the more recent snapshots are deleted.
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Specifying a Source and a Target from the Main Window

The following topics are covered:

• To “specify a source file” on page 165
• To “open an existing Target PST” on page 177
• To “create a new Target PST” on page 177
• To “open a Target Exchange Server” on page 178

To open a Source file

1. Do one of the following:
• On the File menu, click Open Source.
• On the toolbar, click the Open Source icon .

Important:  Before you select a source file in the dialog box below, see “Before You Open 
the Source Database From the Main Window” on page 174.

An EDB file in a backup 
created using a supported 
backup application other 
than SnapManager

1. Use Single Mailbox Recovery ExtractWizard to restore the 
files to a location accessible from the Single Mailbox 
Recovery server.  

2. If the backup is an offline backup or in an online 
incremental or differential backup, organize the files for 
use by Single Mailbox Recovery. For details, see 
“Organizing Files Extracted From Other Backup 
Applications” on page 286. 

3. Verify that there is sufficient hard drive space available to 
store temporary files that Single Mailbox Recovery creates. 
For details, see “Verifying Hard Drive Space for .idx and .dat 
Files” on page 287. 

A PST file Enable the PST source agent. For details, see “PST Source 
Agent” on page 4 and “Task III: Enable Any Optional 
Agents” on page 14.

NOTE: You cannot open the same PST file as both source and 
target. Also, due to the database nature of the PST file and 
MAPI subsystem, PSTs opened as source will be modified.

If the Source File is... Then do this:
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Figure 4-16. Browse to a EDB, PST, or CAS file to use as Source

2. In the Source File box, click Browse to find a Source EDB, PST, or CAS file. The CAS 
files are used for the content analysis store feature.

3. If you selected a PST or CAS file, proceed to step 6. PST and CAS files do not require log 
file or temporary file paths.

Note:  Due to the database nature of the PST file and MAPI subsystem, PSTs opened as 
source will be modified.

4. In the Log File Path box, click Browse to find the log files associated with the Source EDB 
file. 

Important:  After you select an EDB file, the Log File Path box defaults to the Source EDB 
file path, even if the log files are not in the same directory as the Source EDB file. Therefore, 
make sure you enter the correct log file path in the Log File Path box.

5. In the Temporary File Path box, accept the default location for .idx and .dat files, or 
specify a new location if they require more hard drive space. 
For more information, see “Verifying Hard Drive Space for .idx and .dat Files” .

6. Click OK. The EDB or PST file appears in the Single Mailbox Recovery Source pane.
Before you can open a source, Single Mailbox Recovery checks for the following 
conditions:

• A LUN on a NetApp storage system is connected to an available drive letter on the 
Single Mailbox Recovery server. You do not need to use this LUN as the Destination 
Folder. 
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• An EDB file exists on either a drive litter on the Single Mailbox Recovery server that is 
mapped to CIFS share on a NetApp storage system or on a direct UNC path to a CIFS 
share on a NetApp storage system. 

If Single Mailbox Recovery does not find any of the above conditions to be true, you cannot 
open a source file. 
If one or more of the above conditions are true, the EDB or PST file appears in the Single 
Mailbox Recovery Source pane.

Figure 4-17. Source pane for an EDB file

Tip:  You can use Windows Explorer to open an EDB, PST, or CAS file. In Windows 
Explorer, double-click the file or drag into the Single Mailbox Recovery Source pane.

To open an existing Target PST

1. Do one of the following:
• On the File menu, point to Target PST, and click Open Existing.
• On the toolbar, click the Open Target PST icon . 

2. In the Open Existing PST window, navigate to the desired location, and select an existing 
PST file.

3. Click Open. The PST file appears in the Single Mailbox Recovery Target pane.

Tip:  In Windows Explorer, you can drag a PST file into the Single Mailbox Recovery Target 
pane. Note that double-clicking a PST file does not open it when using Windows XP, 
Outlook XP, or Outlook 2003.

To create a new Target PST

1. On the File menu, point to Target PST, and click Create New.
2. In the Create PST File window, navigate to the desired location. You may want to create a 

new folder.
3. In the File name box, type a name for the new PST file. 
4. Click New. The PST file appears in the Single Mailbox Recovery Target pane.

Note:  With Outlook 2003, you have to choose between the 97 and 2003 version of the PST.
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Figure 4-18. Target pane for a PST file

To open a Target Exchange Server

1. Do one of the following:
• On the File menu, click Open Target Exchange Server.
• On the toolbar, click the Open Target Exchange Server icon . The Connect to 

Exchange Server window appears.

Figure 4-19. Enter the Mailbox Name and Server Name to connect to the Exchange Server

2. For the Mailbox and Server Name boxes, type the mailbox and server names. 

Tip:  If you do not know the full name of the mailbox, type the first letter of the mailbox in 
the Mailbox Name box, and click OK. (Log on to the Exchange Server if prompted; see step 
4.) In the Check Name window that appears, select the mailbox from the list, and click OK.

3. The Connect to Public Folders check box is selected by default. This feature allows you to 
open public folders as a Target for restoring public folders or messages. If you do not want 
to restore to public folders, deselect this check box. For more information, see “Restoring to 
Public Folders” on page 234.

4. If you are not authenticated to the domain, the Enter Password window appears. In this 
window, type a user name that has full rights to the mailbox, a password, and a domain 
name. Then click OK. This window may appear again, which requires you to reenter this 
information.

5. Click OK. The Exchange Server appears in the Single Mailbox Recovery Target pane.
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Figure 4-20. Target pane for an Exchange Server

To open a Target content analysis store

1. Do one of the following:
• On the File menu, click Open Target Content Analysis Store.
• On the toolbar, click the Open Target Content Analysis Store icon . The 

Opening a Content Analysis File window appears.
2. In the Opening a Content Analysis File window, navigate to desired location and select an 

existing CAS file.
3. Click Open. The CAS file appears in the Single Mailbox Recovery Target pane.

Opening a Live Microsoft Exchange Server as a Target

You can open live Exchange Servers as a Target within Single Mailbox Recovery. This means you 
can connect to one live Exchange Server at a time, establishing a single mailbox connection or 
connecting to all accessible mailboxes and displaying a list of the mailboxes found in that 
Exchange Server. A status indicator tells you if you have permission rights to view a mailbox. 

Note:  The Exchange Server as a Target feature is only supported if the system running Single 
Mailbox Recovery is on the same domain as the Exchange Server.

MAILBOX ACCESS

When connecting to a single mailbox, the Target pane populates with only the specified single 
mailbox. When connecting to all mailboxes on an Exchange Server, the Target pane populates with 
the list of mailboxes found in that Exchange Server. 

Note:  You can connect to only one live Exchange Server at a time. If you attempt to connect to an 
additional live Exchange Server while a server is already open, the current server connection 
closes. 
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PREFERENCE SETTING

When Single Mailbox Recovery connects to an Exchange Server, it can display both accessible and 
inaccessible mailboxes. You can set the preferences so that all mailboxes are displayed regardless 
of their permission status or only those mailboxes that you are permitted to view. See “Setting 
Preferences” on page 154 for more information.

Figure 4-21. List inaccessible mailboxes preference

Note:  Deselecting this option while you have mailboxes open prompts the mailbox list to refresh 
and redisplay without the inaccessible mailboxes showing.

MAILBOX FUNCTIONS

Paste, Paste Special, folder creation, folder renaming, and the search functions are available for the 
accessible mailboxes. A mailbox or server cannot be renamed.

To open a single mailbox in a live Exchange Server as a Target

1. Do one of the following to display the Connect To Exchange Server window:
• On the File menu, click Open\Create Target, then click Open Target Exchange 

Server.
• On the toolbar, click the Open Target Exchange Server icon . 
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Figure 4-22. Connect To Exchange Server

2. Under Connect options, click Connect to a single mailbox.
3. Enter Exchange Information:

• Mailbox Name: The mailbox name must match exactly what is in the Exchange 
Server.

• Server Name: The Server Name must match the existing Exchange Server.
4. Select Connect To Public Folders if desired.
5. Click OK. The Opening Target process begins. This may take several minutes.
6. The Opening Target progress report can be printed or saved if desired. Otherwise, click 

Close to close the progress window and display the opened mailboxes in the Target pane.

To open mailbox(es) in a live Exchange Server using the Data Wizard

1. Open the Data Wizard by doing one of the following:
• On the File menu, click Use Wizard.
• Press Ctrl+W.

2. Click Next and then Skip to reach the Target Type & Path Selection page.
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Figure 4-23. Connect To Exchange Server using the Data Wizard

3. Select Connect To Exchange Server (Single Mailbox) or Connect To Exchange Server 
(All Mailboxes).

4. Do one of the following:
• For Single Mailbox, using the drop-down arrows, select the correct Mailbox Name 

and Server Name.
• For All Mailboxes, using the drop-down arrows, select the Domain Controller and 

Server Name.
5. Select or deselect Connect To Public Folders as desired.
6. Click Next. The Opening Target progress window is displayed. If Microsoft Office 

Outlook does not recognize the Mailbox Name, a Check Name window appears.
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Figure 4-24. Check Name

7. Select a new Mailbox Name from the Change to list and click OK. The connection 
completes and the Completing the Data Wizard page appears.

8. Click Finish.

To open a multiple mailboxes in a live Exchange Server as a Target

1. Do one of the following to display the Connect To Exchange Server window:
• On the File menu, click Open\Create Target, and then click Open Target Exchange 

Server.
• On the toolbar, click the Open Target Exchange Server icon . 

2. Under Connect options, click Connect to all mailboxes on server.
3. Enter Exchange Information:

• Domain Controller: The domain controller is needed to retrieve the list of mailboxes 
from Active Directory. It must match the existing Exchange Server.

• Server Name: The Server Name must match the existing Exchange Server.
4. Select Connect To Public Folders if desired.
5. Click OK. If the server is already open, a message appears asking you if you want to close 

the current server and continue.

Figure 4-25. Exchange Server already open message
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Tip:  If you do not want this message to display every time you already have an Exchange 
Server open, select Do not show this message again. Selecting this option deselects the 
Show warning setting in Preferences - Warnings tab.

Figure 4-26. Deselected warning message

Clicking OK in the Exchange Server already open message begins the Opening Target 
process. This may take several minutes.

Figure 4-27. Opening Target progress window

6. To stop the opening process from completing, click Cancel. A cancel confirmation message 
appears. Until you click Yes or No, the opening process continues in the background. 

Note:  If you click Yes to confirm the cancel operation, all mailboxes opened up to this point 
appear in the Target pane after the progress window is closed.
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7. The Opening Target progress report can be printed or saved if desired. Otherwise, click 
Close to close the progress window and display the opened mailboxes in the Target pane.

Opening Multiple Sources and Targets

You can display multiple Sources in the Source pane and multiple Targets in the Target pane. 
Sources include EDB, PST, and CAS files. Targets include PSTs, CAS, and Exchange Servers. See 
the instructions for using the Data Wizard or the Single Mailbox Recovery main window to open 
one Source or one Target at a time.

Figure 4-28. Multiple Sources can be displayed

Closing Sources and Targets

You can close Sources and Targets from the Single Mailbox Recovery main window.

Avoid maintaining a connection to a LUN in a snapshot during a period when the NetApp storage 
system volume in which that LUN is contained is scheduled for update snapshots. 

Caution:  If a LUN in a snapshot is mounted, and while it is mounted one or more snapshots are 
taken of the filer volume in which it is contained, a “busy snapshot” will result, and you will not be 
able to unmount or delete that LUN until all the more recent snapshots are deleted. The chances of 
this situation are increased in configurations where a single secondary storage volume is used to 
coalesce snapshots from numerous primary storage trees. 

To close a Source

1. In the Source pane, select a Source EDB, PST, or CAS file.
2. Do one of the following:

• On the File menu, click Close Store.
• Right-click the selection, and on the context menu click Close Store.

3. If the source is an EDB file in a SnapManager-based backup snapshot, unmount the LUN as 
soon as your Single Mailbox Recovery restore operation is completed.

To close all Sources

1. In the Source pane, right-click the Sources root node.
2. On the context menu, click Close All Stores.

Multiple Targets

Multiple Sources
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3. If the source is an EDB file in a SnapManager-based backup snapshot, unmount the LUN as 
soon as your Single Mailbox Recovery restore operation is completed.

To close a Target

1. In the Target pane, select a PST file, Exchange database, or CAS file.
2. Do one of the following:

• On the File menu, click Close Store.
• Right-click the selection, and on the context menu click Close Store.

Deleting Items in the Target Pane 

Using the Delete key to remove an item (e.g., folder, message) from the Single Mailbox Recovery 
Target pane permanently deletes the item, similar to using Shift+Delete in Microsoft Outlook.

Note:  Messages within a content analysis store profile folder cannot be deleted.
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Using the Mailbox Creation Wizard

You can create new mailboxes either by using a wizard or the Copy and Paste functions. Possible 
uses for this new function are migrating user accounts from Exchange Server 2000 to an Exchange 
Server 2003 or Exchange Server 2007 Target or archiving legacy data.

User Permission

You must have the necessary Active Directory permissions to create a mailbox on the selected 
Exchange Server. Both the user account logons and the Name field must be unique to create a new 
user account and mailbox. If you are creating a mailbox for an existing user, the Name field must 
match the full name of the existing user.

Tip:  It is recommended that anyone creating mailbox-enabled users have fundamental knowledge 
of Exchange administration and Active Directory.

Creating Mailboxes

You can create mailboxes with the wizard manually or by copying a single mailbox or the root of a 
Source EDB onto the root of a Target Exchange Server. 

Note:  Mailbox creation on disabled user accounts is not supported.

Note:  The Target Exchange Server must be on the same domain as the Single Mailbox Recovery 
computer.

CREATING MAILBOXES USING THE WIZARD

You can create a new mailbox by using the wizard which steps you through the process.
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To create a mailbox using the wizard

1. Open a Target Exchange Server in Single Mailbox Recovery.
2. Right-click the Target Exchange Server root and click New Mailbox, or on the Edit menu, 

click New Mailbox. The New Mailbox form appears.

Figure 4-29. New Mailbox form

3. Enter the User Information and click Next to display the Mailbox Settings window. 
• Organizational unit: This field is pre-populated but you can change it by clicking 

Browse. 
• First name: (Optional) Enter the first name of the user. If a user account already exists 

without a mailbox based on this Name, the mailbox is created on the existing user 
account.

• Initials: (Optional) Enter the initials of the user.
• Last name: (Optional) Enter the last name of the user. If a user account already exists 

without a mailbox based on this Name, the mailbox is created on the existing user 
account.

• Name: This field auto-populates as the First name, Initials, and Last name are entered. 
This field can also be modified.

• User logon name (User Principal Name): Create a user logon name for the new 
account. If this name matches the same field of an existing user account, an error is 
displayed indicating that it is a duplicate.

• UPN suffix: This field adds the Organizational Unit selected as the second half of the 
logon name email address.

• User logon name (pre-Windows 2000): A user logon name for older versions of 
Windows.
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• Password and Confirm Password: (Optional) These fields are optional. It must meet 
the minimum domain password requirements.

• Save as default password: Select this check box to designate the entered password as 
the default.

Figure 4-30. Mailbox Settings window

4. Ensure the Storage group and Mailbox database settings are correct. The Alias and 
Server fields are auto-populated, however, Alias can be edited if necessary. 

5. Click Finish.
6. If the mailbox creates successfully or unsuccessfully, a message displays. Click OK. If it 

was created successfully, the new mailbox automatically appears in the Target directory and 
is expanded.
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Figure 4-31. Mailbox created successfully

Note:  

• If your Preferences are set to display inaccessible mailboxes, they are displayed in the 
Target directory but are inaccessible.

• If the mailbox was created successfully but it cannot be connected to, the new mailbox 
is displayed in the Target directory as inaccessible.

• If the mailbox creation fails, the mailbox does not appear in the Target directory.

CREATING MAILBOXES USING COPY-PASTE

You can create new mailboxes by using the Copy function. Mailbox creation through copying can 
be made available or unavailable through the Preferences window under the Options tab.

To create a new single mailbox using Copy-Paste

1. Verify that Allow mailbox creation during copy option in Preferences is selected.
2. Right-click the single mailbox in the Source pane and click Copy.
3. Highlight the Target Exchange Server and click Paste. The New Mailbox window opens 

with certain fields auto-populated. 

Note:  If Paste is not available, you do not have access rights to the Source mailbox.

4. Click Next. 
5. Confirm Mailbox Settings are correct and click Finish. The Copy Progress window 

displays and creates a report when the copying is finished.
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Figure 4-32. Copy Progress complete

6. Click Print to print the report, Save to save the report to your hard drive, or Close to close 
the Copy Progress window. Each mailbox from the Source EDB you copied is now a new 
mailbox in the Target pane.

Note:  

• If the mailbox already exists and is accessible, it is added to the Target directory and 
shown as accessible.

• If the Source mailbox did not exist in the Target directory, a new mailbox is created on 
either a new user account or an existing user account.

• If the mailbox you just created is not accessible, it displays in the Target directory and 
shown as inaccessible.

To create multiple mailboxes using copy-paste

1. Verify that Allow mailbox creation during copy and Prompt whether to create 
mailboxes during copy options in Preferences are selected.

2. Right-click the entire Source EDB and click Copy. 
3. Highlight the Target Exchange Server and click Paste. A confirmation message appears.

Figure 4-33. Mailbox Creation confirmation message
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4. Clicking Yes opens the User Information window with the fields auto-populated based on 
the information from the Source mailbox. Entering a password is optional, but it must meet 
the minimum domain password requirements. You can still select a different Organizational 
Unit, UPN Suffix, and Password.

5. Click Next. 

Figure 4-34. User Information window for multiple mailboxes 

6. Confirm that the Mailbox Settings are correct. The Alias field is auto-populated based on 
the information from the Source mailbox. 
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Figure 4-35. Mailbox Settings for multiple mailboxes

7. Click Finish. The Copy Progress window appears and creates a report when the copying is 
finished.

Figure 4-36. Copy Progress complete

8. Click Print to print the report, Save to save the report to your hard drive, or Close to close 
the Copy Progress window.
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The EDB Source you copied is now a new mailbox in the Target pane.

Note:  

• If the mailbox already exists and is accessible, it is added to the Target directory and 
shown as accessible.

• If the Source mailbox did not exist in the Target directory, a new mailbox is created on 
either a new user account or an existing user account.

• If the mailbox you just created is not accessible, it displays in the Target directory and 
shown as inaccessible.

Preference Settings

Two options have been added to the Options tab of the Preferences window regarding mailbox 
creation through copy. See “Setting Preferences” on page 154 for more information.

• Allow mailbox creation during copy
• Prompt whether to create mailboxes during copy

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Auditing Failure

If your Administrator is running the Single Mailbox Recovery Administrative Server auditing 
service, any failure of the audit log warns you with a message, giving you the option to retry, re-
connect, or abort Single Mailbox Recovery or Single Mailbox Recovery ExtractWizard. Once the 
audit log is confirmed to have failed, Single Mailbox Recovery or Single Mailbox Recovery 
ExtractWizard starts the process of shutting down. 

Contact your Administrator if restarting the applications is not successful.
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Overview

The Find in Source window lets you search a Source EDB, PST, or CAS file for message items that 
are defined by such criteria as keywords, message senders and recipients, and message creation 
dates. In addition, this window lets you define the scope of your search: an EDB, PST, or CAS file, 
one or more mailboxes or folders (e.g., Inbox), dates, or even previous search results.

The Find in Exchange Server Target window adds the ability to search a live Exchange Server 
Target and perform actions on the search results. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Guidelines for Using the Find Window

• The Find Now button only becomes available if at least one of the following conditions is 
met:

• At least one Search in check box is selected.
• The Sent from or Sent to box contains at least one character.
• The Created Dated after or Created Dated before check box is selected.

• Each Search in check box that you select is run as a separate query, and the results of the 
query are combined (i.e., OR’d together). For example, if you enter “solution” in the Search 
for words box, and then select the Message Subject and Message Body check boxes, 
Single Mailbox Recovery will return message items that contain “solution” in either the 
message subject or message body.

• If you select one or more Search in check boxes, but specify no additional search criteria, 
Single Mailbox Recovery will return all of the message items in the folder(s) undergoing 
the search.

• Single Mailbox Recovery can search multiple information stores at the same time. In the 
Find in Source window, click Browse and you will see a tree view of all of the open Source 
data stores. You can then select multiple mailboxes or folders to include in your search.

• Single Mailbox Recovery does not return duplicates of a message item during a search as 
long as the “Check for duplicate messages during search” preference is selected. For 
example, if the same message item exists in two or more data stores, only the first message 
item found is listed in the search results. For more information, see “Setting Preferences” on 
page 154.
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• The contents of an inaccessible EDB mailbox cannot be searched.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Searching Sources

The Find in Source window provides the ability to search single or multiple mailboxes and perform 
actions on the search results. 

Tip:  CAS and PST files are searchable in the Source pane but not in the Target pane.

The actions allowed to perform on search results are copying or exporting message items, 
performing Integrity Checks, and viewing message items using the Message Views options. You 
can have several Find in Source windows open at a time.

To search for message items in Sources

1. In the Source pane, select the folder (e.g., EDB or PST file, mailbox, Inbox) you want to 
search. The folder(s) you select defines the scope of your search.

2. Do one of the following:
• Click Find  in the toolbar to display the Find in Source window. The name of the 

folder you selected appears next to the Search in folder box.
• Right-click the file and click Find.
• On the Tools menu, click Find.
• Press F3.

Note:  The first time you search for a message item, the Search in folder option is 
automatically selected. For information on using the Search in results option, see 
“Searching Within Results” on page 199.

3. To search multiple mailboxes or folders, click Browse. In the Select Folder(s) window, 
select the items you want to search. In the illustration below, two mailboxes have been 
selected.

Figure 5-1. You can select multiple folders or mailboxes to search.
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Note:  If you select the Search Subfolders check box, Single Mailbox Recovery includes 
subfolders in the search.

4. Click OK to return to the Find in Source window.
In the following illustration, the Search in folder box now displays “Multiple folders 
selected.”

Figure 5-2. Result when multiple folders are selected

5. In the Search for words box, enter one or more words or phrases if you want to execute a 
keyword search. Keep in mind the following points:

• Put a space between words or phrases to perform an AND operation (i.e., all words 
must be matched in order to include a message item with the search results).

• Put a comma between words or phrases to perform an OR operation (i.e., only one of 
the words must be matched in order to include a message item with the search results).

• Put quotation marks around word phrases (i.e., the exact phrase must be matched in 
order to include a message item with the search results).

Example:Search for words: dog cat mouse, rat

Search results: Message items that contain [“dog” AND “cat” AND “mouse”] OR 
[“rat”] are included in the search results.

6. In the Exclude words box, enter words or phrases if you want to perform a NOT operation. 
If matched, these words or phrases will exclude a message item from the search results. The 
rules for using spaces, commas, and quotation marks apply when excluding words from a 
search.

Example:Search for words: dog cat mouse, rat
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Exclude words: bird

Search results: Message items that contain [“dog” AND “cat” AND “mouse”] OR [“rat”] 
BUT NOT [“bird”] are included in the search results.

7. For Search in, select one or more of the following check boxes: Message Subject, 
Message Body, Attachment File Name(s), or Attachment Text. Each Search in check 
box that you select is run as a separate query, and the results of the query are combined (i.e., 
OR’d together). 

Note:  Single Mailbox Recovery has the ability to search multiple levels of embedded 
message items. Select Attachment Text in the Select in check box. See “Searching 
Embedded Message Items” on page 199 for more information.

Note about searching within attachments: Single Mailbox Recovery does not search within 
archive file types such as .zip or .rar files. For more information, see “Searching Within 
Attachments” on page 206.

8. In the Sent from and Sent to boxes, enter the appropriate names, if desired. Using the Sent 
to box is particularly useful if you are trying to find a message item sent to multiple people. 
The rules for using spaces, commas, and quotation marks apply when using the Sent from 
and Sent to boxes.

9. For Created Dated after and Created Dated before, select the appropriate check box, if 
desired. You may select both check boxes. Then type or select the part of the date you want 
to change.

• Created Dated after: Searches for documents created on or after the selected date.
• Created Dated before: Searches for documents created on or before the selected date.

10. When you have finished specifying search criteria, click Find Now. The results of your 
search appear in the message item list.

11. To preview the message items returned by the search, click the Preview check box.
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Figure 5-3. Find window with results and message pane

Searching Embedded Message Items

You can search multiple levels of embedded message items in Single Mailbox Recovery. 

Note:  Searching attachments (email and non-email) is available only when the Single Mailbox 
Recovery Agent for Advanced Searching is enabled. See “Viewing and enabling agents” on 
page 14.  

To search embedded message items

1. Perform steps 1 through 6 in “Searching Sources” on page 196. 
2. For Search in, click Attachment Text. 
3. Continue with step 8 in the “Searching Sources” process.

Searching Within Results

The Search in results option lets you refine the search process using the previous search results.
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To search within results

1. To make the Search in results option available, you must perform at least one search. 
2. Modify the search criteria as desired. For information on specifying search criteria, see 

“Searching Sources” on page 196.
3. Select the Search in results option at the top left of the Find in Source window.
4. Click Find Now. The results of your new search appear in the message item list. 
5. To preview the message items returned by the search, click the Preview check box.

Figure 5-4. Checking the Preview option adds a message Preview pane

VIEWING PREVIOUS SEARCH RESULTS

You can click the Previous button multiple times to return to any previous search criteria and search 
results. This button becomes unavailable when there are no more previous results. 

To view previous search results

1. Perform at least two searches so the Previous button becomes available. 
2. Click Previous. The results of the previous search appear in the in the message item list. 
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3. You can now view the previous search, or you can modify the search criteria and conduct a 
new search. For information on specifying search criteria, see “Searching Sources” on 
page 196.

CLEARING FIELDS AND RESULTS

If you click the Clear Fields button, all of the search criteria that you entered in the Find in Source 
window are returned to the default settings. If you click the Clear Results button, all current and 
past search results are cleared. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Searching Microsoft Exchange Server Target

You can search a live Exchange Server Target and delete, move, copy, or export the search results. 
This means you can search and delete, or move specific message items from an Exchange Server 
Target. You can have only one search session Find in Exchange Target window open at one time.

Note:  Only accessible mailboxes and public folders of the Exchange Server can be searched.

Tip:  CAS and PST files are not searchable in the Target pane but are searchable in the Source 
pane.

To search an Exchange Server Target

1. Do one of the following to display the Find in Exchange Target window:
• Right-click the valid object in the Target pane and click Find. 
• On the Tools menu, click Find.
• On the toolbar, click the Find icon .
• Press F3.

2. Conduct search as described in “Searching Sources” on page 196.

Tip:  Exchange Server Target search results can have an Integrity Check performed either 
by right-clicking the message or click Integrity Check in the Tools menu.

Managing Message Items

Once you have performed a Target search, several functions are available on the search results 
including cut, move, export, copy, and delete. 

MOVING MESSAGE ITEMS

Moving message items from the search results to another folder within the Target directory 
removes the message items from the original location. You can move message items by using the 
Move To Folder function, or by dragging and dropping to the destination folder.

Move to Folder

Single Mailbox Recovery presents you with a Move To Folder option and a corresponding Move 
Items destination selection window. 

Note:  Message items cannot be moved to a Content Analysis Store (CAS).
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To move to folder using Move To Folder

1. Do one of the following to display the Move Items window:
• Right-click the message item(s) in the search results and click Move To Folder. 
• On the Edit menu, click Move To Folder. 

2. Select a folder as the destination and click OK. The Copy Progress window appears.
3. Select Print to print the progress report, Save to save the progress report to your hard drive, 

or Close to close the window.

Moving Message Item using Drag and Drop

Drag and drop from a Find in Target search result list has a “Move” option. This option behaves in 
the same manner as the Move to Folder function or cut and paste. 

To move to folder using drag and drop

1. Right-click the message item in the search results and drag to a mailbox in the Target pane.
2. At the destination mailbox, a shortcut menu appears with the options of Paste, Move, Paste 

Special, or Cancel. Select one and the Copy Progress window appears.

Figure 5-5. Drag and drop context menu

3. Click Print to print the progress report, Save to save the progress report to your hard drive, 
or Close to close the window.

COPYING MESSAGE ITEMS

You can copy message items to Exchange Server and PST file Targets. Only valid Targets are 
displayed in the Copy Items window.

Copy to Folder

Single Mailbox Recovery presents you with a Copy To Folder option which copies the item and 
keeps it in its original location to be pasted in a designated location. 

To copy to folder

1. On the Edit menu, click Copy To Folder. The Copy Items window appears.
2. Select a folder as the destination and click OK. The message item is now copied and pasted 

to the designated location.
3. In the Copy Progress window, click Print to print the progress report, Save to save the 

progress report to your hard drive, or Close to close the window.
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CUTTING AND DELETING MESSAGE ITEMS

The Target search results has two new actions, cutting message items and deleting message items, 
which are only available in the Target search results window. 

Cutting Message Items

Cutting a message item moves the item from the original location to a given target. 

Deleting Message Items

Deleting a message item in the search results works in a similar manner as deleting message items 
from the main Target list. When you delete message items from the search results list, they are also 
deleted from the main Target list if the same message item is currently displayed. 

Note:  You cannot delete message items from the main Target list if the Find in Exchange Target 
window is open.
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Saving and Using Search Profiles

Single Mailbox Recovery allows you to save search criteria to a text file for the purpose of using 
the search criteria in future searches. There are two menu commands that allow you to perform 
these functions: “Save Criteria” and “Use Previous Criteria.” In addition, if you want to modify the 
search criteria in a search profile, you can edit the text file with a text editor.

Figure 5-6. Use the File menu to access the Save Criteria command

When creating a search profile, you can save the following search criteria. The “Search For,” 
“Exclude Words,” “Sent from,” and “Sent to” fields have a maximum of 4,095 characters.

• Search for words
• Exclude words
• Search in
• Sent from
• Sent to
• Created Dated after
• Created Dated before

Note:  The saved criteria of a content analysis store profile folder can be used for a search. 
Conversely, the saved criteria for a search can be used to create a content analysis store profile 
folder. For more information on content analysis stores, see “Content Analysis Store” on page 257.

To create a search profile

1. Open the Find in Source window, and enter search criteria.
2. On the File menu in the Find in Source window, click Save Criteria.
3. In the Save As window, specify a name and location for the search profile text file. 
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4. Click Save.

To edit a search profile

1. Locate and open the search profile that you want to edit.

Figure 5-7. Search profile

2. Modify the search criteria as desired and save the text file. 

To use a search profile when performing a search

1. Open the Find in Source window.
2. On the File menu in the Find in Source window, click Use Previous Criteria.
3. In the Open window, locate and open the search profile that you want to use for your 

search.
4. Click Open. The Find in Source window is populated with the search criteria specified in 

the search profile.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Using Multiple Search Windows 

Single Mailbox Recovery allows you to open multiple instances of the Find in Source window to 
search any combination of information stores at the same time. There is no limit other than system 
resources for the number of concurrent searches you can initiate. 

When searching on a live Exchange Server Target, you are able to have only one instance of a 
search session Find in Exchange Target window at one time. 

Note:  If you are using multiple instances of the Find in Source window to search within the same 
mailbox, you may notice a slowdown in performance.
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Searching Within Attachments 

In both the Find in Source and Find in Exchange Target windows, you can search the text of email 
attachments. The Searching within Attachments feature supports Unicode text and is available for 
EDB, PST, CAS Sources, and Exchange Targets. Single Mailbox Recovery supports Microsoft 
Office documents and many other popular file types. 

Note about the licensing agent: The “Agent for Advanced Searching” must be enabled in order to 
search attachments.  For more information, see “Task III: Enable Any Optional Agents” on 
page 14.

Figure 5-8. Select the Attachment Text option to include in your search

To search within attachments

1. In the Find in Source or Find in Exchange Target window, select the Attachment Text 
check box.

2. Specify other desired search criteria. For more information, see “Searching Sources” on 
page 196.

3. Click Find Now. If Single Mailbox Recovery matches a keyword or phrase in the text of the 
attachment, it will return a “Hit” just as it would if it found a keyword or phrase in the body 
or subject of a message item. 

Exceptions When Searching Within Attachments

Single Mailbox Recovery does not search for the following items:

• Archive files (e.g., .zip, .rar)
• Binary files (e.g., .dll, .exe, .jpg,) 
• Metadata associated with files (e.g., author and company information in an .xls file)
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Other Single Mailbox Recovery Features Available Through 
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the Find Window

In addition to the search features described in the previous sections, there are several Single 
Mailbox Recovery features available through the Find window.

Opening and Saving Attachments in the Find Window

For instructions on opening and saving attachments, see “Opening Attachments” on page 147 and 
“Saving Attachments” on page 147.

Keep in mind that you must have an application on your computer that can open the attachment’s 
file type. If no associated program is available for the attachment file type, Single Mailbox 
Recovery will present a message dialog box saying the attachment cannot be viewed.

Exporting Message Items from the Find Window

The Export feature allows you to copy individual message items from the Find window to a local or 
network drive destination. You can choose to save exported message items as plain text files (.txt) 
or Microsoft Outlook files (.msg). For more information, see “Exporting Messages” on page 211.

Restoring Message Items from the Find Window

The results of conducting a search appear in the message item list in the Find window. You can 
restore the message items in this list by dragging them or copying and pasting them into the Target 
folder. If you want to maintain the directory structure of restored individual message items, use the 
Paste Special command. 

You can also restore message items by browsing in the Single Mailbox Recovery main window and 
dragging and dropping or copying and pasting from the main window to the Target. You do not 
need to search to restore message items. For more information, see “Restoring Exchange Data” on 
page 219. 

Performing an Integrity Check on Message Items in the Find in Source Window

The Find in Source window allows you to perform an integrity check on one or more message 
items in the Results area. During the integrity check, Single Mailbox Recovery verifies that it can 
read all of the properties of the message items.

Note:  Only accessible mailboxes can have an Integrity Check performed.

To perform an integrity check on message items in the Find in Source window

1. In the Find in Source window, perform a search.
2. In the Results area, select the message items for which you want to perform an integrity 

check.
3. On the Tools menu in the Find in Source window, click Integrity Check. The Integrity 

Check window appears. 
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Search Results Report

You can save a text-based report of the search results to your local drive without having to copy or 
export any of the search results. The search results report is saved into a file that includes the search 
criteria, date/time the search was started, and a report of message items that matches the criteria.

Save Report

You can save the search results report once a search has been performed and either completed or 
stopped. 

The Save Report button creates two text-based reports. One report contains a search session 
summary (Summary Report) and the other report contains search session message item results 
(Message Report). 

SUMMARY REPORT

The information included in the Summary report is the search session details and the user-defined 
search criteria for the search. 

MESSAGE REPORT

The information included in the Message report is based on the column headings in the search 
results, message type, attachments, From and To, etc. 

To save the report

1. After conducting the search, click Save Report. The Browse For Folder window appears.
2. Select the destination for the report and click OK. The search results reports creates both a 

Message Report and a Summary Report, and are saved on your hard drive in a .txt format.

Figure 5-9. Summary and Messages Reports

The files are named using the date of the search and a suffix indicating the type of report. 
For example, if you run a search on 5/8/2007, the report names are: 
SearchResults_20070508_Summary.txt for the summary report, or 
SearchResults_20070508_Messages.txt for the message report. 
For cases where you choose to create more than one set of reports on the same date, files are 
named using an incremental numbering convention starting with “1.” If you run a second 
search on 5/8/2007, the report names are:
SearchResults_20070508(1)_Summary.txt for the summary report, or 
SearchResults_20070508(1)_Messages.txt for the message report.
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3. Clicking Cancel during the report generation progress terminates the process and any 
reports created for this Save Report action are deleted from the report destination.

USING THE REPORT

The text summary or message report is tab delimited and can be imported into a spreadsheet if 
desired. Simply drag the .txt file from its location into a blank spreadsheet. The Source # in the 
search results is replaced with the full path to its location in the report.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

You can export mail from an EDB, PST, or CAS Source file to a local or network drive destination. 
Exported messages can be saved as Microsoft Outlook files (.msg) or plain text files (.txt). This can 
assist you in copying old email backups into an alternate or non-email system. You can export at all 
levels: an EDB file, a PST file, a CAS file, a CAS profile folder, a mailbox, a folder, and individual 
messages. EDB files can be exported to PSTs.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
General Information about Exporting Messages

• The file name for an exported message is its subject. A duplicate subject name will create a 
file with the same name but with an (x) appended to the filename: x = 1 for the first 
duplicate, x = 2 for the next duplicate, and so on. If the subject contains illegal file name 
characters, the offending characters will be replaced with an underscore. 

• Associated messages and folder properties will not be exported.
• When exporting individual messages, you have the option to keep the folder/mailbox 

hierarchy, similar to the paste special feature. When exporting a mailbox or folder, you 
have the option to also export the subfolders. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
About Message (.msg), Text (.txt), and PST Export 

The file type for an exported message can be either Microsoft Outlook (.msg) or plain text (.txt). 
EDB files can be exported to a PST.

Message (.msg) export 

A .msg file (OLE compound document) can be imported directly into Microsoft Outlook. This file 
type encapsulates the entire message including attachments. 

Text (.txt) export

A .txt file is created with the following information. Note that neither message attachments nor 
message properties are exported.
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PST export

The Export to PST option allows you to generate PST files for one or all users’ mailboxes from an 
off-line EDB file. Single Mailbox Recovery generates a single PST file for each user’s mailbox. 
See “Exporting to PST” on page 215 for more information.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Exporting Messages 

The following instructions show you how to export an EDB file, a PST file, a CAS file, a CAS 
profile folder, mailboxes, folders, and messages from the Source pane in the Single Mailbox 
Recovery main window. They also show you how to export messages from the Find in Source or 
Find in Exchange Target window. 

Note:  Only accessible mailbox items can be exported. If you are exporting a CAS file, only 
accessible mailboxes are included in the export.

To export an entire EDB file

1. In the Source pane, select the EDB file. 
2. Do one of the following:

• On the Tools menu, click Export.
• On the toolbar, click the Export icon .
• Right-click the EDB file, and on the shortcut menu, click Export. The Export EDB 

window appears.

Figure 6-1. MSG or TXT format can be selected for Export

3. In the Format box, select MSG or TXT.
4. In the Export To box, specify the location for the exported EDB file.
5. Click Export.
6. In the Export Progress window, verify the EDB file was successfully exported, and click 

Close.

To export a PST file, a mailbox, or a folder

1. In the Source pane, select a PST file, a mailbox or a folder (e.g., Inbox). 
2. Do one of the following:

• On the Tools menu, click Export.
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• On the toolbar, click the Export icon .
• Right-click the mailbox or folder, and on the shortcut menu, click Export. The Export 

Mailbox or Export Folder window appears. 

Figure 6-2. Export Mailbox window

Figure 6-3. Export Folder window

3. In the Format box, select MSG or TXT.
4. In the Export To box, specify the location for the exported mailbox or folder.
5. Select the Export Subfolders check box if you want to export all of the subfolders for the 

selected mailbox or folder.
6. Click Export.
7. In the Export Progress window, verify the mailbox or folder was successfully exported, 

and click Close. The mailbox or folder appears in the specified location. In the illustration 
below, the exported folder is the Inbox.

Figure 6-4. The exported Inbox appears in the specified location
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To export individual messages

1. In the Source pane, select one or more messages from the message list. 
2. Do one of the following:

• On the Tools menu, click Export.
• On the toolbar, click the Export icon .
• Right-click the selection, and on the shortcut menu, click Export. The Export 

Messages window appears.

Figure 6-5. MSG or TXT format can be exported

3. In the Format box, select MSG or TXT.
4. In the Export To box, specify the location for the exported messages.
5. Select the Maintain Message Path check box if you want to maintain the directory 

structure of the exported messages.
6. Click Export.
7. In the Export Progress window, verify your messages were successfully exported, and 

click Close. The messages appear in the specified location. In the illustration below, the 
exported messages come from the “User 1” mailbox. 

Figure 6-6. Messages appear in specified location

To export individual messages from the Find window

1. In the Find in Source or Find in Exchange Target window, select one or more messages 
from the message list. 

2. Right-click the selection, and on the shortcut menu, click Export.
3. Perform steps 3-7 in the preceding section.
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To export individual messages from the Source content analysis store profile folders

1. In the Source message pane, select a profile folder, then select one or more messages from 
the message list. 

2. Do one of the following:
• On the Tools menu, click Export.
• On the toolbar, click the Export icon .
• Right-click the selection, and on the shortcut menu, click Export. The Export 

Messages window appears.

Figure 6-7. MSG or TXT format can be exported

3. In the Format box, select MSG or TXT.
4. In the Export To box, specify the location for the exported messages.
5. Select the Maintain Message Path check box if you want to maintain the directory 

structure of the exported messages.
6. Click Export.
7. In the Export Progress window, verify your messages were successfully exported, and 

click Close.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Exporting to PST

The Export to PST option allows you to generate PST files for one or all users’ mailboxes from an 
off-line EDB file. Single Mailbox Recovery generates a single PST file for each user’s mailbox. If 
Outlook 2003 or greater is installed on your computer, you have the option of creating either 
Outlook 97-2002 style PST files or Outlook 2003 style PST files.

This feature is available with the following Source selections in the Source pane:

• EDB Source(s)—Export all mailboxes to PST files
• One mailbox within an EDB Source—Export EDB mailbox to PST files

Note:  EDB Sources that are a result of a search cannot be exported to PST.

Note:  Before exporting to PST, ensure that you have sufficient disk space available at the 
destination of the PST export.
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To export to PST

1. Highlight the item to export.
2. Do one of the following:

• Right-click and click Export
• On the toolbar, click the Export icon .
• On the Tools menu, click Export.

3. Select PST in the Format drop-down list.
4. Select the destination in Export To field.
5. Click Export. The Outlook Version window appears. 

Note:  If your system has Outlook 2003 or later installed, then Single Mailbox Recovery has 
the capability to create either Outlook 97-2002 or Outlook 2003 style PST files. If this is the 
case, you are presented with a window prompting you to select which style of PST you want 
to create. 

Figure 6-8. Select Outlook Version

6. Select the appropriate version of Outlook and click OK. The Export Progress window is 
displayed. 

7. After the export has completed, click Print to send to printer, Save to save a .txt report of 
the export to your local drive, or Close to close the window.

To use exported PST

1. Navigate to the location where the PST was created.
2. Drag and drop the PST into Single Mailbox Recovery in either the Source or the Target 

pane. The Select Source Files window appears.
3. Click OK. The PST now appears in the Target or Source directory.

Output

Note:  By default, the limit for a .pst file in Outlook 2003 and in Outlook 2007 is configured to be 
20 GB. As a result, exporting Outlook 2003 or Outlook 2007 .pst files larger than 20 GB is not 
supported.
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The PST files generated are named according to the mailbox name and placed in a folder named 
after the EDB. For example, if you wanted to export all the mailboxes from Priv1.edb (John Doe, 
Jane Doe, and User5), and you selected C:\PST as the “Export To:” folder, the exported folders and 
PST files would look like:

C:

PST

Priv1.edb

John Doe.pst

Jane Doe.pst

User5.pst

ALREADY EXISTING FILES

If any of the exported PST files already exist, Single Mailbox Recovery adds a number in 
parenthesis to the file name so that it does not conflict with an existing file. For example, if John 
Doe.pst already exists, then the exported PST for John Doe would be named “John Doe(1).pst.” If 
John Doe(1).pst also exists, then the exported PST would be named “John Doe(2).pst.”

Note:  There is a 2 GB limit for Outlook 97-2002 style PSTs. See “Limits for PST and Folder 
Targets” on page 220 for more information.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
About the Export Progress Window

Each time you attempt to export messages, the Export Progress window appears. This window 
displays the following information: 

• Source and Target
• Export start time
• Number of folders to export
• Number of messages to export
• Warnings or errors encountered during the export process. If an error occurs on a message, 

the message subject and Source path along with an error message will be displayed. If the 
message does not have a subject, the date (created) and message sender will be displayed 
instead.

• Total folders and messages successfully exported
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Figure 6-9. The export progress is shown

Note:  

• If an error occurs that Single Mailbox Recovery can recover from, such as a corruption that 
prevents it from getting a message property, Single Mailbox Recovery will log an error, stop 
processing that message, and continue.

• If an error occurs from which Single Mailbox Recovery cannot recover, such as a major 
corruption error, Single Mailbox Recovery will log an error to the Export Progress window 
and stop exporting.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Saving and Printing the Report

The contents of the export report can be saved by clicking Save. This brings up a Save File dialog 
box allowing you to select the location and name of the file. The default name of the report is 
“ExportProgress.txt.”

The export report can also be printed by clicking Print.
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RESTORING EXCHANGE DATA CHAPTER 7 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

This chapter describes how to restore Exchange data (an EDB file, a PST file, a mailbox, or a 
folder) to an Exchange server. The following topics are covered:

Quick look at restoring your Exchange data. The first part of this chapter provides you with 
a quick look at restoring your Exchange database, so you can begin to use Single Mailbox 
Recovery immediately.

Examples of restoring your Exchange data. The second part of this chapter provides 
examples of restoring messages, folders, mailboxes, and even an entire EDB file to the desired 
destination.

Note:  The concepts in this chapter apply to EDB, PST, and CAS files (unless otherwise noted), 
even though all of the examples of Sources are EDB files. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Quick Look at Restoring Your Exchange Data

Restoring data from a Source EDB, PST, or CAS file to a Target destination is a simple process. 
Just drag and drop or use the Copy and Paste/Paste Special commands. 

• “Restoring Your Exchange Data in Three Easy Steps” on page 219
• “Limits for PST and Folder Targets” on page 220
• “About Restoring Messages to an Exchange Server” on page 221
• “About the Copy Progress Window” on page 221
• “Creating, Renaming, and Deleting Folders in the Target Pane” on page 222
• “Copying and Pasting or Dragging and Dropping” on page 223

Restoring Your Exchange Data in Three Easy Steps

If you copy an EDB file, a PST file, a mailbox, or a folder from the Source pane and paste it to any 
Target destination, Single Mailbox Recovery will preserve the directory structure of all restored 
messages. When restoring individual messages, you must use the Paste Special command to 
preserve their directory structure. 
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To restore individual messages with Copy-Paste 

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, paste the messages into a folder.
3. In the Copy Progress window, verify that your messages were successfully copied, and 

click Close.

To restore individual messages with Copy-Paste Special 

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, use Paste Special to paste the messages into a folder, mailbox, PST root, 

or Exchange Server root.
3. In the Copy Progress window, verify that your messages were successfully copied, and 

click Close.

Tip:  Use the Paste Special command to retain the directory structure of messages copied from the 
Find in Source or Find in Exchange Target window, because messages in this window often come 
from several Source locations.

To restore a folder, a mailbox, an EDB file, a CAS file, or a PST file 

1. In the Source pane, copy a folder, a mailbox, an EDB file, a CAS file, or a PST file.
2. In the Target pane, paste the copied item into a folder, mailbox, PST root, or Exchange 

Server root.
3. In the Copy Progress window, verify that your messages were successfully copied, and 

click Close.

Note:  You cannot open the same PST as a Source and Target. In addition, you cannot 
restore messages from a PST file to an Exchange Server root node.

To restore data even faster, use drag-and-drop

• Example: To restore an entire EDB file, drag it to the Target Exchange Server root.

Limits for PST and Folder Targets

When restoring Exchange Data to a Target PST or folder, Outlook 97-2002 style PSTs have the 
following limits: 

2 GB PST Limit 

When a Target PST file reaches 1.8 GB, Single Mailbox Recovery creates a new PST for the 
additional messages. The new PST file has the same name as the original Target PST file, plus an 
appended number in parentheses: Personal Folders (1), Personal Folders (2), and so on. Single 
Mailbox Recovery creates the folder path in the new PST and continues to restore Exchange data 
where it left off.

Note:  The 1.8 GB limit applies only to PST files created by Microsoft Outlook 2002 and earlier. 
This limit does not apply to the new type of PST files created by Microsoft Outlook 2003/2007.
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16,383 Messages Per Folder (e.g., Inbox) Limit

When a Target folder (e.g., Inbox) reaches 16,383 messages, Single Mailbox Recovery creates a 
new PST folder for the additional messages. The new folder has the same name as the original 
Target folder plus an appended number in parentheses: Inbox (1), Inbox (2), and so on. Single 
Mailbox Recovery creates the folder path in the new folder and continues to restore Exchange data 
where it left off.

Note:  If you have upgraded the PST file to a large table format, the PST can hold 64,000 messages 
per folder. However, when a Target folder (e.g., Inbox) reaches 16,383 messages, Single Mailbox 
Recovery still creates a new PST folder for the additional messages.

To turn off the preference setting for the PST messages per folder limit

If you do not want Single Mailbox Recovery to create new folders when the number of messages 
reaches 16,383, do the following: 

1. On the Edit menu, click Preferences. 
2. In the Preferences window, click the Options tab, and then deselect the Create new PST 

folders when PST message/folder limits are reached check box.

Note:  If you turn off the preference, all messages above the messages per folder limit will fail to 
copy correctly, and the PST file may become corrupt.

About Restoring Messages to an Exchange Server

You must have sufficient access rights to all of the Exchange mailboxes you are trying to restore 
messages to. Keep in mind that you can connect to only one mailbox at a time. 

Restoring Messages to Exchange Server 2000/2003/2007

In Exchange Server 2000/2003/2007, the permission that controls whether or not any mailbox can 
be copied to is Full Mailbox Access. You must have Full Mailbox Access set to “Allow” in order to 
copy to a mailbox other than the one you logged in under.

Restoring Messages to Exchange Server 5.5

In Exchange Server 5.5, the account you are logged in under needs an Exchange Service Account 
Administrator rights or role. As long as you copy this role to your account, you can restore 
messages to any mailbox. 

About the Copy Progress Window

Each time you attempt to restore messages to the Target pane, the Copy Progress window appears. 
This window displays the following information about the copy operation: 

• Time of copy operation
• Number of messages, associated messages, and folders
• Errors, if any
• Mailboxes that Single Mailbox Recovery connected to or failed to connect to when copying 

to an Exchange Server
• Copy results
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Figure 7-1. Copy Progress Window

Important:  Viewing the copy results in Copy Progress window is especially important when 
attempting to restore multiple mailboxes to an Exchange Server root node. That is because Single 
Mailbox Recovery displays only one mailbox at a time in the Target pane; therefore, the only way 
you will know if all of the mailboxes were successfully copied to the Exchange Server will be to look 
at the copy results listed in this window. 

If you do not have full access rights to the mailboxes you are trying to restore messages to, Single 
Mailbox Recovery will be unable to connect to the mailboxes. For more information, see “About 
Restoring Messages to an Exchange Server” on page 221.

Creating, Renaming, and Deleting Folders in the Target Pane

The Target pane has folders in which you can place your restored messages. However, you may 
wish to create new folders for your messages. You can also rename or delete any folder in the 
Target pane.

To create a new folder in the Target pane

1. In the Target pane, select a folder, a PST root node, or an Exchange mailbox. 
2. Do one of the following:

• On the Edit menu, click New Folder.
• Right-click and on the shortcut menu, click New Folder.
• Press Ctrl+N.

3. In the Create New Mail Folder window, name the folder and click OK. A subfolder is 
created in the Target folder.

To rename a folder in the Target pane

1. In the Target pane, select a folder. 
2. Do one of the following:

• On the Edit menu, click Rename.
• Right-click and on the shortcut menu, click Rename.
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• Press Ctrl+R.
3. Type a new name for the folder.

Note:  You can also rename a PST root.

To delete a folder in the Target pane

1. In the Target pane, select a folder. 
2. Do one of the following:

• On the Edit menu, click Delete.
• Press the Delete key.

Copying and Pasting or Dragging and Dropping

In Single Mailbox Recovery, you can restore data to the Target pane by using Copy-Paste, Copy-
Paste Special, or Drag-and-Drop.

To copy an item in the Source pane or Find window

1. In the Source pane or Find in Source window, select messages, a folder, a mailbox, or the 
entire EDB file. 

Note:  In the Find in Source window, you can only select messages.

2. Do one of the following:
• On the Edit menu, click Copy.
• Right-click the selected item(s), and on the shortcut menu, click Copy.
• Click the Copy Mail Item icon  on the toolbar.
• Press Ctrl+C.

To paste an item in the Target pane

1. In the Target pane, select a folder, a mailbox, the PST root node, or the Exchange root node.
2. Do one of the following:

• On the Edit menu, click Paste.
• Right-click the selected item, and on the shortcut menu, click Paste or Paste Special. 

For more information on using the Paste Special command, see “Restoring Messages 
with Paste Special” on page 225.

• Click the Paste icon  on the toolbar.
• Press Ctrl+V (Paste) or Ctrl+Y (Paste Special).

To use drag-and-drop 

• Drag an item from the Source pane into a folder in the Target pane. Dragging and dropping 
achieves the same results as copying and pasting.

To use drag-and-drop when right-clicking a Source item

1. In the Source pane, select one or more messages.
2. Right-click the selected messages and drag them to a folder in the Target pane.
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3. When you let go of the mouse, a shortcut menu appears. On the shortcut menu, click Paste 
or Paste Special. For more information on using the Paste Special command, see 
“Restoring Messages with Paste Special” on page 225.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Examples of Restoring Your Exchange Data

This section provides examples of restoring messages, folders, mailboxes, and even an entire EDB 
file to the desired destination. In each case, it provides guidelines for restoring messages.

• “Restoring Messages with Copy-Paste” on page 224
• “Restoring Messages with Paste Special” on page 225
• “Restoring a Folder” on page 230
• “Restoring a Mailbox” on page 232
• “Restoring an EDB File” on page 233

Note:  The concepts in this chapter apply to both EDB and PST files (unless otherwise noted), even 
though all of the following examples are EDB files.

Restoring Messages with Copy-Paste 

The following instructions show you how to restore individual messages to a folder in a Target PST 
file or Exchange Server by using Copy-Paste. Keep in mind that using Drag-and-Drop achieves the 
same results.

Guidelines for Restoring Messages

• You can copy messages from the message list in the Source pane or the Find in Source 
window. 

• You can use Drag-and-Drop or Copy-Paste to restore individual messages to a folder in 
the Target pane. 

• You cannot use Drag-and-Drop or Copy-Paste to restore individual messages to a PST 
root node, an Exchange Server root node, or an Exchange mailbox. However, you can use 
Paste Special to restore individual messages to these locations.

• Using Drag-and-Drop or Copy-Paste to restore individual messages does not preserve the 
directory structure of the restored messages. If you want to preserve the directory structure 
of restored individual messages, use Paste Special. 

• You cannot copy-paste inaccessible mailboxes.

Tip:  For information on Paste Special, see “Restoring Messages with Paste Special” on 
page 225.

To restore messages with Copy-Paste

1. In the Source pane or Find in Source window, copy messages from the message list.
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Figure 7-2. The shortcut menu in the message pane reveals the Copy command

2. In the Target pane, paste the messages into a folder (e.g., Inbox) in the Target PST file or 
Exchange Server. 

3. In the Copy Progress window, verify that your messages were successfully copied. You can 
also print or save the copy report by doing one of the following.

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window. 

Results of Restoring Messages with Copy-Paste

All unduplicated messages appear in the Target folder.

Figure 7-3. Pasting messages into a folder (Inbox) in the Target pane

Restoring Messages with Paste Special

You can use the Paste Special command to preserve the directory structure of restored individual 
messages. The Paste Special command is especially useful when restoring messages from the 
message list in the Find window, since these messages often come from several Source locations.
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Guidelines for Restoring Messages with Paste Special 

• You can use the Paste Special command to restore individual messages to any Target 
destination. Using the Paste Special command preserves the directory structure of the 
restored messages. 

• You can use the Paste Special command to restore individual messages only. You cannot use 
the Paste Special command to restore an entire EDB file, a mailbox, or a folder. 

• You cannot use Paste Special to restore messages to a public folder.
• If the Target is a PST root node or folder, Single Mailbox Recovery creates a folder to 

represent each mailbox. Each mailbox is a subfolder of the folder the user selected for the 
Paste Special operation.

• If the Target is an Exchange Server mailbox or folder, Single Mailbox Recovery copies 
all messages to the Target. Each mailbox is a subfolder of the folder the user selected for the 
Paste Special operation.

• If the Target is an Exchange Server root node, the Paste Special code attempts to connect 
to each mailbox one at a time and copies each message to its corresponding mailbox and 
folder. If the folder does not exist, it will be created. If the mailbox does not exist, Single 
Mailbox Recovery logs an error in the copy results, skips the entire mailbox, and continues 
the Paste Special operation. 

Note:  You cannot restore messages from a PST file to an Exchange Server root node.

To restore messages to a PST root or folder with Paste Special

If the Target is a PST root node or folder, Single Mailbox Recovery creates a folder to represent 
each mailbox. Each mailbox is a subfolder of the folder you selected for the Paste Special 
operation.

1. In the Source pane or Find in Source window, copy messages from the message list.

In this example, messages from three different mailboxes (PC User 1, PC User 2, and PC 
User 3) are copied from the message list in the Find in Source window.

Figure 7-4. Copying messages from the Find in Source window

2. In the Target pane, use Paste Special to paste the messages into a PST root node or folder. 
3. In the Copy Progress window, verify that your messages were successfully copied. You can 

also print or save the copy report by doing one of the following.
• Click Print to print the copy report.
• Click Save to save the copy report as a text file.
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4. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window. 

Results of Restoring Messages to a PST Root Node or Folder with Paste Special 

All unduplicated messages appear in the Target destination, and their directory structure will be 
preserved. 

Figure 7-5. Using Paste Special on a Target

To restore messages to an Exchange Server mailbox or folder with Paste Special 

If the Target is an Exchange Server mailbox or folder, Single Mailbox Recovery copies all 
messages to the Target. Each mailbox is a subfolder of the folder you selected for the Paste Special 
operation.

1. In the Source pane or Find in Source window, copy messages from the message list.

In this example, messages from three different mailboxes (PC User 1, PC User 2, and PC 
User 3) are copied from the message list in the Find in Source window.

Figure 7-6. Copying messages from the Find in Source window

2. In the Target pane, use Paste Special to paste the messages into an Exchange mailbox or 
folder.

3. In the Copy Progress window, review your results to make sure all the messages were 
copied to the Target destination. You can also print or save the copy report by doing one of 
the following.
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• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window. 

Results of Restoring Messages to an Exchange Server Mailbox or Folder with Paste Special

Each mailbox is a subfolder of the Target destination, and all unduplicated messages are restored. 
In addition, their directory structure is preserved.

Figure 7-7. Using Paste Special on a Target Exchange mailbox

Figure 7-8. Results of using Paste Special on a Target Exchange mailbox

To restore messages to an Exchange Server root node with Paste Special 

If the Target is an Exchange Server root node, Single Mailbox Recovery attempts to connect to 
each mailbox one at a time and copies each message to its corresponding mailbox and folder. If the 
folder does not exist, it is created. If the mailbox does not exist, Single Mailbox Recovery logs an 
error in the Copy Progress window, skips the entire mailbox, and continues the Paste Special 
operation. 

Important:  The Source mailbox must exist on the Target Exchange Server, and you must have full 
mailbox access rights to all of the Exchange mailboxes to which you are trying to restore messages. 
For more information on access rights, see “About Restoring Messages to an Exchange Server” on 
page 221.
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1. Select one or more messages from the message list in the Find in Source window or the 
Source pane.

2. In the Source pane or Find in Source window, copy messages from the message list.

In this example, messages from three different mailboxes (PC User 1, PC User 2, and PC 
User 3) are copied from the message list in the Find in Source window.

Figure 7-9. Copying messages from the Find in Source window

3. In the Target pane, use Paste Special to paste the messages into an Exchange Server root 
node. 

4. In the Copy Progress window, verify your results to make sure that your messages from all 
mailboxes were copied to the Target destination. You can also print or save the copy report 
by doing one of the following:

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

5. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window. 

Results of Restoring Messages to an Exchange Server Root Node with Paste Special

All unduplicated messages are restored in each mailbox that Single Mailbox Recovery can connect 
to, and the directory structure of the messages is preserved. 

When attempting to restore multiple mailboxes to an Exchange Server root node, you must look at 
the Copy Progress window to verify that your messages from all mailboxes were successfully 
copied to the Exchange Server. That is because Single Mailbox Recovery displays only one 
mailbox at a time in the Target pane.
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Figure 7-10. The Copy Progress window reports that Single Mailbox Recovery was able to connect 
to all mailboxes and successfully copy all messages to Exchange Server.

Restoring a Folder 

The following instructions show you how to restore a folder to any Target destination by using 
Copy-Paste. Keep in mind that using Drag-and-Drop achieves the same results. 

Guidelines for Restoring a Folder

• You can use Drag-and-Drop or Copy-Paste to restore a folder to a Target PST root node or 
folder, or to an Exchange Server mailbox or folder. If the folder does not exist in the Target 
destination, it is created. 

• You cannot restore a folder to an Exchange Server root node.
• You cannot restore a private folder to a public folder. But you can restore messages from a 

private folder to a public folder.
• You cannot use the Paste Special command to restore a folder. You can use the Paste 

Special command to restore individual messages only.

To restore a folder

1. In the Source pane, copy a folder (e.g., Inbox).
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Figure 7-11. The shortcut menu reveals the Copy command

2. In the Target pane, paste the folder into a folder, mailbox, or PST root node.
3. In the Copy Progress window, verify your results to make sure that your messages from all 

mailboxes were copied to the Target destination. You can also print or save the copy report 
by doing one of the following.

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window. 

Results of Restoring a Folder

All unduplicated messages in the folder are restored and their directory structure is preserved. If the 
folder does not exist in the Target destination, it is created. 

Figure 7-12. Pasting a folder in a Target destination (e.g., Exchange mailbox)

Note:  No folder is created because the copied folder (Inbox) already exists in the Target Exchange 
mailbox.
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Restoring a Mailbox 

The following instructions show you how to restore a mailbox to any Target destination by using 
Copy-Paste. Keep in mind that using Drag-and-Drop achieves the same results. 

Guidelines for Restoring a Mailbox

• You can use Drag-and-Drop or Copy-Paste to restore a mailbox to a Target PST root node 
or folder, or to an Exchange Server root node, mailbox, or folder. 

• If you restore a mailbox to a Target PST root node: Messages from folders in the Source 
PST are restored to corresponding folders in the Target PST (e.g., messages from the Source 
Inbox are restored to the Target Inbox). If a corresponding folder does not exist in the Target 
destination, it is created. 

• If you restore a mailbox to a to a Target PST folder, or to an Exchange Server, 
mailbox, or folder: If the mailbox does not exist in the Target destination, a folder with its 
name is created. 

Important:  If you want to restore a mailbox to a Target Exchange Server root node, the 
Source mailbox must exist on the Target Exchange Server, and you must have full mailbox 
access rights to all of the Exchange mailboxes you are trying to restore messages to. For 
more information on access rights, see “About Restoring Messages to an Exchange Server” 
on page 221.

• You cannot restore a mailbox to a public folder. But you can restore messages from a 
mailbox to a public folder.

• You cannot use the Paste Special command to restore a mailbox. You can use the Paste 
Special command to restore individual messages only.

To restore a mailbox

1. In the Source pane, copy a mailbox (e.g., PC User 1).

Figure 7-13. The shortcut menu reveals the Copy command

2. In the Target pane, paste the mailbox into a folder, mailbox, PST root node, or Exchange 
Server root node.
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3. In the Copy Progress window, verify your results to make sure that your messages from all 
mailboxes were copied to the Target destination. You can also print or save the copy report 
by doing one of the following.

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window. 

Results of restoring a mailbox 

All unduplicated messages in a mailbox are restored and their directory structure is preserved. 

If the mailbox does not exist in the Target destination, a folder with its name is created. However, if 
you restore a mailbox to a Target PST root node, a mailbox is not created. Instead, messages from 
folders in the Source PST are restored to corresponding folders in the Target PST. 

Figure 7-14. Pasting a mailbox into a PST root node

Note:  A folder is created because the copied mailbox (PC User 1) does not exist in the target PST 
file.

Restoring an EDB File

The following instructions show you how to restore an entire EDB file to any Target destination 
with Copy-Paste. Keep in mind that using Drag-and-Drop achieves the same results. 

Guidelines for Restoring an EDB File

• It is recommended that you restore an EDB file to a Target Exchange Server root node. 
• You can use Drag-and-Drop or Copy-Paste to restore an entire EDB file. You cannot use 

the Paste Special command to restore an EDB file. You can use the Paste Special command 
to restore individual messages only.

Important:  If you restore an EDB file to a Target Exchange Server root node, the Source 
mailbox must exist on the Target Exchange Server, and you must have full mailbox access 
rights to all of the Exchange mailboxes to which you are trying to restore messages. For 
more information on access rights, see “About Restoring Messages to an Exchange Server” 
on page 221.
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To restore an EDB file

1. In the Source pane, select the EDB file.
2. On the Edit menu, click Copy.
3. In the Target pane, select the Exchange Server root node. 
4. On the Edit menu, click Paste.
5. In the Copy Progress window, review your results to make sure all the messages were 

copied to the Target destination. You can also print or save the copy report by doing one of 
the following.

• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

6. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window. 

Results of restoring an EDB file

Single Mailbox Recovery attempts to connect to each mailbox in the Target pane one at a time and 
copies each message to its corresponding mailbox and folder. If the folder does not exist, it will be 
created. If the mailbox does not exist, Single Mailbox Recovery logs an error in the Copy Progress 
window, skips the entire mailbox, and continues the operation.

Restoring to Public Folders

The following instructions show you how to restore messages or public folders to a public folder 
Target. An option to open public folders is available upon connection to an Exchange Server. 

Important:  Single Mailbox Recovery opens public folders and your mailbox when you connect to 
an Exchange Target. You will see those folders that you have permission to see. 

Guidelines for Restoring to Public Folders

• You can restore folders from a pub.edb database to a public folder Target. All public folder 
permissions are transferred to the Target folders. However, folder permissions may not 
transfer if the version of the Source Exchange Server is different than the version of the 
Target Exchange Server.

• You can restore messages from any database Source or search results to a public folder 
Target. 

• You cannot restore a folder or mailbox from a private database to a public folder Target. But 
you can restore messages in a folder or mailbox to a public folder.

• You cannot use Paste Special when restoring messages to a public folder Target.

Note:  The ability to restore to public folders is also available at the command line.

To restore messages to a Target Public Folders

1. In the Source pane or Find in Source window, copy messages from the message list.
2. In the Target pane, paste the messages into the Target root public folder or a folder in the 

public folder. 
3. In the Copy Progress window, verify that your messages were successfully copied. You can 

also print or save the copy report by doing one of the following.
• Click Print to print the copy report.
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• Click Save to save the copy report as a text file.
4. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 

window. 

To restore a folder from a public database to a Target Public Folders

1. In the Source pane copy a folder from a public database.
2. In the Target pane, paste the folder into the Target root public folder or a folder in the public 

folder. 
3. In the Copy Progress window, verify that your messages were successfully copied. You can 

also print or save the copy report by doing one of the following.
• Click Print to print the copy report.
• Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the Single Mailbox Recovery main 
window.

Results of Restoring to Public Folders

When you restore folders from a pub.edb database to a public folder Target, the following occurs: 

• All public folder permissions are transferred to the Target folders. However, folder 
permissions may not transfer if the version of the Source Exchange Server is different than 
the version of the Target Exchange Server.

• The Exchange user doing the restore will be added to all public folder permissions with 
owner rights.

• If you have IFS (also known as “M:drive”) enabled on your Exchange Server, permissions 
for child folders may be merged with permissions for parent folders.
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. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
USING THE COMMAND LINE CHAPTER 8 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

The command line feature allows you to easily batch repetitive processes such as multiple copy and 
export tasks without initiating the Single Mailbox Recovery user interface. This feature is 
extremely beneficial in Single Mailbox Recovery production environment implementations.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Command Line Syntax

The syntax is as follows:

<< >> Required for all operations

< > Required for copy/export operations

[ ] Optional

Command Line Syntax

smbr [Program Options] <<Operation>> [Operation options] <<Source Store>> [Source options] 
<Source Folder Path> <Target Store>  <Target Folder Path>

[Program Options]

-Server[=Address]

This program option provides control of the choice of Single Mailbox Recovery Administrative 
Server. Without an address the switch forces the display of the Single Mailbox Recovery 
Administrative Server Connection Point Manager dialog box. This dialog box allows you to use a 
server different from the server advertised in the Active Directory.  Without an address this option 
is only valid when running in GUI mode.

Address:

(address=<address>);(port=<port>) - forces a connection attempt at the specified address and port. 
For example: "-server=(address=<192.168.0.2>);(port=<49152>)" forces a connection to a server 
running on IP address 192.168.0.2 on port 49152.

<Operation>

-Copy

-Export
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-List (report information about the database)

-Integ (Integrity Check)

-h (help)

[Operation options]+

-f <format> 

format:

msg - messages will be exported as .msg (.msg is the default)

:txt - message will be exported as .txt

:pst - messages will be exported to a PST

-p <format>

:97 - create a 97-2002 style PST for export/copy

:2003 - create a 2003 style PST for export/copy

-r

export/copy subfolders

-o <filename>

name of file to output progress information to default is CON

Note:  If the file exists, Single Mailbox Recovery will append to the output progress file. If the file 
does not exist, Single Mailbox Recovery will create it.

-da  <mm/dd/yyyy>

Process messages dated on or after this date

-db <mm/dd/yyyy >

Process message dated on or before this date

-v <verbose>

<Source Store>

Full path of EDB file, CAS file, or PST file

[Source options]

-l <Log file path>

-t <Temp file path>

< Source Folder Path >

full path, including mailbox to the Source folder, or profile folder to be copied/exported or 
$ROOT for root datastore folder

<Target Store>

ServerName;mailbox or Full path of PST 

Ex. Pcpdc;jJones
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Pcpdc;hJohnson

C:\archive.pst

Note:  The Target Store is not needed for export.

[Target options]

-pub public folders

<Target Folder Path>

Full path, including mailbox to the Target folder to be copied/exported to or $ROOT for root 
datastore folder

Note:  Only message containers (i.e., mailboxes, folders, entire EDB) can be selected for 
copy/export. All messages contained are copied/exported. Individual messages can not be selected 
from the command line. 
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Command Line Parameters

Parameter Description 
<Operation> — required for all operations 
-Copy 
-Export 
-List Report information about the database 
-Integ Database integrity check  
-h Help 
[Operation options] 
-f :msg Messages will be exported as .msg (the default) 
-f :txt Messages will be exported as .txt 
-r Export/copy subfolders 
-o <filename> Name of file to output progress information to default is CON 

NOTE: If the file exists, Single Mailbox Recovery appends to 
the output progress file. If the file does not exist, Single 
Mailbox Recovery creates it. 

-da <dd/mm/yyyy> Process messages dated on or after this date 
-db <dd/mm/yyyy> Process messages dated on or before this date 
-v Verbose 
<Source Store> — required for all operations 
Full path of EDB file or PST file 
[Source options] 
-l <Log file path> 

-t <Temp file path> 

<Source Folder Path> — required for copy and export operations 
full path, including mailbox to the 
source, folder to be copied/exported or 
$ROOT for root datastore folder 
<Target Store> 
ServerName;mailbox or Full path of 
PST 

Examples. Pcpdc;jJones, Pcpdc;hJohnson, C:\archive.pst 
NOTE: The Target Store is not needed for export. 

[Target Options] 
-pub public folders 
<Target Folder Path> — required for copy and export operations 
Full path, including mailbox, to the 
target folder to be copied/exported to or 
$ROOT for root datastore folder 

NOTE: Only message containers (i.e., mailboxes, folders, 
entire EDB) can be selected for copy/export. All messages 
contained will be copied/exported. Individual messages can not 
be selected from the command line. 
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Examples of Using the Command Line

The following examples are for copy, export, and list (i.e., report information about the database).

Example 1: Copy pcuser1’s Inbox and all subfolders from c:\pcdata.edb to the Inbox in 
c:\target.pst. c:\out1.txt will contain the copy report.

smbr -copy -r -o c:\out1.txt c:\pcdata.edb –l c:\edb -t c:\edb pcuser1\inbox c:\target.pst 
$ROOT

Example 2: Copy pcuser1’s Inbox and all subfolders from c:\pcdata.edb to user1’s Inbox on 
Exchange Server pcpdc. c:\out1.txt will contain the copy report.

smbr -copy   -r   -o c:\out2.txt   c:\pcdata.edb   -t c:\   pcuser1\inbox   pcpdc;user1   inbox

<Operation> Explanation

-copy Perform a copy operation

[Operation options] Explanation

-r copy subfolders

-o c:\out1.txt output report file name

<Source Store> Explanation

c:\p cdata.edb path to the database file name

[Source options] Explanation

-t c:\edb temporary file path

<Source Folder Path> Explanation

pcuser1\inbox source folder to copy

<Target Store> Explanation

c:\target.pst target data store

<Target Folder Path> Explanation

$ROOT copy to the root folder of the data store

<Operation> Explanation

-copy perform a copy operation

[Operation options] Explanation

-r copy subfolders

-o c:\out2.txt output report file name

<Source Store> Explanation
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Example 3: Export pcuser1’s mailbox and all subfolders from pcdata.edb as text to c:\export 

smbr -export   -r   -f:txt   -o   c:\out3.txt   c:\pcdata.edb   -t c:\    pcuser1   c:\export

Example 4: Provides information on the databases including a list of mailboxes.

c:\p cdata.edb path to the database file name

[Source options] Explanation

-t c:\ temporary file path

<Source Folder Path> Explanation

pcuser1\inbox source folder to copy

<Target Store> Explanation

pcpdc;user1 target data store (Exchange Server name and 
logon ID)

<Target Folder Path> Explanation

inbox copy to the inbox

<Operation> Explanation

-export perform an export operation

[Operation options] Explanation

-r export subfolders

-f:txt messages will be exported as .txt

-o c:\out3.txt export report file name

<Source Store> Explanation

c:\p cdata.edb path to the database file name

[Source options] Explanation

-t c:\ temporary file path

<Source Folder Path> Explanation

pcuser1 source folder to copy

<Target Store> Explanation

NA target data store

<Target Folder Path> Explanation

c:\export Root folder of the export

<Operation> Explanation
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Tip:  When performing the -list operation, use the -o filename option in order to see the mailboxes. 
Otherwise, the operation will proceed so fast that you won’t be able to see the mailboxes.

smbr -list -o c:\mblist.txt c:\priv1.edb

Example 5: Perform an integrity check on and entire EDB.

smbr -integ -r -o c:\output.txt c:\priv1.edb $ROOT

Example 6: Copy a folder from a pub EDB to public folders (only copy messages dated after 
01/01/2000)

smbr -copy -r -o c:\out2.txt -da 01/01/2000 c:\pub1.edb newsgroups 
"pcvx2000;administrator" -pub $ROOT

<Operation> Explanation

-list perform a list operation

[Operation options] Explanation

-o c:\mblist.txt output report file name

<Source Store> Explanation

c:\priv1.edb path to the database file name

<Operation> Explanation

-integ Perform an integrity check on a database

[Operation options] Explanation

-o c:\\output.txt output report file name

<Source Store> Explanation

c:\priv1.edb path to the database file name

<Source Folder Path> Explanation

$ROOT Root of the EDB (entire EDB)

<Operation> Explanation

-copy perform a copy operation

[Operation options] Explanation

-r copy subfolders

-o c:\out2.txt output report file name

-da 01/01/2000 Only copy messages that were created after 
this date
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Important:  

• All paths with spaces need to be in quotes.
• If a PST does not exist in the Target, Single Mailbox Recovery will create a PST file 

compatible with Outlook 97, 98, 2000, and XP.

<Source Store> Explanation

c:\pub1.edb path to the database file name

<Source Folder Path> Explanation

newsgroups source folder to copy

<Target Store> Explanation

"pcvx2000;administrator" target data store (Exchange Server name and 
logon ID)

<Target Options> Explanation

-pub Copy to public folders

<Target Folder Path> Explanation

$ROOT Public folders root

<Operation> Explanation
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Example 7: Perform an integrity check on an entire Content Analysis Store.

smbr -integ -r -o "c:\out1.txt" "c:\source.cas" $ROOT

Example 8: Copy Profile1 from c:\source.cas to the root in c:\target.pst.

smbr -copy -r -o c:\out2.txt c:\source.cas "Profile1" c:\target.pst $ROOT

<Operation> Explanation

-integ Perform an integrity check on a database

[Operation options] Explanation

-r check subfolders

-o "c:\out1.txt" output report file name

<Source Store> Explanation

"c:\source.cas" Path to the Content Analysis Store file name

<Source Folder Path> Explanation

$ROOT Root of the CAS (entire CAS)

<Operation> Explanation

-copy perform a copy operation

[Operation options] Explanation

-r copy subfolders

-o c:\out2.txt output report file name

<Source Store> Explanation

c:\source.cas path to the Content Analysis Store file name

<Source Folder Path> Explanation

"Profile1" source folder to copy

<Target Store> Explanation

c:\target.pst target data store 

<Target Folder Path> Explanation

$ROOT copy to the root folder of the data store
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Example 9: Export Profile2 from source.cas as text to c:\export

smbr -export -r -f:txt -o c:\out3.txt c:\source.cas "Profile2" c:\export

<Operation> Explanation

-export perform a export operation

[Operation options] Explanation

-r export subfolders

-f:txt messages will be exported as .txt

-o c:\out3.txt export report file name

<Source Store> Explanation

c:\source.cas path to the Content Analysis Store file name

<Source Folder Path> Explanation

"Profile2" source folder to copy

<Target Store> Explanation

NA target data store

<Target Folder Path> Explanation

c:\export Root folder of the export
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

This section shows you how to create reports, view the statistics in the generated reports, and save 
the reports as either tab-delimited or comma-delimited text files. Any data store opened as a Source 
can be the Source of a report.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Creating Reports

You can generate reports on an EDB, PST, or CAS Source data store in Single Mailbox Recovery. 
The reports contain statistics about the data store such as sizes and counts for attachments and 
messages, and may be generated per attachment type, domain, mailbox, database, and date. The 
Mailbox and Date reports are available for Priv EDB data Sources only.

Note:  Only accessible mailboxes can generate a report.

To create one or more reports

1. In the Source pane, select an EDB, PST, or CAS data Source.
2. On the Tools menu, click Create Reports. The Create Reports window appears. 

• If you selected a Priv EDB as the Source for the report, the list pane displays all 
mailboxes in the EDB. 

• If you selected a PST or Pub EDB as the Source, the list pane displays all folders 
immediately under the root of the PST or Pub EDB.
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Figure 9-1. The Create Reports window

Figure 9-2. The Create Reports window for a CAS

3. Do one of the following:
• For Priv EDB: Under Mailboxes, select the mailboxes to be included in the report(s). 

All mailboxes are selected by default.
• For Pub EDB or PST: Under Folders, select the folders to be included in the report(s). 

All folders are selected by default.
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• For CAS: Under Profile Folders, select the folders to be included in the report(s). All 
folders are selected by default.

4. Under Reports, select one or more reports that you would like to create:
• Attachment Statistics
• Domain Statistics
• Messages by Database
• Messages by Profile Folder: This report is available for CAS data Sources only.
• Messages by Mailbox: This report is available for Priv EDB data Sources only.
• Messages by Date: If you select this report, then specify the appropriate options for 

received date range and date unit (e.g., hour, day, week, month). This report is available 
for Priv EDB and CAS data Sources only.

5. Under Message Options, select the appropriate deleted item retention option(s). Both 
options are selected by default. For PST Sources, the first option is deselected. You cannot 
modify the default options for PST Sources.

• Include messages in deleted item retention: Select this option to include messages in 
deleted item retention.

• Include messages not in deleted item retention: Select this option to include 
messages that are not in deleted item retention. In most cases, this option represents 
most of the messages in the Source data store.

6. Click Generate Reports. The Reports window appears. For more information the contents 
of the reports, see “Viewing Reports” on page 250.
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Viewing Reports

The Reports window shows the progress of the report generation and also shows the reports 
themselves. This window consists of a tabbed view of the reports, with each tab containing a single 
report. For information on the statistics provided in each report, see the following sections. 

Figure 9-3. The Reports progress window

Single Instance Storage (SIS) vs. Cumulative Counts

The Attachment Statistics and Messages by Database reports use the terms “SIS” (Single Instance 
Storage) and “Cumulative” when referring to the number and size of attachments in the data store. 
The term “SIS” counts attachments only once and does not include their duplicates. The term 
“cumulative” refers to all of the attachments or messages, including their duplicates. 

Example: An attachment of type .DOC of size 100 KB is being shared by three messages. As the 
table shows, the SIS size more closely estimates how much of the EDB size is attributed to the 
attachment. 

The cumulative size more closely estimates how much of the EDB size is attributed to attachments 
if the data store did not have SIS.

Method of Counting 
Attachments/Messages

Total # of .DOC 
Attachments Total Size of .DOC Files

SIS Count 1 100 KB

Cumulative Count 3 300 KB
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Attachment Statistics Report

The Attachment Statistics report provides statistics on all of the attachments contained in messages 
in the selected Source. The attachments are categorized by extension, which appears in upper case 
letters (e.g., .DOC, .XLS). Attachments without extensions are put into a separate row called “No 
Extension.”

Domain Statistics Report

The Domain Statistics report provides statistics on messages grouped by the domain from which 
the messages were sent. 

The domain is determined using the PR_SENDER_ADDRTYPE in combination with the 
PR_SENDER_EMAIL_ADDRESS as follows:

• If PR_SENDER_ADDRTYPE is “EX” or “SYSTEM,” then it is an Exchange message and 
the domain is “internal.”

• If PR_SENDER_ADDRTYPE is “SMTP”, then the domain is whatever follows the @ in 
the PR_SENDER_EMAIL_ADDRESS property. 

• If PR_SENDER_ADDRTYPE is something else, then the domain is “unknown.”

Column Heading Description

Attachment Extension Attachment type by extension (e.g., .DOC, .PPT, .PDF).

Cumulative Number of 
Attachments Found in 
Messages

Cumulative number of attachments of each type found in the 
processed messages.

Cumulative Size of 
Attachments

Cumulative size of attachments of each type found in 
messages.

Average Attachment Size Cumulative size of attachments of each type divided by the 
cumulative number of attachments found in messages.

Percent of Total by Number Number of attachments of each type divided by total 
attachments of all types.

Percent of Total by Size Total size of attachments of each type divided by the total size 
of attachments of all types.

SIS Number of Attachments SIS number of attachments of each type. NA for PST Sources.

SIS Size of Attachments SIS size of attachments of each type. NA for PST Sources.

SIS Percent of Total by Size SIS size of attachments of each type divided by SIS size of 
attachments of all types in attachment table. NA for PST 
Sources.
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Messages by Database Report

The Messages by Database report provides statistics on the database that contains the processed 
messages. In the current version of Single Mailbox Recovery, reports are limited to a single EDB or 
PST, which means the database report has only one row of information. For example, the database 
report for Priv1.edb has one row of information listing all message statistics for Priv1.edb and its 
mailboxes.

Important:  The statistics in the Database report refer only to the mailboxes (for a Priv EDB) or 
the folders (for a PST, Pub EDB, or CAS profile folders) you selected in the Create Reports 
window. The statistics also depend on the options you specified in the Message Options area. In 
other words, unless all mailboxes/folders are selected, the Database report does not provide 
statistics for the entire database.

Column Heading Description

Domain The name of the domain (e.g., netapp.com) from which 
the message was sent. All messages whose domain cannot 
be determined are placed into an “unknown” domain. All 
Exchange messages are placed into an “internal” domain.

Number of Messages Total count of messages that were received from each 
domain.

Total Size of Messages Total size of all messages that were received from each 
domain.

Percent of Total by Number Number of messages from each domain divided by the 
total number of messages from all domains.

Percent of Total by Size Total size of messages from each domain divided by the 
total size of messages from all domains.

Column Heading Description

Database (EDB, PST, or CAS) The database name (e.g., Priv1.edb, Pub1.edb, Outlook 
XP.pst, User1.cas).

Cumulative Number of Messages Cumulative number of messages.

Cumulative Size of Messages Cumulative size of all messages processed.

Average Size of Messages Cumulative size of messages divided by cumulative 
number of messages.

Cumulative Size of Attachments Cumulative size of attachments in all messages 
processed.

SIS Size of Attachments SIS total size of attachments. This column applies only to 
EDB Sources. For PST and CAS data stores, this column 
is NA.
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Figure 9-4. The Create Reports window for a Priv EDB Source

Messages by Mailbox Report

The Messages by Mailbox report provides message statistics for all selected mailboxes in a Priv 
EDB data store. 

Note:  This report is available only for a Priv EDB.

Column Heading Description

Mailbox Name of the mailbox: Display name (alias)

Number of Messages Total number of messages in the mailbox.

Total Size of Messages Total size of all messages in the mailbox.

Average Size of Messages Total size of messages divided by number of messages.

Total Attachment Size Total size of attachments in all messages in this mailbox. 
Attachments in messages in this mailbox that are also in 
messages in another mailbox are counted in both 
mailboxes.

Shared Attachment Size Size of attachments that are found more than once, either 
multiple times in this mailbox or in this mailbox and other 
mailboxes. Calculated as total size of attachments minus 
the non-shared attachment size.
253



R E P O R T I N G
Viewing ReportsCHAPTER 9
Note:  For a definition of “received message,” see the “Glossary” on page 293.

Messages by Date Report

The Messages by Date report provides statistics for messages in a date range, such as 1/1/2004 to 
1/1/2005, and a unit of hours, days, weeks, or months. The report is keyed off of the received date 
of the message.

Note:  This report is available only for a Priv EDB and CAS files.

Note:  For a definition of “received message,” see the “Glossary” on page 293.

Non-shared Attachment 
Size

Size of attachments that are not shared with other 
messages.

Internal Received Messages Received messages of type “EX” or “SYSTEM.”

SMTP Received Messages Received messages of type “SMTP.”

Other Received Messages Received messages not of type “EX,” “SMTP,” or 
“SYSTEM.”

Column Heading Description

Hour/Day/Week/Month The date unit that was selected in the Create Reports 
window. Examples are:

Hour: “12/25/2004 - 9 PM”
Day: “12/25/2004”
Week: “12/26/2004 - 1/1/2005” (Weeks start on 
Sunday and end on Saturday.)
Month: “12/2004”

Internal Received Messages Received messages of type “EX” or “SYSTEM.”

Total Size of Internal 
Received Messages

The sum of the internal received message sizes.

SMTP Received Messages Received messages of type “SMTP.”

Total Size of SMTP 
Received Messages

The sum of the SMTP received message sizes.

Other Received Messages Received messages not of type “EX,” “SMTP,” or 
“SYSTEM.”

Total Size of Other 
Received Messages

The sum of the other received message sizes.

Column Heading Description
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Messages by Profile Folder

The Messages by Profile Folder report provides statistics for messages in a profile folder, the 
number of messages, total size of messages, average size of messages, total attachment size, shared 
attachment size, non-shared attachment size, internal received messages, SMTP received messages, 
and other received messages. The report is keyed off of the profile folder.

Note:  The Messages by Profile Folder report only includes information gathered from accessible 
mailboxes.

Note:  This report is available only for a CAS.

Note:  For a definition of “received message,” see the “Glossary” on page 293.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Sorting Reports

The Attachment Statistics and Messages by Database reports use the terms “SIS” (Single Instance 
Storage) and “Cumulative” when referring to the number and size of attachments in the data store. 
The term “SIS” counts attachments only once and does not include their duplicates. The term 
“cumulative” refers to all of the attachments or messages, including their duplicates.  

Column Heading Description

Profile Folder Title of the profile folder.

Number of Messages Total number of messages in the profile folder.

Total Size of Messages Total size of all messages in the profile folder.

Average Size of Messages Total size of messages in the profile folder divided by 
number of messages.

Total Attachment Size Total size of attachments in all messages in the profile 
folder.

Shared Attachment Size Size of attachments that are found more than once, either 
multiple times in this profile folder or in this profile 
folder and other profile folders.

Non-shared Attachment 
Size

Size of attachments that are not shared with other 
messages.

Internal Received Messages Received messages of type “EX” or “SYSTEM.”

SMTP Received Messages Received message of type “SMTP.”

Other Received Messages Received messages not of type “EX,” “SMTP,” or 
“SYSTEM.”
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Example: An attachment of type .DOC of size 100 KB is being shared by three messages. As the 
table shows, the SIS size more closely estimates how much of the EDB size is attributed to the 
attachment. The cumulative size more closely estimates how much of the EDB size is attributed to 
attachments if the data store did not have SIS. 

To sort the statistics in a report

1. Click a column heading to sort the statistics based on that heading. An arrow appears 
indicating the sort direction. An up arrow indicates the statistics appear in ascending (A-Z) 
order. A down arrow indicates that the statistics appear in descending (Z-A) order.

2. To reverse the order of the statistics based on that column heading, click the column 
heading again. The arrow reverses directions.

An Example of Sorting

The Attachment Statistics report is originally sorted based on the ascending order of attachment 
extensions (e.g., .DOC precedes .TXT). If you click the Attachment Extension heading, the down 
arrow appears and statistics are sorted in descending order (e.g., .TXT precedes .DOC). 

If you click the “Number of Attachments Found in Messages” column heading, the up arrow 
appears and statistics are sorted based on ascending order. This means that the attachment extension 
occurring least frequently in the data Source appears first in the report. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Saving Reports

You may save the currently active report as either a tab-separated or comma-separated text file. The 
report name defaults to the name shown on the report tab, without the spaces and with a .txt 
extension (e.g., MailboxReport.txt). The file type defaults to a tab-separated text file.

To save a report

1. In the Reports window, make the desired report active by clicking its tab (e.g., Attachment 
Report, Database Report).

2. Click Save.
3. In the Save Report window, specify the name, location, and file type for the report. You 

may save the report as either a tab-separated or comma-separated text file.
4. Click Save to return to the Reports window.
5. Repeat steps 1-4 for each report you want to save.

Method of Counting 
Attachments/Messages

Total # of .DOC 
Attachments Total Size of .DOC Files

SIS Count 1 100 KB

Cumulative Count 3 300 KB
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Overview

The content analysis store (CAS) enables you to automate and save search results by selecting 
Sources. Sources include entire EDB files, individual mailboxes from an EDB, or folders from an 
EDB. Any number of Sources is allowed, including multiple EDBs. 

After selecting specific Sources, you can create profile folders as subfolders to the content analysis 
store. Each profile folder has the same criteria as the search criteria, such as, “From,” “To,” 
“Subject,” etc. Only messages matching the criteria are contained in the profile. Multiple profile 
folders are possible. Every profile folder processes simultaneously. This allows you to make many 
separate searches (profiles) for the same set of Sources.

After the processing is complete, you can open the content analysis store as a Source. This allows 
you to use the CAS for searching, copying, exporting, and integrity checks. It allows you to copy 
the data out of the CAS into PSTs or to an Exchange Server. It allows you to repeatedly use a 
specific set of profile results without having to rerun the profile processing. The results of the 
profile can be saved between sessions using the CAS. You can also save the CAS on one computer 
and reopen it on a different computer to share the results of a profile.

Content analysis stores provide a method for an email administrator to perform content analysis 
offline from their production server. This feature:

• Minimizes the time it takes to detect/filter out emails that include specific content. 
• Minimizes the time it takes to detect/filter out a specific type of email file that is being sent 

or received (e.g., specific extension, subject, date).
• Analyzes the number of emails being sent/received that contain what could be legally 

damaging content (e.g., admission of guilt). 
• Analyzes the number of emails being sent/received that contain politically incorrect content 

(e.g., tasteless jokes, pornography). 
• Analyzes the number of emails with confidential content that go out unprotected - 

unencrypted. 
• Minimizes the time it takes to determine if someone is using the system for unauthorized 

activity (e.g., spamming, inappropriate downloads, starting a business).        
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Creating a Content Analysis Store

A new content analysis store can be created from the File menu, from the toolbar, or from the Data 
Wizard. After the CAS file is created, a new content analysis store shows in the Target pane. 

To create a content analysis store using the toolbar

1. On the toolbar, click the Create/Open Target Content Analysis Store icon  located on 
the toolbar. The Opening a Content Analysis File window appears.

Figure 10-1. The Opening a Content Analysis File window

2. Enter a File name and in the Look in box, select a destination.
3. Click Open. The name of the store defaults to the file name you entered in step 2. It can be 

renamed as any other Target folder.

To open or create a Target Content Analysis Store using the menu

1. To display the Opening a Content Analysis File window, on the File menu, point to Open 
Target Content Analysis Store and click Open Existing or Create New. 

Figure 10-2. The File menu leads to the Open Target Content Analysis Store and Open 
Existing or Create New commands
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Figure 10-3. The Opening a Content Analysis File window

2. If creating a new Target CAS, enter a File name and click Open.
3. If opening an existing Target CAS, select the CAS from the list and click Open.

To open or create a Target Content Analysis Store using the Data Wizard

1. On the File menu, click Use Wizard. The Data Wizard appears.
2. Click Next. The Source Path Selection page opens.

Figure 10-4. Selecting a CAS file in the Source Path Selection

3. In the Source File box, click Browse to find the Source EDB you wish to search. If you do 
not want to open a Source EDB file at this time, click Skip.

4. Click Next. The Target Type & Path Selection page of the Data Wizard appears.
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Figure 10-5. The Target Type & Path Selection window

5. Select Content Analysis Store.

Figure 10-6. Select the Content Analysis Store option

6. Do one of the following:
• If you know the Target CAS file path, type it in the Content Analysis Store Path box.
• Click Browse to open the Create Content Analysis Store window, and navigate to the 

desired location. Then create a new CAS file by typing a name in the File name box, or 
select an existing CAS file. Then click Open. The path of the Target CAS file appears 
in the Content Analysis Store Path box.

7. Click Next. The Completing the Data Wizard  page of the Data Wizard appears.
8. Click Finish.

Important:  For more details, see “Running the Data Wizard” on page 160.

Creating and Processing Content Analysis Store Profile Folders

A content analysis store profile folder is created as a subfolder of the content analysis store to filter 
EDB messages (only) based on the profile criteria.

When the profile folder is created, a folder appears under the content analysis store and Single 
Mailbox Recovery searches all the Sources in the content analysis store for messages that match the 
criteria for the profile folder. 
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During processing (searching), the profile folder is green and its status will indicate that processing 
is taking place. The status bar at the lower left also indicates the status. The message pane on the 
right populates with the results when the profile folder is selected or when the screen is refreshed.

Deduplication can be performed on a per profile basis and if selected does not return duplicates of a 
message during a search. For example, if the same message exists in two or more data stores, only 
the first message found is listed in the search results. Selecting this option may result in slower 
search performance.

Note:  Only accessible mailboxes in the EDB Source can populate the CAS Target profile with 
messages.

To create and process a content analysis store profile folder

1. Select a Target content analysis store root.
2. In the Profile menu on the menu bar, click Create Profile. The Create Profile window 

opens with “Profile1” as the default Profile Name. Once created, the content analysis store 
profile folder can be renamed just as any folder would be. 

3. Enter the criteria for the content analysis. This window offers similar search options as the 
Find window. For more information, see “Finding Messages” on page 195.

Note:  The profile criteria can be saved and imported. 

Figure 10-7. The Create Profile Folder window is used to enter profile criteria

4. Click OK. Single Mailbox Recovery indicates that a profile is processing when the color of 
the profile folder is green and its status states “Processing.” When the profile is selected, the 
status shown in the status bar at the lower left of the main window indicates that the profile 
is processing. For more information, see “Profile Processing Statuses” on page 263.

5. When the processing for a profile is complete, the color of the profile icon changes from 
green to blue and its status states “Completed.” All messages from the content analysis store 
EDBs that match the criteria are contained in the profile folder. 
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Note:  A content analysis store cannot be opened as a Source until all profile processing has 
completed.

Figure 10-8. Messages displayed after profile folder created

Note:  If the same Source is added to the content analysis store twice for processing, Single 
Mailbox Recovery ignores the second copy. The Source is not listed twice nor is an error 
message displayed.

DB # COLUMN

The content analysis store profile folder message views include a column to display a database 
number to enable you to trace back to the actual database in the content analysis store. This number 
does not correlate to the profile folder number or Source #, i.e., “Profile1” or “Source 1” does not 
necessarily correlate with DB #1. The correlation is between the profile folder message and the 
Source database.
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Example:

Figure 10-9. The Database numbers are tied to the actual database.

Note:  Database (DB) numbers are tied to the actual database, not the folder so each folder from 
the same EDB will have the same DB number. DB numbers increment from 1 for each different 
database added to the content analysis store, not for each folder.

PROFILE PROCESSING STATUSES

When the profile is processing, there are four possible statuses that are displayed: Processing, 
Suspended, Completed, and Completed with errors.

Figure 10-10. Profile Processing Status folders are indicated by different colors

Processing

After entering the profile criteria, the profile is created and is represented by a folder under the 
content analysis store. During processing (searching), the profile folder is green and its status states 
“Processing.” Selecting the profile folder or pressing F5 populates the message pane with messages 
when the processing is complete.

Processing occurs when a new profile is created, when removing a Source, when adding a Source, 
when editing a profile, when copying a Source profile folder to a Target content analysis store, or 
when resuming a suspended profile.
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Note:  If unrecoverable errors are encountered during processing then the profile is not fully 
processed and is blue in color with a red ! indicating the error.

Suspended

Processing can be suspended (see “Suspending and Resuming Content Analysis Store Profile 
Folders” on page 265) on any profile folder during processing. Suspended profile folders are red in 
color. The status also indicates that the profile is suspended.

Completed

Once the processing is complete, the profile folder turns blue and its status states “Completed.”

Completed with errors

If Single Mailbox Recovery detects corruption or some other issues while processing, the profile 
folder status states “Completed with errors.” To obtain details on the error, view the Properties on 
the profile folder by right-clicking on the profile folder and selecting Properties.

Figure 10-11. An error message displays when processing cannot be completed

SAVING AND IMPORTING PROFILE CRITERIA

Profile criteria can be saved and later imported into a new profile in the Create Profile window to 
save time.

To save a profile criteria

1. On the File menu, click Save Criteria.

Figure 10-12. The File menu leads to the Save Criteria command

2. In the Save As window, enter a File name and click Save. Be sure to note where the criteria 
file is being saved in the Look in: box.
264



. .
 . 

. .C O N T E N T  A N A L Y S I S  ST O R E
Creating a Content Analysis Store
Note:  The profile folder name is not saved.

To import saved profile criteria

1. On the File menu, click Use Previous Criteria.

Figure 10-13. The File menu leads to the Use Previous Criteria command

2. In the Open window, select the previously saved profile criteria .txt file.

Figure 10-14. The Open window allows you to select previous saved criteria to use in a new 
profile

3. Click Open. All previously saved profile criteria, except for the Profile Name, reads from 
the file and is placed into the Create Profile fields.

4. Enter a new Profile Name.

Note:  Search criteria from previous and current versions of Single Mailbox Recovery can 
be imported into Single Mailbox Recovery 5.0 for find and profile criteria.

Suspending and Resuming Content Analysis Store Profile Folders

You can pause the processing of one or more profile criteria folders and then resume processing at 
a later time. Suspended profile folders are red in color and then turn to green when processing is 
resumed. The folder then turns to blue when processing is complete. For more information, see 
“Profile Processing Statuses” on page 263.

Important:  Processing of all profiles is suspended automatically if you exit Single Mailbox 
Recovery or if you close the content analysis store before processing is complete. 
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To suspend the processing on profiles

1. Do one of the following:
• Select the profile folder, click the Profile menu and click Suspend Processing. 
• Right-click the profile folder and click Suspend Processing. 

Figure 10-15. The shortcut menu that leads to the Suspend Processing option from the 
Profile Folder

To suspend processing on all profiles

1. Do one of the following:
• Select the content analysis store root, click the Profile menu and click Suspend 

Processing. 
• Right-click the content analysis store root and click Suspend Processing. 

Figure 10-16. The shortcut menu that leads to the Suspend Processing option from the CAS 
root

Note:  Suspended profiles are red in color. The status also indicates that the profile is 
suspended.

To resume processing on profiles

1. Do one of the following:
• Select a profile folder, click the Profile menu and click Resume Processing. 
• Right-click the profile folder and click Resume Processing.
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To resume processing of all profiles

1. Do one of the following:
• Select the content analysis store root, click the Profile menu and click Resume 

Processing. 
• Right-click the profile folder and click Resume Processing. 

Adding Sources to Content Analysis Stores

Only EDB store objects, EDB mailboxes, or EDB folders can be drag and dropped or copied and 
pasted from the Source into the new content analysis store root to prepare for analysis. 

Note:  Messages or folders cannot be copied directly to a profile folder (results folder).

To add a folder, a mailbox, or an EDB file with Copy-Paste 

1. In the Source pane, select a folder, a mailbox, or an EDB file.
2. Do one of the following:

• On the Edit menu, click Copy.
• Right-click the selected item(s), and on the shortcut menu, click Copy.
• Click the Copy Mail Item icon  on the toolbar.
• Press Ctrl+C (Copy).

3. In the Target pane, click the content analysis store root and do one of the following:
• On the Edit menu, click Paste.
• Right-click the selected item, and on the shortcut menu, click Paste. 
• Click the Paste icon  on the toolbar.
• Press Ctrl+V (Paste).

4. In the Copy Progress window, verify that your messages were successfully copied, and 
click Close.

To add data even faster, use drag-and-drop

• To move entire EDB store objects, EDB mailboxes, or EDB folders, drag to the Target 
content analysis store root. Dragging and dropping achieves the same results as copying and 
pasting.

To use drag-and-drop when right-clicking a Source item

1. In the Source pane, select one or more messages.
2. Right-click the selected message containers and drag them to a content analysis store in the 

Target pane.
3. When you let go of the mouse, a shortcut menu appears. On the shortcut menu, click Paste.

Important:  If a new Source (Inbox, Deleted items, Outbox, etc.) is dropped into the content 
analysis store or the user removes a Source store from the content analysis store, all profiles 
automatically process the new Source. 
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Editing and Deleting Profiles

Deleting a profile stops any processing on that profile and removes that profile and all data 
associated with it from the content analysis store. Deleting a profile does not modify the EDB 
Sources. 

To edit a profile

1. To edit a profile, right-click the profile folder and click Edit Profile or click on the Profile 
menu and click Edit Profile. 

Figure 10-17. The Edit Profile Folder command allows you to edit the criteria

2. The Edit Profile Folder window appears. Edit any or all of the criteria. When new criteria 
is entered, all messages in the profile are deleted, the icon changes to its processing color 
(green), the profile status will update, and the process begins. 

To delete a profile

1. Do one of the following:
• Right-click the profile folder and click Delete.
• Click profile folder, and on the Edit menu, click Delete.
• Select the profile folder and press the Delete key on the keyboard.

Closing a Content Analysis Store

Closing a content analysis store root closes the root as well as all of the profile folders created 
under that root.

To close a content analysis store (CAS)

1. Do one of the following:
• Right-click the CAS and click Close Store.
• Click the CAS and on the File menu, click Close Store.
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Opening a Content Analysis Store as Source

When all profile processing has completed, you can open the content analysis store as a Source, for 
which the following Source operations can be performed: Copy/Paste, Paste Special, Export, Find, 
Integrity Check, Properties, and Create Reports. Use Copy/Paste to copy Source profile search 
criteria to a Target content analysis store.

If a content analysis store is opened as a Source and it has not completed processing all profiles, a 
window indicates that the content analysis store has not completed its processing. There is then an 
option to open the CAS as a Target. If that option is selected, Single Mailbox Recovery opens it as 
a Target and resumes processing on all remaining profiles.

To open a content analysis store as Source

1. One the File menu, click Open Source. The Select Source Files window opens.

Figure 10-18. The Source Path Selection window is used to open a CAS as Source

2. Click Browse to the right of Source File (*.edb, *.pst, *.cas). The Open window appears.
3. Select a .cas file and click Open.
4. In the Select Source Files window, click OK. A Source content analysis store appears in 

the left pane of Source.

Figure 10-19. A Source content analysis store root and profile folders
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Viewing Properties of a Content Analysis Store

To view the properties of a content analysis store

1. To display the CAS File Properties window, right-click the CAS in either the Source or 
Target pane and click Properties.

Figure 10-20. Right-click the CAS file to reveal the Properties command

Figure 10-21. The Properties of the selected CAS file

To view the properties of a content analysis store profile folder

1. Right-click the profile folder and click Properties.

Figure 10-22. The Properties of the CAS profile folder
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Creating Reports in Content Analysis Store

You can create reports of the Source content analysis store by right-clicking the Source content 
analysis store root. The reports are:

• Attachment statistics
• Domain statistics
• Messages by Database
• Messages by Profile Folder
• Messages by Date

See “Reporting” on page 247 for instructions on creating reports.

Viewing Profiles in Content Analysis Store

The Viewing Profiles option allows you to view what profile criteria has been used for a specific 
content analysis. All fields are read only.

To view a profile

1. Do one of the following to display the Profile Folder Properties page:
• Right-click the profile folder in either the Source pane or Target pane and point to View 

Profile Folder.
• Click the profile in either the Source pane or Target pane, click the Profile menu and 

click View Profile Folder.

Figure 10-23. Profile Folder Properties
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2. Click OK to exit.

Missing Database Files

If an EDB or log file that belongs to a content analysis store is moved and then the content analysis 
store is opened, there is a prompt to find or remove the missing database files. If the EDB is located 
but the STM is missing, Single Mailbox Recovery displays an error indicating that the STM needs 
to be located in the same directory as the EDB.

MISSING EDB
When there is a wrong EDB, you are prompted to locate the file.

Figure 10-24. This message appears if the EDB file is missing

To locate the missing EDB

1. On the Missing Database File error message, click Browse. The Open window appears.
2. Navigate to the EDB files and double-click the appropriate file.
3. Click OK. The Source pane now populate with files.
4. If you are unable to locate the EDB file, click Remove on the Missing Database File error 

message. A message asking you to confirm your decision to remove the file is displayed.

Figure 10-25. This message confirms that you want to remove the Source from the CAS.

5. Click OK.

Important:  When an EDB is removed, the complete Source EDB is removed from the CAS 
as well as any Source folders or mailboxes that also reference that EDB.

MISSING LOG FILES

When there are missing log files, you are prompted to locate the log directory. The Browse button 
opens a Browse for Folder dialog and defaults to the last known location of the logs.
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To locate the missing log files

1. On the Missing Database File error message, click Browse. The Open window appears.
2. Navigate to the directory containing the logs and click OK. The Source pane now populates 

with files.

Important:  When logs are removed, the complete Source EDB is removed from the CAS as 
well as any Source folders or mailboxes that also reference that EDB and logs.

MISSING STM FILES

When there are missing .stm files, you are prompted to remove the files.

To remove missing .stm files

1. On the Missing Database File error message, click Remove. 
2. A message asking you to confirm your decision to remove the file is displayed. Click OK.

Important:  When the .stm is removed, the complete Source EDB is removed from the CAS 
as well as any Source folders or mailboxes that also reference that EDB and .stm.

MISSING TEMP FILES DIRECTORY LOCATION

When there are missing temp file directory locations, you are prompted to locate the temp file 
directory location. The Browse button opens a Browse for Folder window and defaults to the 
current temporary path set by Single Mailbox Recovery. 

Figure 10-26. This message appears when the temporary file location cannot be found

To locate missing temp file directory location

1. On the Missing Database File error message, click Browse. The Open window appears.
2. Navigate to the directory containing the temp files.
3. Click OK. The Source pane now populates with files.

Note:  If just the temp files are missing but the directory exists, it recreates the temp files.

Wrong Database Files

When Single Mailbox Recovery finishes opening the EDB, it checks the database for the correct 
file in the content analysis store. If it does not locate the correct file, it determines that there is a 
different EDB at the original location than when the CAS was originally created. An error is 
displayed and prompts you to remove the file from the CAS.
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Figure 10-27. This message appears when the EDB database signature does not match.

To remove wrong files

1. On the Wrong Database File error message, click Remove.
2. A message appears asking if you are sure you want to remove the Source and all related 

messages from the content analysis store. Click OK.

Figure 10-28. This message confirms that you want to remove the Source from the CAS
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. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
MESSAGE VIEWS CHAPTER 11 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

You can view all instances of a given message or attachment in the EDB Source(s) within the same 
database as well as messages related by conversation in the Message Views option. This option is 
particularly useful in assisting with administrative tasks such as database cleanup activities, 
determining the history or dissemination of a message, or grouping messages by conversation 
thereby allowing you to view them together in context without missing a reply or forward.

Message views are available for messages in the Source pane, find results pane, and also from 
another message view. Message views are available only on single messages. If multiple messages 
are selected in the message pane, the message view menu items and toolbar buttons are unavailable.

You can view a message in various ways, depending on the message view option selected. Upon 
option selection, you are presented the following:

• Message Table View—all the messages that are referenced by the same message table row 
as the selected message. 

• Attachment Table View—all the messages that have an attachment that are referenced by 
the same attachment table row as the selected attachment. 

• Conversation View—messages that are related by conversation, with the sorting order of 
the email thread based on who replied to whom within the thread. Messages are indented to 
show the thread timeline of when replies occurred.
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Message Views Menus and Toolbars

The message views are accessible via the Tools menu, toolbar buttons, and a sub-menu on the 
shortcut menu in the message panes. 

Message Views Menus

The Tools menu contains a sub-menu with menu items for each message view. 

Figure 11-1. The Tools menu leads to the Message Views options

Message Views Toolbar Icons

A toolbar button exists for each message view: Message Table View, Attachment Table View, and 
Conversation View.

Figure 11-2. The Toolbar provides another option for accessing the Message Views

Message View Shortcut Menu

The Source pane shortcut menu has a Message Views sub-menu with menu items for each message 
view. As with the main menu, the new Message Views menu items provides status bar text when 
they are highlighted.
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Figure 11-3. The Message View options can be reached by right-clicking an EDB message in the 
upper message pane.

Figure 11-4. The Status Bar
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Message View Pane

The Message View Pane is the area that hosts the various message views. The pane provides you 
the ability to view the related messages and perform various actions (e.g., viewing messages in 
alternate views, exporting messages to your directory, checking the integrity).

Other Options Available in the Message View

Other actions can be performed within a Message View, such as Exporting messages, Integrity 
Check, copying messages, and viewing a message in another Message View.

Figure 11-5. Other options available in the Tools menu are Copy, Export, and Integrity Check

These options are available in any Message View:

• Copying Messages—Messages within a Message View can be copied and pasted into 
folders in the Target pane via the Edit menu or shortcut menu. For more information about 
copying messages, see “Restoring Exchange Data” on page 219.

• Exporting Messages—Messages within a Message View can be exported as any message 
can via the Tools menu or shortcut menu. For more information, see “Exporting Messages” 
on page 211.

• Integrity Check—Messages within a Message View can have an integrity check performed 
on them via the Tools menu or shortcut menu. For more information, see “Looking at the 
Interface” on page 139.

• Message Views—Messages within a Message View can be viewed in any of the three 
Message View options, Message Table View, Attachment Table View, or Conversation 
View. The message view options are only available if a single message is selected.
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Message View Options

You have the option of viewing all instances of a given message or attachment in the EDB 
Source(s) in three different ways—Message Table, Attachment Table View, and Conversation 
View.

Message Table View

Choosing the Message Table View option displays all the messages from the same EDB that 
reference the same message table row (Single Instance Storage). 

Example:

A message is sent to User1, User2, and User3. The message is stored in the message table once. If 
a user opens up the database and right-clicks the message in User1’s Inbox and chooses Message 
Table View, a table opens with three messages in it: One in User1’s Inbox (or deleted items), one in 
User2’s Inbox, and one in User3’s Inbox as long as they are all in the same Exchange database 
(EDB). If User 1, 2, or 3 are in a different EDB, those messages will not appear in this view.

Sample

Figure 11-6. The Message Table View displays messages that have been deleted.

The message pane displays the related messages in a report format showing the Message Type, 
Attachment, From, To, Subject, Folder, Date, and Status (indicating if message has been deleted). 

Note:  

• Only messages within the same EDB can be viewed in the Message Table View.
• Message Table Views in Exchange 2007 only return as a single instance of the message you 

have selected. 

To open and view messages in the Message Table View

1. In the message pane, select an EDB message.
2. Do one of the following to display the Message Table View:

• Click the Message Table View icon  on the toolbar.
• Right-click a message and point to Message Views, then click Message Table View. 
• Click the Tools menu, point to Message Views, then click Message Table View.
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Note:  The first time opening a view on this EDB, a message appears stating that a Message View 
file needs to generated. 

Attachment Table View

Choosing the Attachment Table View option displays all of the messages in the same EDB that 
have an attachment referencing the same attachment table row as the selected attachment (Single 
Instance Storage). If the message contains multiple attachments, a sub-menu listing each individual 
attachment allows the selection of an individual attachment. 

Example:

A message with an attachment is sent from User1 to User2 and User3. User3 forwards the email to 
User4. The attachment is stored in the attachment table only once (single instance storage). A user 
opens up the Exchange database (EDB) containing these messages and creates an Attachment 
Table View on the message in User1’s “Sent Items” folder. The Attachment Table View contains five 
messages: one in User1’s Sent Items, one in User2’s Inbox, one is User3’s Inbox, one in User3’s 
Sent Items and one in User4’s Inbox as long as they are all in the same EDB.

As in the Message Table View, the Attachment Table View shows the related messages in a report 
format with Message Type, Attachment, From, To, Subject, Folder, Date, and Status (including 
indicating if message has been deleted).

Note:  

• Only messages with attachments can be viewed in the Attachment Table View.
• Only attachments within the same EDB can be viewed in the Attachment Table View.
• Attachments within inaccessible mailboxes cannot be viewed in the Attachment Table View.

To open the Attachment Table View

1. In the message pane, select a message.
2. Do one of the following to display the Attachment Table View:

• Click the Attachment Table View icon  on the toolbar.
• Right-click a message and point to Message Views, then click Attachment Table 

View. 
• Click the Tools menu, point to Message Views, then click Attachment Table View.

Note:  The first time opening a view in this EDB, a message appears stating that a Message 
View file needs to generated. 
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Figure 11-7. The Attachment Table View displays messages with attachments

3. To view a message within the Attachment Table View, right-click a message, point to 
Message Views and select one of the following options:

• Message Table View
• Attachment Table View
• Conversation View

4. Any message in the Attachment Table View can be opened by double-clicking the message 
in the table.

Conversation View

Choosing the Conversation View option displays the messages that are related by conversation 
showing the Message Type, Attachment, From, To, Subject, Folder, Date, and Status (including 
indicating if message has been deleted). Messages are indented to show the chain of replies and 
forwards. 

Example:

If a user composes and sends Email 1 to another user, and that user sends Email 2, a reply to Email 
1, then Email 1 has no indention and Email 2 is indented one level. If the first user then replies to 
Email 2 with Email 3, then Email 3 is indented two levels.

Note:  

• Only conversation threads within the same EDB can be viewed in the Conversation View.
• Messages within inaccessible mailboxes cannot be viewed in the Conversation View.

To open a Conversation View

1. In the message pane, select a message.
2. Do one of the following to display the Conversation View:

• Click the Conversation View icon  on the toolbar.
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• Right-click a message and point to Message Views, then click Conversation View. 
• Click the Tools menu, point to Message Views, then click Conversation View.

Figure 11-8. The Conversation View displays the conversation threads which are indicated 
by indentions.

Note:  

• The first time opening a view on this EDB, a message appears stating that a Message 
View file needs to generated. 

• If the first message is missing, the next message in the thread is still indented indicating 
that it is not the original message.

3. To view a message within the Conversation View, right-click a message, point to Message 
Views and select one of the following options:

• Message Table View
• Attachment Table View
• Conversation View

4. Any message in the Conversation View can be opened by double-clicking the message in 
the table.

Opening a View for the First Time

To create a Message View for the first time

1. The first time you create any Message Table View, Attachment Table View, or Conversation 
View, Single Mailbox Recovery creates a Message View file. If no file exists, you are 
prompted to create the file.
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Figure 11-9. This message informs the user that an initial message view file does not exist

2. Click Yes to create the file. A progress window is displayed to indicate the stage, progress 
text, estimated time, elapsed time, and a grow bar. 
There are 5 stages: Initializing file, Processing attachments, Processing messages, 
Processing rows, and Saving file.
After the message view file has been created, if creating a Message Table View, the 
Creating Message View File progress window is replaced by another progress dialog that 
tracks the progress of view preparation. A Preparing Message Table View progress 
window appears.
If you click Cancel during this process, the Message Table View is not shown.

3. To view a message within the Message Table View, Attachment Table View, or 
Conversation View, right-click a message, point to Message Views and select one of the 
following options:

• Message Table View
• Attachment Table View
• Conversation View

4. To open a message in the Message Table View, Attachment Table View, or Conversation 
View, double-click on the message in the table.
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Find in Source Window in Message Views

You can open a message view from the Find in Source window by using the Message Views sub-
menu on the Find Window’s top-level Tools menu. The messages in the Find in Source window’s 
results pane also have the Message Views shortcut menu by right-clicking on a message and 
pointing to Message Views.

To open messages in Find in Source window result pane in different views

1. Click the Find icon  on the toolbar. The Find in Source window is displayed.
2. Enter search criteria in the appropriate fields.
3. Click Find Now. The Results pane appears with the search results.

Figure 11-10. The Find results can be displayed in each of the Message Views

4. Do one of the following:
• Click the Tools menu, point to Message Views, then click the desired view in the sub-

menu.
• Right-click the message, point to Message Views, then click the desired view in the 

sub-menu.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
SOURCE APPENDIX A : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

This section describes information you need to know and tasks you need to perform to restore 
Exchange mail items from an EDB file:

• About the Exchange Database
• Organizing Files Extracted from Other Backup Applications
• Verifying Hard Drive Space for .idx and .dat Files

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
About the Exchange Database1

The Exchange database consists of the following files:

1.The information in this section is taken from Microsoft Training and Certification: 
Implementing and Managing Microsoft Exchange 2000. Workbook. Redmond, WA: 
Microsoft Press, 2001. 

File(s) Description 

.edb file This is a rich text database file that contains data placed in the store through 
MAPI, as well as all the database tables that define mailboxes, messages, 
folders, and attachments. 

.stm file This is a streaming database file that contains common Internet formatted 
content, such as Multipurpose Internet Mail Extensions (MIME) content, that 
protocols other than the MAPI protocol place in the store. 

NOTE: The .stm file is new to Exchange 2000. Exchange 5.5 does not contain 
.stm files. 
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Organizing Files Extracted from Other Backup Applications 

If the source EDB is in an offline backup or in an online incremental or differential backup (as 
opposed to a full online backup) created by an application other than SnapManager, then—after 
you have extracted the files to a location accessible from the Single Mailbox Recovery server—use 
the following guidelines for organizing the files according to the backup type.  

If the source EDB is contained in an online incremental or differential backup: For best 
results, do the following: 

• Put the .edb and .stm files in one directory. 
• Put the associated log files (e.g., .log, .pat, .chk) in one directory.  

The two directories can be different. 

Single Mailbox Recovery does not require .stm or .log files, but you should include them to ensure 
that all email data is recovered. You may get corruption errors if these files are not present. In other 
words, the quality of the recovery is better if you include the .stm and log files. 

If the source EDB is contained in an offline backup: You need to use the .edb and .stm files. To 
ensure that all email data is recovered, you should also include all .log files, as well as .pat and .chk 
files if they exist. Single Mailbox Recovery performs its own verification process and will include 
the .log and .pat files to determine if it needs them to recover the data. 

Note: Exchange 5.5 and Exchange Server 2007 do not use .stm files. 

.log files These are transaction logs, or history files that record server activity. These 
files are useful in restoring and backing up Exchange data. All Exchange 2000 
transaction logs are 5 MB in size. Each storage group uses its own set of 
transaction log files. For example, if a storage group contains five stores, all 
transactions for all five stores are recorded in a single series of transaction log 
files. You can determine where to locate the transaction log files for each 
storage group. 

.chk files These are checkpoint files used for recovering (playing back) data from 
transaction logs into EDB files. The checkpoint is the place marker in the 
EDB.CHK file that indicates which transactions have been committed. 
Whenever data is written to an EDB file from the transaction log, the 
EDB.CHK file is updated with information specifying that the transaction was 
successfully committed to the respective EDB file. Separate Exx.chk files are 
maintained for each storage group using ESE (Extensible Storage Engine). 

.pat files These are patch files that are used to record information on page splits in 
Exchange 5.5 through Exchange 2000 (SP1). In Exchange 2000 (SP2) and 
later, the functionality provided by .pat files is incorporated into Exchange log 
files. 
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Verifying Hard Drive Space for .idx and .dat Files 

Single Mailbox Recovery never modifies an .edb file or its associated files (.log, .stm, .pat, or .chk 
files). However, it does create .idx and .dat files the first time you open an .edb file from a 
directory that contains log files; the interface prompts you to accept the default location for .idx and 
.dat files or specify a new location if the files require more hard drive space. Be sure you have a 
sufficient amount of hard drive space for .dat and .idx files. These files may require hard drive 
space equal to the size of the .log files. Therefore, you may need to change the default file path for 
.idx and .dat files if you need more space. 

Each time you reopen the .edb file, Single Mailbox Recovery uses the information in the .idx and 
.dat files so it can open the .edb file quicker. 
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KNOWN ISSUES APPENDIX B : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

The following are issues known to exist in Single Mailbox Recovery 5.0: 

See also:

• “Duplicated Message” 
• “New Mailbox Not Visible” 
• “No Virus Checking” 
• “Single Mailbox Recovery ExtractWizard Requires Windows Drivers” 
• “Single Mailbox Recovery ExtractWizard Support of Tape Block Sizes Greater than 64 

KB” 
• “PST Files Do Not Support HTML Message Bodies” 
• “Automatic Renaming of Mailboxes” 
• “General Procedure” 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Duplicated Message 

If you have ever copied or moved a message using Outlook, and later restored that same item with 
Single Mailbox Recovery, the message may be duplicated. This is because the message ID numbers 
differ between Single Mailbox Recovery and the Exchange Server.  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
New Mailbox Not Visible 

Newly created mailboxes on the Exchange Server do not become visible within Single Mailbox 
Recovery until someone has logged onto the mailboxes with Outlook, or at least one message is 
delivered (or copied) to the mailbox. Until one of these two events occurs, there is no physical 
mailbox, only directory information. 
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No Virus Checking 

Single Mailbox Recovery does not check messages or attachments for viruses when restoring them 
from the database. If your server antivirus program has current signature files, it should identify 
and protect against infected messages when the restored messages are on the live server. 

Single Mailbox Recovery ExtractWizard Requires Windows 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Drivers 

The Single Mailbox Recovery ExtractWizard requires that the Windows drivers be installed and 
configured for the tape device. 

Single Mailbox Recovery ExtractWizard Support of Tape 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Block Sizes Greater than 64 KB 

The Single Mailbox Recovery ExtractWizard can support tape block sizes greater than 64 KB as 
long as the SCSI HBA and its associated Windows drivers and settings support block transfers 
greater than 64 KB.  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
PST Files Do Not Support HTML Message Bodies 

When Single Mailbox Recover restores an HTML message from an EDB to a PST file, the message 
does not appear as anticipated when opened in Outlook. When you view the PST file in Outlook, 
the message will display plain text or it will display the HTML tags. Whether you get plain text or 
HTML tags depends on the email client that sent the original message. In any case, the copied 
message will not resemble the original HTML message because PST files don't support HTML 
message bodies. 

To overcome this issue, copy the message back to the Exchange 2000 Server. This will correctly 
generate the HTML message body as it appeared in the original message. Copying to an Exchange 
5.5 Server will not generate the correct HTML message body. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Automatic Renaming of Mailboxes 

Single Mailbox Recovery might not display mailbox names as expected if there is a dash (-) in the 
mailbox name. As initially installed, Single Mailbox Recovery displays mailbox names as follows: 

• If the text string “Mailbox - ” is contained in the mailbox name, Single Mailbox Recovery 
will remove the string.  
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• If the text string “Mailbox - ” is not found, Single Mailbox Recovery will look for a dash 
(-). If a dash is found, Single Mailbox Recovery will remove the dash and the text before it.  

Examples:

To modify the way Single Mailbox Recovery handles mailbox names, you can create a string value 
registry entry under the registry key: HKCU\Software\NetApp\SMBR. There are two possible 
solutions: 

• Create a registry entry with a value. This causes Single Mailbox Recovery to remove the 
specified text string if it exists in the mailbox name. For example, if you only want the text 
string “Mailbox - ” removed from mailbox names, you would create a registry entry as 
follows: 
Name:  MailboxParseString
Type: REG_SZ 
Value: “Mailbox – ” (without quotes and with a trailing space after the dash) 
In this example, Single Mailbox Recovery will NOT remove “New York - ”, for example, if 
it exists in the mailbox name. 

• Create a registry entry with no value. This causes Single Mailbox Recovery to not 
remove any text strings from mailbox names. The registry entry would be as follows: 
Name:  MailboxParseString 
Type: REG_SZ 
Value:   (no value entered)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
General Procedure 

1. Refer to the following Microsoft article for instructions and cautions on editing the 
Windows Registry: http://support.microsoft.com/default.aspx?scid=kb;en-us;136393. 

2. Start Regedit. 
3. In HKeyCurrentUser, highlight NetApp\SMBR, then right-click and select New, then 

String Value. 
4. Rename the NewValue to MailboxParseString. 
5. Highlight MailboxParseString, then right-click and select Modify. 
6. In the Value Data field, enter the text string that you want Single Mailbox Recovery to 

remove from mailbox names. 

If the mailbox name is… Single Mailbox Recovery might display it as: 

Mailbox – Joe Smith Joe Smith 

New York – Joe Smith Joe Smith 

Joe Smith - Princeton Princeton 
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Term Description

Attachment Table View A table that displays all the messages that have an attachment 
referenced by the same attachment table row as the selected 
message.

BKF An .MTF format backup-to-disk file, which is similar to other 
archive formats such as ZIP or ARJ. Backup software applications 
that output this file format are NT Backup (the version that shipped 
with Windows 2000), Windows Backup 2003 and XP, and Backup 
Exec.

CAS See Content Analysis Store

CHK Checkpoint files (.chk files) are used for recovering (playing) data 
from transaction logs into EDB files. The checkpoint is the place 
marker in the EDB.CHK file that indicates which transactions have 
been committed. Whenever data is written to an EDB file from the 
transaction log, the EDB.CHK file is updated with information 
specifying that the transaction was successfully committed to the 
respective EDB file. Separate Exx.chk files are maintained for each 
storage group using ESE (Extensible Store Engine).

Content Analysis Store 
(CAS)

A data store type where each message in the root level container 
identifies a Source container. A Source container can either be an 
EDB, an EDB mailbox, or an EDB folder. The CAS is used to 
analyze messages based on profile criteria entered before 
processing.

Conversation View A table that displays all messages in the database that are related by 
conversation. The conversation thread is indented to indicate 
replies.

Data Store A unified collection of folders and messages contained in a single 
storage medium. A PST file is a data store. An Exchange 
Information Store is also a data store. In a basic case, Exchange has 
two live data stores, one for the private mailboxes and one for the 
public folders.

Data Wizard The first time you start Single Mailbox Recovery, the Data Wizard 
starts. The Data Wizard guides you through the loading of 
Exchange Database (EDB), PST files, or content analysis store 
(CAS) files into Single Mailbox Recovery, and shows you how to 
specify the Target PST file or Exchange Server. 

Deduplication An automated process of deleting an identical file during 
processing.

EDB See Exchange Database.
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EIS See Exchange Information Store.

Exchange Database This file, which usually has an EDB extension, contains the 
mailbox, folders, and messages you see when connecting to an 
Exchange Server. The Exchange Server reads and writes to this file 
in response to incoming email and events from the clients. On 
Exchange Server 2000, this is one of the two files that make up the 
Exchange Information Store, the other being the STM file.

Exchange Information 
Store

This is the set of files that make up the data store for private 
mailboxes and public folders on an Exchange Server. For Exchange 
Server 5.5, this is the single Exchange Database file usually named 
priv1.edb and pub1.edb. On Exchange Server 2000, 2003, and 
2007, the private mailbox data store will consist of the files 
priv1.edb and priv1.stm, and the public folder data store will consist 
of pub1.edb and pub2.stm.

Log Files Transaction log files (.log files) are history files recording server 
activity. These files are useful in restoring and backing up Exchange 
data. Transaction logs for Exchange Server 5.5, 2000, and 2003 are 
5 MB in size. Transaction logs for Exchange Server 2007 are 1 MB 
in size.

Messages Messages are found in the folders of an Exchange Information 
Store. Messages can mean “email,” but Outlook Contacts are also 
messages, as are Appointments, Journal Entries, Sticky Notes, and 
Tasks.

Message Table View A table that displays all messages that are referenced by the same 
message table row as the selected message. For example: A 
message that is sent to three different users is displayed three times, 
one in each users Inbox.

MTF Microsoft Tape Format is the format defined by Veritas and 
Microsoft used to record files in a backup using NTBackup (Backup 
for NT4, 2000, XP) or BackupExec.

PAT Patch files (.pat files) are used to record information on page splits 
in Exchange Server 5.5 through Exchange Server 2000 (SP1). In 
Exchange Server 2000 (SP2) and later, the functionality provided 
by .pat files is incorporated into Exchange log files.

Profile Folder A subfolder of the content analysis store containing the results of 
profile criteria entered for processing.

PST Personal Storage file. This file, used by Outlook, contains folders 
and messages that have been retrieved from a user’s Exchange 
mailbox and copied locally.

Term Description
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Received Messages Messages that have been sent through an Exchange Server to 
another mailbox. Messages in the “Sent Items” folder are copies of 
messages sent through an Exchange Server and are not considered 
to be “received messages.” Because messages in the “Drafts” folder, 
“Notes” folder, and other similar items are not sent through an 
Exchange Server, they too are not considered to be “received.”

Note: Because recovery software such as Single Mailbox Recovery 
restores messages from a source to an Exchange mailbox without 
sending them, the messages that Single Mailbox Recovery restores 
are not considered to be “received messages.”

Shortcut Menu This menu is accessed by right-clicking on an item.

Source Data Store This is the data store from which folders and messages are copied. 
The Source is read-only, so items cannot be copied into, deleted 
from, or changed in the Source.

STM For Exchange Server 2000 and 2003, this is one of the two files that 
make up the Exchange Information Store, the other being the EDB 
file. The STM file stores certain data for emails that come into the 
Exchange Server through the POP or SMTP port. This email data 
may eventually get moved into the EDB file over time.

Target Data Store This is the data store to which folders and messages are copied. The 
Target is read-write allowing items to be added, deleted, and 
changed. The Target data store can be an Exchange Server or PST 
file.

Term Description
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A
access rights

Exchange mailboxes 228, 232, 
233

access rights to an Exchange server 
221

administrative rights to the Net-
Worker server 43

Advanced Method 35
API Method for EMC NetWorker 

43
API Method for IBM Tivoli Stor-

age Manager 37
Emulation for UltraBac and Ex-

change 2000/2003 129
Exchange Emulation for CA 

ARCserve and Exchange 
2000/2003 97

Exchange Emulation for CA 
ARCserve and Exchange 5.5 
103

Exchange Emulation for Com-
mVault Galaxy Backup & Re-
covery and Exchange 
2000/2003 118

Exchange Emulation for HP 
OpenView Storage Data Pro-
tector and Exchange 2000/2003 
65

Exchange Emulation for HP 
OpenView Storage Data Pro-
tector and Exchange 5.5 71

Exchange Emulation for NT 
Backup and Exchange 
2000/2003 on Windows 
2000/XP/2003 52

Exchange Emulation for NT 
Backup and Exchange 5.5 on 
Windows 2000/XP/2003 57

Exchange Emulation for NT 
Backup and Exchange 5.5 on 
Windows NT 4 61

Exchange Emulation for Syman-
tec Backup Exec 8.6 and Ex-
change 2000/2003 88

Exchange Emulation for Syman-
tec Backup Exec 8.6 and Ex-
change 5.5 93

Exchange Emulation for Syman-
tec Backup Exec 9.1/10.1 and 
Exchange 5.5 85

Exchange Emulation for Ultra-
Bac and Exchange 5.5 133

Exchange Emulation for Veritas 
NetBackup and Exchange 
2000/2003 108

Exchange Emulation for Veritas 
NetBackup and Exchange 5.5 
114

Advanced Searching
licensing agent 206

All Mailboxes 182
API 37
API Method. See also Advanced 

Method
requirements for using 36
using 37

attachment table view 280, 293
attachments

opening and saving 147
opening and saving in the Find 

dialog box 207
searching for 206

B
BKF 293

C
CAS 293
CHK 293
closing a content analysis store 268
closing sources and targets 185
Command Line

examples 241
syntax 237

completing
the Data Wizard 170

Configuring Microsoft Outlook 12
Connect to Exchange Server dialog 

box 178
Connect to Public Folders 167, 

168
content analysis store

creating 258
creating reports 271

opening as Source 269
viewing profiles 271
viewing properties 270

content analysis store (CAS) 293
closing 268

content analysis store profile
viewing properties 270

continue loading EDB file without 
logs 169

conventions in this manual
menu commands and shortcuts 

16
shortcut menu 6, 16

conversation view 281, 293
Copy Progress dialog box 221
copy results in Copy Progress win-

dow
viewing 222

Copy To Folder 202
copying and pasting 223
create a mailbox

wizard 187
create a new single mailbox

Copy 189
Create a New Target PST command 

177
Create Content Analysis File dialog 

box 169
create mailboxes 186
create multiple mailboxes

Copy 190
Create New Mail Folder dialog box 

222
creating

content analysis store profile 
folders 260

creating a content analysis store 
258

creating a new folder in the Target 
pane 222

creating reports
content analysis store 271

D
Data Wizard 293

Completing the Data Wizard 
170

Now Processing Data File 169
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opening a Target content analysis 
store 259

returning to 171
Source Path Selection 165
Target Type and Path Selection 

166
Welcome page 164

deleting a folder in the Target pane 
223

deleting profile 268
disabled user accounts 186
displaying a message in the preview 

pane 146
dragging and dropping 223

E
EDB 293

searching for messages 196
EDB file

exporting 212
guidelines for selecting 166
in Source pane 140
restoring a folder 230
restoring a mailbox 232
restoring an entire EDB file 233
restoring in three easy steps 219
restoring messages with Copy-

Paste 224
restoring messages with Paste 

Special 225
restoring to an Exchange Server 

221
editing a profile 268
EIS 294
embedded messages

searching 198, 199
enabling licensing agent for 3
Enter Password dialog box 167, 

168, 178
Exchange database 294
Exchange Emulation for Symantec 

Backup Exec 9.1/10.1 and Ex-
change 2000/2003 75, 80

Exchange Emulation. See also Ad-
vanced Method
two steps for using 50

Exchange Emulation. See also 
Advanced Method
two steps for using

requirements for using

51
Exchange information store 294
Exchange server

opening a target 178
specifying as the target for re-

stored data 167, 168
Exchange Server Targets

searching 195, 201
exclude words 197
existing user account 193
export individual messages

Source content analysis store 
215

export report
printing 218
saving 218

Export to PST 215
exported PST

output 216
using 216

exported PST files
existing files 217

exporting
a CAS file 212
a PST file, mailbox or folder 212
an EDB file 212
individual messages 214
individual messages from the 

Find dialog box 214
messages from the Find dialog 

box 207
exporting a mailbox or folder 211
exporting individual messages 211
exporting messages

about MSG and TXT files 211
about the Export Progress dialog 

box 212
general information 211

F
Find dialog box

exporting messages from the 
Find dialog box 207

guidelines for using 195
performing an integrity check on 

messages 207
restoring messages 207
saving search profiles 205
searching within attachments 

206

searching within results 200
selecting multiple mailboxes or 

folders to search 195
viewing previous search results 

200
Find in Exchange Target 201, 205
Find in Source 196, 205
Find in Sources 195
Find window

opening messages 284
Folders in the Target Pane

creating 222
deleting 222
renaming 222

G
guidelines

for restoring messages 224
for restoring messages with 

Copy-Paste 224
for restoring messages with Paste 

Special 226
restoring a folder 230
restoring a mailbox 232
restoring an EDB file 233
restoring to public folders 234
using the Find dialog box 195

H
Help

online Help 8
hiding the preview pane 146
hiding the toolbar and status bar 

148

I
illustration 139
importing

profile criteria 264
inaccessible mailbox 180, 189
inaccessible mailboxes 156
inputting

saved profile criteria 265
Integrity Check 153

K
Keyboard Shortcuts 14
298



. .
 . 

. .I N D E X
L
live Exchange Server

opening mailboxes 181
Live Microsoft Exchange Server 

179
log files 294

organizing the Exchange data-
base files for Single Mailbox 
Recovery 138

M
mailbox access 179
mailbox creation 155, 193
mailbox or folder

exporting 212
Mailbox Settings 189
mailbox-enabled user

create 186
Main window

menu bar 144
Source message list 142
Source pane 140
Target pane 142
toolbar 145

manual mailbox creation 155
menu bar 144
message (.msg) export 211
Message Report 208
message table view 279, 294
message view

integrity check 278
message view options

attachment table view 280
conversation view 281
message table view 278

message view pane 278
message views

copying messages 278
exporting messages 278
menus and toolbars 276

messages
cutting 203
deleting 203
exporting 212
moving 201
searching 196

missing database files
missing temp files location 273

Move To Folder 201
moving messages 201

using drag and drop 202
using Move To Folder 202

moving or copying a folder, a mail-
box, or an EDB file with Copy-
Paste 267

MTF 294
multiple levels

searching 199
multiple mailboxes

opening 183
searching 196

multiple search windows 205

N
new mailbox

created 190
new mailboxes 186
Now Processing Data File 169

O
online Help 16
Open Existing Target PST com-

mand 177
open messages in Find window 284
Open Source command 175
Open Target Content Analysis Store 

command 179, 180, 183
Open Target Exchange Server com-

mand 178
opening

a target content analysis store 
179

a target Exchange Server 178
an Exchange database (EDB) file 

or PST file 175
an existing target PST 177
attachments 147
attachments in Find dialog box 

206
content analysis store as Source 

269
conversation view 281
Data Wizard 164
message table view messages 

279
messages 146
multiple sources 185
Target content analysis store us-

ing the Data Wizard 259
the preview pane 146

the source database and target 
mailboxes 175

Opening Target 184, 185

P
Paste Special

restoring messages 225
PAT 294
permission rights 179
permissions of public folders 234
preferences 154
preview pane

displaying a message in 146
hiding 146
opening 146
opening attachments in 147
saving attachments in 147

previewing and opening messages 
146

previous search results
viewing 200

processing
content analysis store profile 

folder 261
processing on profiles

resuming 266
suspending 266

profile folder 294
properties of an EDB file, PST file, 

CAS file, CAS profile folder, 
mailbox, or folder 150

PST 294
PST and folder limits 220
PST export 212
PST file

creating a new target 177
in Source pane 176
opening an existing target 177
restoring in three easy steps 219
searching for messages 196

PST files
as displayed in Target pane 142
generate 215
generated 217

PST messages per folder limit
turning off 221

public folders
permissions 234
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R
refreshing the screen 149
renaming a folder in the Target pane 

222
report

saving 208
using 209

reporting
attachment statistics report 251
creating reports 247
domain statistics report 251
mailbox report 253
messages by database report 252
messages by date report 254
messages by profile folder report 

255
saving reports 256
sorting reports 255

reports. See reporting
restore messages

Exchange Server root node 228
restoring a folder

guidelines 230
results 231

restoring a mailbox
guidelines 232
results 233

restoring an EDB file
guidelines 233
results 234

restoring Exchange data
looking at the Target pane 142

restoring Exchange data to a PST 
file
about the Copy Progress dialog 

box 221
looking at the Target message list 

143
restoring a folder 230
restoring a folder, a mailbox, an 

EDB file, a CAS file, or a PST 
file 220

restoring a mailbox 232
restoring an EDB file 233
restoring individual messages 

with Copy-Paste 220
restoring individual messages 

with Paste Special 220
restoring Exchange data to an Ex-

change server

about the Copy Progress dialog 
box 221

restoring a folder 230
restoring a folder, a mailbox, an 

EDB file, a CAS file, or a PST 
file 220

restoring a mailbox 232
restoring an EDB file 233
restoring an Exchange server 

mailbox or folder with Copy-
Paste 224

restoring individual messages 
with Copy-Paste 220

restoring individual messages 
with Paste Special 220

restoring messages to an Ex-
change server root node with 
Paste Special 228

restoring messages to Exchange 
2000/2003 221

restoring messages to Exchange 
5.5 221

restoring to public folders 234
restoring messages

guidelines 224
Paste Special 225

restoring messages from the Find di-
alog box 207

restoring messages with Copy-Paste
results 225

restoring messages with Paste Spe-
cial
guidelines 226

restoring PST and Folder Targets
limits 220

restoring to public folders 234
guidelines 234
results 235

restoring your Exchange data in 
three easy steps 219

resuming processing on profiles 
266

rights
access rights to an Exchange 

server 221
administrative rights to the Net-

Worker server 43
rights for using Exchange emulation 

51

S
saving

attachments 147
attachments in the Find dialog 

box 207
profile criteria 264
reports 256

saving search profiles 204
search

performing 205
search criteria

report 208
search embedded messages 199
search for words 197
Search in

Attachment File Name(s) 198
Attachment Text 198
Message Body 198
Message Subject 198

search profile
creating 204
editing 205

search profiles 204
search results report 208
searching

for attachments 198, 199
using multiple search windows 

205
within attachments 206
within results 199

searching for messages 196
searching within attachments

exceptions 206
searching. See also Find dialog box

for messages 196
Shortcut Menu 6, 16
single instance storage (SIS) vs. cu-

mulative counts 250
Single Mailbox 182
single mailbox

opening 180
searching 196

single mailbox copy 155
Single Mailbox Recovery

five reasons for using 2
system requirements 9

Single Mailbox Recovery license 
agents 3

sorting messages in the message list 
149
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Source
EDB or PST file 140
message list 142
pane 140

Source data store 295
source file

opening 175
source mailbox 193
Source Path Selection 165
specifying a content analysis store 

168
specifying target CAS file path 169
split bar, using to resize panes 148
STM 295
Summary Report 208
suspending the processing on pro-

files 266
system requirements 9

T
Tamper-Proof Target 156
Target content analysis store

opening 259
Target Exchange Server 189
Target message list 143

in main window 143
Target pane

creating a new folder 222
deleting a folder 223
pasting an item 223
renaming a folder 222

Target Type and Path Selection 166
technical support 8
text (.txt) export 211
toolbar

in main window 145

U
Use Wizard command 171
User Information 187, 191
user permission 186
using Find window in message 

views 284
using multiple search windows 205
using search profiles 204

V
view the properties of a content 

analysis store profile 270
viewing

message table view messages 
279

previous search results 200
the properties of a PST file, EDB 

file, folder, or mailbox 150
the toolbar or status bar 148

viewing profiles in content analysis 
store 271
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